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1.1

1.2

200180 2009-08

Safety

General

The operator of the system is responsible in terms of planning, mounting, commissioning,
operating and maintenance.

Installation and commissioning of all devices must be performed by a trained professional
only.

Protection of operating personnel and the system is not ensured if the product is not used
in accordance with its intended purpose.

Laws and regulations applicable to the usage or planned purpose of usage must be
observed. Devices are only approved for proper usage in accordance with intended
purpose. Improper handling will result in voiding of any warrantee or manufacturer's
responsibility.

The Declaration of Conformity, Certificate of Compliance, Statement of Conformity, EC-
type-examination certificate and data sheets are an integral part of this document.

The data sheet contains the electrical data of the Declaration of Conformity, the Certificate
of Compliance and the EC-type-examination certificate.

The documents mentioned are available from http://www.pepperl-fuchs.com or contact your
local Pepperl+Fuchs representative.

Intended use

The DTM software described in this manual has been developed according to FDT 0.98
specifications and is designed exclusively for configuring a Pepperl+Fuchs LB/FB remote
I/O System and for displaying measured values and status information during
commissioning and maintenance.
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1.3

Symbols used

This document contains information that you must read for your own personal safety and to
avoid property damage. The warning signs are displayed in descending order depending
on the hazard category, as follows:

Safety-relevant symbols

Danger!
This symbol indicates a warning about a possible danger.

In the event the warning is ignored, the consequences may range from personal injury to
death.

Warning!
This symbol indicates a warning about a possible fault or danger.

In the event the warning is ignored, the consequences may course personal injury or
heaviest property damage.

Caution!
This symbol warns of a possible fault.

Failure to observe the instructions given in this warning may result in the devices and any
connected facilities or systems develop a fault or fail completely.

10
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Informative symbols

Note!

This symbol brings important information to your attention.

Action

This symbol marks an acting paragraph.

I3 PEPPERL+FUCHS
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PROFIBUS COM UNIT
Safety

1.4 Declaration of Conformity

All products have been developed and manufactured taking into consideration applicable
European standards and regulations.

Note!

[0

A Declaration of Conformity can be requested from the manufacturer.

The manufacturer of this product, Pepperl+Fuchs GmbH in 68307 Mannheim, Germany,
has a certified quality assurance system in conformity with 1ISO 9001.

1SO9001
1.5 LB/FB hardware

Read the LB/FB hardware manuals before using this manual to configure and commission
the Remote 1/O station.

Pay particular attention to the chapter on safety and all other parts of the LB/FB hardware
manuals that refer to the safe area.

200180 2009-08
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PROFIBUS restart after certain procedures

Modifications to some Com Unit/l/O module device parameters and to the slot configuration
change the data structure of the Profibus data telegram. These modifications cause the
Profibus to restart automatically and cannot be changed online (active connection with the
device).

If your system supports HCIiR, the parameters below can be changed offline and activated
at a later time when the system is operative.

If the system does not support HCiR, we recommend setting the following parameters to
the correct values before commissioning the Remote I/O station if possible, to prevent the
Profibus from restarting while the system is operating and to avoid functional interruptions:

Com Unit parameters
¢ Module status area parameters

¢ Status+command parameters

I/O module parameters
¢ Modify the function type of /O module 1x03 (Measuring method parameter)

* Modify the number of HART auxiliary variables in the I/O module 3x02 (Measuring
method parameter)

Offset module diagnostics parameter change

¢ Changing the Offset module diagnostics parameter represents a serious
manipulation of the diagnostics and alarm handling system. We recommend changing
the parameter only if the module counting methods for diagnostic assignment in the
master and slave are different. It is advisable to check the module counting method
prior to commissioning or during a plant shutdown and then modify the parameter once
if required.

I3 PEPPERL+FUCHS
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Quick start

This chapter contains brief instructions for quick-starting your Remote 1/O station.

However, we recommend reading the detailed descriptions in these instructions so that you
gain a better understanding of Com Units, 1/0 modules and configurations.

Bus connection

Bus — electrical test of connections

Note!
Please refer to the relevant literature to obtain more detailed information.
The bus must have exactly 2 bus terminations per segment, one at the start and one at the

end. A segment usually starts at the master, while the last Remote I/O station is the end of
the segment. All Remote 1/O stations on the bus are slaves.

Example(view Figure 2.1 on page 13): one line with 1 master, 4 slaves, one fiber optic link,
1 repeater (R), 3 segments, and 6 bus terminations (T): Master (T) — Slave (T) — OLM —
fiber optic link — OLM (T) — Slave — (T) Repeater (T) — Slave — (T) Slave.

Note!

A new copper segment also starts or ends at a repeater or OLM (Optical Link Module =
fiber optic link)

Figure 2.1: Example: bus segments with bus termination

T = bus termination
OLM = optical link module
R = repeater

I PEPPERL+FUCHS
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Testing the physical connection to the end of the segment

Tip

Perform all measurements from the control room!

If you do not have a multimeter available, hold an LED across B (+) (pin 8 on the bus
connector) and A (-) (pin 3 on the bus connector). It should light up.

1.

Remove the bus connector from the master (view Figure 2.2 on page 15).

2. Disable the bus termination on the bus connector (beginning of the bus).

3. Measure the voltage across A (pin 3) and B (pin 8) on the bus connector.
There should be a voltage of U=220Q /(220 Q2 +2*390 Q) *5V = 1.1 V across A
and B. This voltage exists because of the bus termination at the field end.
If a voltage of 1.1 V is not present, then one of these situations may be present: there is
no bus termination connected at the end of the bus, the cable is faulty, or there is no
termination voltage applied to the Remote I/O station.

4. Measure the current between A (pin 3) and B (pin 8) on the bus connector.
The current between A and B should measure | =5V /(2 * 390 Q) ~ 6.4 mA.
If the current is noticeably higher (by a factor of 2 or more), the bus is terminated with
more than one termination.
If the current equals ~0 mA, then one of these situations may exist: no bus termination
is connected, the cable is faulty, or the termination voltage is not present. In this case,
the resistance between A and B should measure 220 Q.
If measurements show no current and no resistance, then either the termination at the
end of the bus is missing or the cable is faulty.

5. Enable the bus termination on the bus connector of the master.

6. Plug the bus connector back into the master.

Danger!

Risk of explosion

Measurements at the terminals of the slaves in Zone 1 are only permitted when there is no
risk of explosion (hot work permit).

14

Testing the physical connection to the Remote I/O station

1.
2.

Remove the bus connector from the master (view Figure 2.2 on page 15).

Disable the bus termination at the bus connector (beginning of the bus).

3. Measure the voltage across A and B at the bus connection to each Remote 1/O station.

A voltage of U = 1.1 V should be present across A and B at every Remote I/O station.

Enable the bus termination on the bus connector of the master again.

5. Plug the bus connector back into the master.

I3 PEPPERL+FUCHS
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2.1.3
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Figure 2.2: Bus connector with built-in switchable bus termination

Three steps for data transfer

Note!

The following DP diagnostics (DP diagnosis, etc.) are defined in the Profibus specification
and user access is enabled via modern master modules. If not, the diagnostics can be
obtained using a Profibus analyzer.

The bus data transfer procedure

Prerequisite: The bus must have successfully passed the electrical test (see chapter 2.1.1).

1. Make sure that the slave address is identical for both the master and slave.
The slave can be activated via the bus (DP diagnostics station_non_existent == 0).
2. Make sure that the Profibus ID in the slave is the same as the ID in the GSD file.
The slave accepts the parameters of the master (DP diagnostic prm_fault == 0).

3. Make sure that the HW Config (the I/O module layout) in the master is the same as the
hardware configuration in the slave.
Caution: On I/O modules 1x03 and 3x02, the data volume depends on the Measuring
method parameter.
Do not configure empty I/O modules at the end of the Remote 1/O station. If this /O
module is not the last module in the station, one slot must be kept free after a dual-width
module.
The status/command area and the module status area change the start number for the
module slot numbering.

The slave accepts the configuration of the master (DP diagnostic cfg_fault == 0).
Control system-dependent parameterization

e "Suppress clear" for PCS7 = 1, otherwise = 0.

¢ "Redundancy" for ABB (symphony) = line redundancy, otherwise = application
redundancy.

* Timeout for outputs: at least 10 times the bus cycle time. The Profibus watchdog time is
a good alternative to the bus cycle time; the watchdog time is usually calculated
automatically by the control system.

I3 PEPPERL+FUCHS 15
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Profibus speed

The following information has been taken from the literature. More detailed information can
be ordered from the Profibus User Organization (PNO).

The reaction time of a Profibus system basically depends on the following factors:

¢ the reaction time in which a slave can respond,
¢ the selected transmission rate (baud rate),

¢ the Min_Slave_Interval,

¢ the agreed net data length.

The following simplified example is good for making estimates

1 master and 5 slaves are connected via the Profibus DP. 10 bytes of output data and 20
bytes of input data are to be transmitted per slave. The transmission rate is 1.5 Mbaud.
Therefore: 1 bit at 1.5 Mbaud = 1/ 1.5 Mbit/sec = 0.67 us = 670 ns.

1 character is made up of 11 bits (1 start bit, 8 data bits, 1 parity bit, and 1 stop bit, see
illustration below). Therefore, 1 character requires 11 x 670 ns = 7.33 pus.

The minimum interval for one information cycle results from the addition of the bus times
and the telegram header.

TMC = 2 x length header (bytes) x 11 bits + TSDR + TSYN + TIDI (see the illustrations
below).

In the data exchange, the header comprises 9 bytes. The bus time-out times for the
synchronization are assumed to be TSYN = 33 bits and TIDI = 36 bits (at 1.5 Mbaud). The
running times of the signals at the bus are negligible. A typical value for an ASIC is TSDR =
30 bits.

Therefore: TMC / bit =2 x9 x 11 + 30 + 33 + 36 = 300 or 300 x 670 ns = 201 ps.

This means that the approximate time for an information cycle is: 201 us + quantity of net
data (e.g. 10 output bytes + 20 input bytes).

201 us + 30 x 7.33 us = 420.9 us per slave or approximately 2.1 ms for 5 slave stations.

|SYN|SD2|LE|LEr|SD2|DA|SA|FC|DSAPlSSAPlDATIFCSlEDlTR|

|START|D7|D6|D5|D4|D3|D2|D1|DO|PAR|STOP|

Figure 2.3: Structure of the Profibus telegram

SYN Bus idle state DAT Data bits

SD2 Start delimiter 2 START  Start bit

LE Byte length D7 ... DO Data bits

LEr Byte length repeated PAR Parity bit

DA Destination address STOP Stop bit

SA Source address FCS Checksum

FC Function code ED End delimiter

DSAP Destination services starting TR Minimum delay
point (8 bit timing)

SSAP Source services starting point

I3 PEPPERL+FUCHS
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PROFIBUS COM UNIT
Quick start

Bus cycle time / ms

A
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Figure 2.4: Bus cycle time for a DP Mono Master System Profibus
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Preferred parameter values

The following tables provide an overview of the parameters that can be set and the

preferred parameter values for the Com Unit and the I/O modules. The preferred parameter

values are suitable for most systems.

To minimize the number of fault messages during initial commissioning, disable all line fault

detection functions.

Unless stated otherwise, the parameters can be adjusted separately for each channel of

the 1/0 module.

Com Unit

Local parameters relate to the Com Unit, global parameters relate to all the modules.

Preferred parameter values for the Com Unit

Parameter

Preferred value

Explanation

Backplane (global)

Specify type of backplane being used

Power supply
(global)

Specify type of power supply being used

Redundancy (local)

No redundancy

Specify whether a redundant system is
being used

Service bus (local)

Specify the service bus address

PROFIBUS (local)

Specify the PROFIBUS address

Watchdog time
(local)

Specify watchdog time with adequate time
for the master cycle

DP parameters

Com Unit setting
(local)

No command or
status data

Defining the Com Unit data to be included
in the cyclic data exchange process.

Suppress
PROFIBUS “clear”
(local)

Off

Defining whether pure null telegrams
should be evaluated.

PROFIBUS

Status and error

Defining when new diagnostic telegrams

diagnostics (global)

diagnostics (local) diagnostics should be generated (only in the event of
errors or changes in status)

Offset module 0 Defining the module counting method for

diagnostics (global) diagnostic messages

Additional module Off Selection and de-selection of additional 2-

bit diagnostics per I/O module

[Table 2.1: Preferred parameter values for the Com Unit
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Digital inputs 1x01, 1x02

Preferred parameter values for digital inputs LB/FB 1x01 and 1x02

Parameter Preferred value | Explanation

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1".

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

Extended parameters

ON delay 0 = Off The ON delay filters short pulses.

OFF delay 0 = Off The OFF delay lengthens pulses.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a simulation, simulation values are
used depending on which operating mode
was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

[Table 2.2: Preferred parameter values for digital inputs LB/FB 1x01 and 1x02

I PEPPERL+FUCHS
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Frequency input 1x03

Preferred parameter values for frequency input LB/FB 1x03 (frequency input function type)

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%
(Start of range/end of
range)

10000 ... 50000

Adapt scaling to the master range (O ...
65535).

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

Direction detection Off You can use the direction detection input to
count up or down, or as a status indicator
for the direction of rotation.

Measurement range 0 ... 15000 Hz

Extended parameters

Analog filter Off If the input signals fluctuate, an analog filter
can be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

status

[Table 2.3: Preferred parameter values for frequency input LB/FB 1x03 (frequency input function type)
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Preferred parameter values for frequency input LB/FB 1x03 (counter input function type)

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

Direction detection Off You can use the direction detection input to
count up or down, or as a status indicator
for the direction of rotation.

Divider 1 To prevent an overflow, you can use a
counter quotient for the counter.

Extended parameters

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Simulation value as required During a manual simulation, simulation

values are used depending on which
operating mode was selected.

[Table 2.4: Preferred parameter values for frequency input LB/FB 1x03 (counter input function type)

I PEPPERL+FUCHS
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Preferred parameter values for frequency input LB/FB 1x03 (combined frequency/counter input function type)

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%

10000 ... 50000

Adapt scaling to the master range.

(0 ... 65535)

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

Direction detection Off You can use the direction detection input to
count up or down, or as a status indicator
for the direction of rotation.

Measurement range 0..50Hz

Extended parameters for frequency

Analog filter Off If the input signals fluctuate, an analog filter
can be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
invalid.

Simulation value with On

status

Live Zero substitute Off

value

Live Zero simulation Off

value

Direction substitute value Off

Direction simulation Off

Extended parameters for counter

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Simulation value as required During a manual simulation, simulation

values are used depending on which
operating mode was selected.

[Table 2.5: Preferred parameter values for frequency input LB/FB 1x03 (combined frequency/counter input function type)
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Digital input 1x08

Preferred parameter values for digital input LB/FB 1x08

Parameter Preferred value | Explanation

Contact type NAMUR The choice for the "Contact type"
parameter is NAMUR, contact or active
voltage input.

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1."

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit (only for NAMUR
contact type, 5V/24V inputs do not have
line fault detection).

Extended parameters

ON delay 0 = Off The ON delay filters short pulses.

OFF delay 0 = Off The OFF delay lengthens pulses.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

[Table 2.6: Preferred parameter values for digital input LB/FB 1x08

I PEPPERL+FUCHS

23



2.3.5

24

Digital output 2xxx

Preferred parameter values for digital output LB/FB 2xxx with 2 digital inputs (*)

Parameter

Preferred value

Explanation

Parameters for output

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1."
Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/O values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection

Off

Although the valve output recognizes lead
breakage and short circuit, the indication it
gives does not distinguish between these
states

Extended parameters for output

ON delay 0 = Off ON delay — after bus data received

OFF delay 0 = Off OFF delay — after bus data received

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Parameters for inputs

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1."

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/0O values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection

Off

Line fault detection recognizes lead
breakage or short circuit.

Extended parameters for inputs

ON delay 0 = Off The ON delay filters short pulses.

OFF delay 0 = Off The OFF delay lengthens pulses.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

I3 PEPPERL+FUCHS
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Parameter Preferred value

Explanation

(*) Note: The last two "xx" in "2xxx" identify the output driver type, e.g., "2x01" with 22 V

output voltage and 315 Q output resistance

[Table 2.7: Preferred parameter values for digital output LB/FB 2xxx

Analog inputs 3xxx

Preferred parameter values for analog inputs LB/FB 3xxx

3x02/03/05 only)

Parameter Preferred value | Explanation

HART (for 3x02/03/05 On HART power supply, only available for
only) analog inputs 3x02, 3x03 and 3x05.
HART scan (for On Automatic readout and storing of HART

values (long address / auxiliary variables)

Operating mode Normal

You can start a manual simulation here for
test purposes (forcing 1/0O values).

Error mode Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100% 10000 ... 50000
(Start of range/end of

range)

Adapt scaling to the master range (O ...
65535).

Line fault detection Off

Line fault detection recognizes lead
breakage or short circuit.

status

Switching points <1mAand | Threshold values for lead breakage and
>21 mA short circuit detection

Extended parameters

Analog filter 0 = Off If the input signals fluctuate, an analog filter
can be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

[Table 2.8: Preferred parameter values for analog inputs LB/FB 3xxx
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Analog outputs 4x01, 4x02

Preferred parameter values for analog outputs LB/FB 4x01 and 4x02

Parameter Preferred value | Explanation

HART (4x02 only) On HART power supply, only available for
analog output 4x02.

HART scan (4x02 only) On Automatic readout and storing of HART
values (long address / auxiliary variables)

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/O values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%
(Start of range/end of
range)

10000 ... 50000

Adapt scaling to the master range (O ...
65535).

status

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

Minimum output current 1 mA A minimum output current can be specified
for line fault detection (for 4 ... 20 mA only).

Extended parameters

Analog filter 0 = Off If the signals fluctuate, an analog filter can
be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

[Table 2.9: Preferred parameter values for analog outputs LB/FB 4x01 and 4x02
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Analog outputs 4x04, 4x05

Preferred parameter values for analog outputs LB/FB 4x04 and 4x05

Parameter Preferred value | Explanation

HART (4x05 only) On HART power supply, only available for
analog output 4x05.

HART scan (4x05 only) On Automatic readout and storing of HART
values (long address / auxiliary variables)

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/O values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%
(Start of range/end of
range)

10000 ... 50000

Adapt scaling to the master range (O ...
65535).

status

Minimum output current 1 mA A minimum output current can be specified
here (for 4 ... 20 mA only).

Line fault detection Off Line fault detection recognizes lead
breakage.

Extended parameters

Analog filter 0 = Off If the signals fluctuate, an analog filter can
be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

[Table 2.10: Preferred parameter values for analog outputs LB/FB 4x04 and 4x05
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Temperature inputs 5x01, 5x04

Preferred parameter values for temperature inputs LB/FB 5x01 and 5x04

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%

10000 ... 50000

Adapt scaling to the master range.

(Start of range/end of (0 ... 65535)

range)

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit.

LFD-delay 10 Set how many cycles a lead breakage
signal should remain active after the
process circuit has been restored.

Measurement method 4-wire Here you can choose between a 2-, 3-, or

configuration | 4-wire configuration.

Measurement range 0...100 °C Enter the required measurement range.

The smallest span for an accuracy of 0.1%
is 20 Q (5x01) or 50 Q (5x04).

Line resistance

20 Q (only for a

Specify the resistance value of the

status

2-wire connection line.
configuration)

Sensor type Pt100 Select the linearization curve or an input
proportional to the resistance (slide-wire
sensor).

Line filter 50 Hz

Temperature unit °C Choose between °C and °F.

Extended parameters

Analog filter 0 = Off If the signals fluctuate, an analog filter can
be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

[Table 2.11: Preferred parameter values for temperature inputs LB/FB 5x01 and 5x04
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Temperature input 5x02

Preferred parameter values for temperature input LB/FB 5x02/5x05

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%
(Start of range/end of
range)

10000 ... 50000

Adapt scaling to the master range (O ...
65535).

status

Line fault detection Off Line fault detection recognizes lead
breakage.

Reference junction internal Reference junction compensation either
takes place internally with a Pt100 sensor
on the terminals (accessories) or externally
with a thermostat.

Sampling rate for line 1:10 The reference junction ratio allows faster

fault detection temperature measurement or more
frequent querying of the reference junction
(for an internal reference junction).

External reference 50 °C If reference junction compensation takes

junction temperatures place externally with a thermostat, set the
temperature here.

Measurement range -200 ... 600 °C | Enter the required measurement range.

) The smallest span for an accuracy of 0.1%
is 5 mV.

Sensor type K Select sensor type for correct linearization.

Temperature unit °C Choose between °C and °F.

Extended parameters

Analog filter 0 = Off If the signals fluctuate, an analog filter can
be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

(*) The measurement range depends on the type of input signal selected.

[Table 2.12: Preferred parameter values for temperature input LB/FB 5x02/5x05
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Voltage input 5x06

Preferred parameter values for voltage input LB/FB 5x06

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Scaling 0% ... 100%
(Start of range/end of
range)

10000 ... 50000

Adapt scaling to the master range (O ...
65535).

Measurement range 0..10V Enter the required measurement range.
The smallest span for an accuracy of 0.1%
is 100 mV.

Line filter 50 Hz

Extended parameters

Analog filter Off If the signals fluctuate, an analog filter can
be activated for signal attenuation.

Transmission range 0 ... 60000 Adapt scaling to the master range.

(lower/upper limit)

Substitute value as required Substitute values from the set error mode
are used in the event of a fault.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Substitute value with On

status

Simulation value as required During a simulation, simulation values are
used depending on which operating mode
was selected.

Invalid simulation value Off Indicates that the simulation value is
flagged as invalid.

Simulation value with On

status

[Table 2.13: Preferred parameter values for voltage input LB/FB 5x06
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Relay output 6x01

Preferred parameter values for relay output 6x01

Parameter

Preferred value

Explanation

Operating mode

Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Extended parameters

ON delay 0 = Off After bus data received.

OFF delay 0 = Off After bus data received.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a simulation, simulation values are

used depending on which operating mode
was selected.

Invalid simulation value

Indicates that the simulation value is
flagged as invalid.

[Table 2.14: Preferred parameter values for relay output 6x01

Relay outputs 6x05, 6x06

Preferred parameter values for relay outputs LB/FB 6x05 and 6x06

Parameter Preferred value | Explanation

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1."

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/O values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Extended parameters

ON delay 0 = Off After bus data received.

OFF delay 0 = Off After bus data received.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a simulation, simulation values are
used depending on which operating mode
was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

[Table 2.15: Preferred parameter values for relay outputs LB/FB 6x05 and 6x06
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Digital output 6x08

Preferred parameter values for digital output LB/FB 6x08

Parameter Preferred value

Explanation

Inverter Off

Use the inverter if the digital input produces
a "0" when you need a logical "1."

Operating mode Normal

You can start a manual simulation here for
test purposes (forcing 1/0 values).

Error mode Substitute value | Specify the required response in the event
of a fault.
Line fault detection Off Line fault detection recognizes lead

breakage or short circuit and reports these
states uniformly as line faults.

Extended parameters

ON delay 0 = Off After bus data received.

OFF delay 0 = Off After bus data received.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

[Table 2.16: Preferred parameter values for digital output LB/FB 6x08
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Digital outputs 6x1x

Preferred parameter values for digital outputs LB/FB 6x10 - 6x15

Parameter Preferred value | Explanation

Inverter Off Use the inverter if the digital input produces
a "0" when you need a logical "1."

Operating mode Normal You can start a manual simulation here for

test purposes (forcing 1/0 values).

Error mode

Substitute value

Specify the required response in the event
of a fault.

Line fault detection Off Line fault detection recognizes lead
breakage or short circuit and reports these
states uniformly as line faults.

Extended parameters

ON delay 0 = Off After bus data received.

OFF delay 0 = Off After bus data received.

Substitute value as required Substitute values are used in the event of a
fault depending on which error mode was
selected.

Invalid substitute value On Indicates that the substitute value is
flagged as invalid.

Simulation value as required During a manual simulation, simulation
values are used depending on which
operating mode was selected.

Invalid simulation value Off Indicates that the simulation value is

flagged as invalid.

[Table 2.17: Preferred parameter values for digital outputs LB/FB 6x10 - 6x15
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Introduction

Overview Remote I/0

This manual contains information on the configuration of Remote 1/O stations. The
following provides a general overview of the P+F Remote 1/O system.

Figure 3.1: Example for LB/FB Remote 1/O stations

1 LB Remote I/O station for the safe area and Zone 2
2 FB Remote I/O station for Zone 1

System concept

The system can be adapted to the plant structure. The ability to adapt is based on a flexible
modular structure and a wide product spectrum.

The system architecture is determined by the number of Remote 1/O stations on each bus
line. The Profibus standard states that a bus line without repeaters may only contain 31
Remote 1/O stations and a bus line with repeaters up to 125 Remote I/O stations.

Up to 48 1/0 modules are available for each Remote 1/O station, which corresponds to 80
analog or 184 digital channels (or a mixture of the two).

Specification RS485 states that the maximum physical expansion of the bus line is 1200 m
at 93.75 kbaud. Even long distances can be bridged using repeaters or fiber optic couplers.
The Profibus allows only limited use of branch lines or use in combination with repeaters.
P+F Remote I/O stations do not require barriers, even for ZONE 1, because a connection
with increased safety is used. Refer to the hardware manuals for the LB/FB Remote I/O for
more information on bus lines.

Compatibility

When developing new installations, P+F always takes into consideration compatibility with
existing equipment. In many cases, a software update of the Com Unit is all that is needed
to make new functions work. Occasionally the Com Unit will need to be replaced in order to
accommodate new features.

Currently available modules are listed elsewhere with part numbers.

Since 2001, new module enclosures and new backplanes with improved mechanical
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characteristics have been provided for all LB I/O modules. The new LB I/O modules are
compatible with the LB backplanes in existing plants. The new backplanes have their own
order code and can only be populated with Com Units, /0O modules, and power supplies
housed in the new enclosure. For details, please refer to the manuals for the modules and
backplanes.

Failure strategy

Appropriate failure strategies must be implemented to guarantee the functional reliability of
the plant, which requires interaction between the process control system and the Remote
I/O stations.

The failure characteristics of the Remote I/O stations can be adjusted separately for each
channel. The failure of an I/O module or channel is identified and signaled to the control.
The start-up characteristics following a fault are essentially defined by the master (PCS).

Available I/O modules
The "x" in the following I/O module names represents different options:

¢ Digital input 1x01, 2-channel,

¢ Digital input 1x02, 3-channel,

* Frequency input 1x03, 1-channel,

* Digital input LB 1007, 7-channel (only with Com Unit 8108),
¢ Digital input 1x08, 8-channel,

¢ Digital input LB 1014 and LB 1015, 15-channel (only with Com Unit 8108),
» Digital output 2xxx,

* Analog input 3x01,

* HART analog input 3x02 and 3x03,

e HART analog input 3x04 and 3x05, 4-channel,

* Analog output 4x01,

* HART analog output 4x02,

¢ HART analog output 4x04 and 4x05, 4-channel,

e Temperature input 5x01 (Pt100),

e Temperature input 5x02 (thermocouple),

* Temperature input 5x04 4-channel (Pt100, Ni100),

e Temperature input 5x05, 4-channel (thermocouple, mV),
e Voltage input 5x06, 1-channel,

¢ Relay output 6x01, 2-channel,

¢ Relay output 6x05, 4-channel,

* Relay output 6x06, 8-channel,

» Digital output 6x08, 8-channel,

¢ Digital output 6x1x, 4-channel,
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Diagnostics

Status diagnostics are reported to the higher level system via the system bus. An additional
query via a service bus that is independent of the primary bus is also possible.
Interference signals are mostly filtered out. However, a state-of-the-art screening concept
should still be applied. Some I/O modules have adjustable filter functions.

The following integral monitoring functions are available:

e System bus monitoring,

* Internal data communication monitoring,

¢ |/O module self-monitoring,

e Line fault detection of field signals (depending on module),

* Defined control direction in the event of a fault (depending on the Com Unit);
e Outputs are equipped with a watchdog function.

Performance of the I/O modules

P+F offers I/O modules with different channel characteristics to maximize system
availability and reduce cost pressure. The different I/O modules can be combined within a
Remote 1/O station in any configuration.

High-availability, single-width 1/0O modules (1 or 2-channel) or

compact, dual-width I/O modules (8-channel (digital) / 4-channel (analog)) are available for
selection.

15-channel, dual-width digital inputs are also available for Com Unit LB 8108.

Galvanic isolation

The channels on single or dual-channel, high-availability I/O modules are galvanically
isolated from one another and from the internal system bus. The channels on all other I/O
modules are also galvanically isolated from the internal system bus, but are not isolated
from one another.

Configuration tasks

The I/0 modules have neither switches nor potentiometers. When an 1/0O module is
replaced, the new module automatically adopts the configuration of the previous module
(provided the same type of module is used). Parameterization takes place once during
commissioning and the parameters are stored in the non-volatile memory of the Com Unit.
Reverse polarity and short circuit protection are available as well as adjustable failure
characteristics. The effective direction of digital inputs and outputs can be parameterized
depending on the model.

Output disable function

The electronic circuit and the load circuit of relay outputs are supplied separately. Similar to
valves, an I/O module with bus-independent output disable input ensures that the position
feedback is still received when the power to the valve is disconnected.
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Extension/Replacement

1/0 modules can be plugged in or unplugged during operation while connected to the
power supply (hot swapping). Extending Remote I/O stations while the system is operating
is only possible using process control systems that support HCIiR (Hot Configuration in
Run). If the control system does not support HCiR, a P+F UniCom Com Unit (LB/FB 8x09)
can be used to extend the station while the system is operating.

Bus system
The fieldbus system fulfills the following criteria:

e Physical properties as per RS485 standard,

* Topology: Line structure,

¢ Nodes: 32 without repeaters, 126 with repeaters,

¢ Max. length expansion per bus segment: 1200 m depending on bus speed,
¢ Interface profile (RS485),

¢ Transmitting medium (twisted pair, fiber optic).

Protocol features

* Bus access as per Profibus DP standard (cyclic) or DPV1 standard (acyclic),
¢ Transfer rate up to 1.5 Mbaud

» Data security as per Profibus standard,

¢ Node communication according to the master/slave principle.

Availability
P+F Remote I/O offers:

¢ Redundancy (system-dependent)

e Operational reliability (adjustable failure characteristics)
* Individual availability (replacement channel by channel)
* Hot swapping

* Hot Configuration in Run (HCIR, system-dependent)

* Adjustable start-up characteristics following a power failure in conjunction with the
master (must be defined in the PCS).

Com Unit

The Com Unit converts the protocol of the system bus integrated in the backplane into the

protocol of the higher-level bus system. The scope of application of the Remote 1/0

systems is largely determined by the fieldbus system. For this reason, a connection to

currently the most frequent fieldbus systems was established with support from the

different Com Unit types.

Redundancy

Redundant communication with a suitable field bus system is possible, if the bus system
allows. Redundancy is being successfully applied with different control systems. The high
level of availability is achieved internally by means of segmenting and with the large
number of selectors used for connecting the modules to the Com Unit.
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Software

The quality of the system software is largely determined by how well it integrates with the
engineering tools of higher-level control systems. The remote IO stations can then be
configured as part of the overall system using a common user interface. This avoids the
need to duplicate data entry and data storage.

The handling requirements for the software components and the resources required are
low. Multilingual versions of the software are available for international use
(German/English as standard). Software upgrades ensure compatibility with existing
systems of the same type.

P+F offers a Device Type Manager (DTM) for integrating the field device concept (FDT)
based on PNO guidelines into the system. Alternatively, you can use EDDs for Siemens’
PDM tool. Large-scale engineering plants running systems from all major system
manufacturers can be operated successfully on this principle.

Configuration/Parameterization

The Com Units and 1/0O modules can be configured via the central engineering station.
Device names and installation positions can be stored for the components and TAG names
can be stored for the input and output signals. The system configuration is subject to
integral plausibility checks.

Functions for importing / exporting data enable the transfer of the configuration to other
process control systems without significant changes being made. GSD files make
component selection easier.

HART communication

Intelligent field devices can be configured and parameterized via the process control
system. HART field devices can be parameterized independently of the bus system using
approved handhelds connected to terminals equipped with a built-in 250 Q communication
resistor. With HART communication on the Profibus supported by FDT and DPV1, standard
commercial software tools can be used for remote control via the bus.

Monitoring

The status of the system components and the signal state values of the field devices can
be viewed online during operation. The installation of a separate service bus that allows the
diagnosis of errors independently of the process control system is recommended here.
However, the service bus is not absolutely essential for obtaining a fully operational
system.

Simulation
Input and output values can be simulated for test functions and commissioning purposes.

Interfaces and data exchange
The exchange of data with other engineering tools via standard interfaces prevents
redundant engineering (e.g. the import/export of ASCII files (XML document)).
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Remote I/0O with Profibus DPV1

Integration of master and slave

The growing number of Profibus installations has led to the full integration of PCS and
Remote 1/O systems. The configuration tool of the master now also allows the direct
configuration and parameterization of slave devices. All the setting parameters are stored
in a joint database from the engineering system and can be stored safely in the Com Unit of
the Remote 1/O stations by downloading them via the Profibus DPV1.

Compatibility of Profibus DP and Profibus DPV1

The FDT concept was taken into consideration during the development of the Profibus
(DPV1).

Profibus DPV1, which has some important new features, is fully compatible with the
Profibus DP. This ensures that DPV1 field stations function with an existing Profibus DP in
the same way as an existing slave works with a DPV1 master. However, the user can only
make use of all the advantages of the DPV1 concept if both master and slave have the
DPV1 features.

In addition to the synchronous cyclic data traffic of the Profibus DP, the Profibus DPV1 also
provides asynchronous services that allow the exchange of parameter and configuration
data between master and slave. Whereas cyclic telegrams belonging to one participant are
always of the same structure and length, the data exchange of the DPV1 is characterized
by a fixed buffer area into which data telegrams that are imported for the parameterization
and configuration can be inserted, when required (see illustration below).

Remote 1/0O for zone 2 Remote 1/O for zone 1

Figure 3.2: Cyclic data transfer to the Profibus
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HART communication via Profibus DPV1

The new features of the Profibus DPV1 enable the transmission of HART telegrams. In this
way, existing field devices can also be operated using the HART protocol depending on
which control system functions are supported. This functionality was previously reserved
for the Profibus PA.

P+F Com Units accept all types of HART data. As a result, device-specific information on
all HART devices can be accessed via the Profibus, provided the manufacturer has
released your HART-DTM for the FDT.

Remote 1/O for Profibus DPV1

Hardware

For users of P+F LB/FB Remote I/O systems it is easy to use the advantages of the
Profibus DPV1. All existing /O modules can still be used, only the Com Unit needs to be
replaced to enable the new function on the P+F slaves.

The main catalog contains a list of technical data for all /O modules and system
components.

Software

The system house integrates the DTM software for P+F LB/FB Remote I/O systems into
the engineering tool of the master using the FDT concept. This DTM software matches the
firmware in the Com Unit.

The user receives this manual and a CD ROM with the DPV1 Com Units. The manual and
CD contain descriptions of the features of the Remote 1/O systems as well as instructions
on how to use the configuration tools.

Although the settings are made via the master, the extremely useful option of using the
service bus is still available. During commissioning, the user can already carry out loop
tests using this second bus while the control system is still being assembled. Further
options provided by the service bus include

¢ Assistance during commissioning,

¢ Simulation of inputs and outputs,

¢ Fault analysis during operation,

* Remote diagnosis via modem using PC-ANYWHERE,

¢ Software updates.
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Differences between Remote I/O systems using Profibus DP and
DPVA1

The main differences between Remote I/0O systems for Profibus DP and DPV1 are
summarized below.

* In P+F Remote I/O systems, the only hardware difference between Profibus DP und
DPV1 is the Com Unit. All other components remain unchanged.

¢ In addition to the cyclic data transfer services, the DPV1 protocol software also provides
acyclic services for parameterizing and configuring the slave devices using the
engineering tools in the master.

* In theory, the Profibus allows parameter changes during active data exchanges (e.g. via
DPV1 or SetPrm) providing these changes do not affect the Profibus configuration. How
these changes are made depends on the manufacturer of the PLC or process control
system.

e The P+F LB/FB Remote I/O system offers numerous diagnostic options and optionally
provides cyclic status information from the Com Unit and the I/O modules. The status
information from the Com Unit includes exact details of the operating mode and the
reason for the fault. The module status indicates which I/O module is not working
correctly (1 bit per I/O module). Apart from cyclic data, the Remote I/O station also
provides new event-related diagnostic data (standard DP diagnostics + extended,
manufacturer-specific diagnostic data) as soon as the error state or the status of the
Remote /O station changes. Furthermore, the Remote I/O station has diagnostics
areas that can be exported using DPV1 read services if required.

¢ In DP systems, HART communication is only possible via the service bus. In a DPV1
Com Unit, the HART protocol is not transferred via the service bus, but via the Profibus,
provided the master supports it. Otherwise, a secondary master is used.

* Depending on the Com Unit, redundancy is possible for P+F Remote I/O systems both
in DP and DPV1 applications.

¢ Analog inputs and outputs can be scaled to the range required by the process control
system. On the DP bus, one shared parameter is used to scale all the inputs and
another shared parameter all the outputs. The DPV1 Com Unit allows all inputs and
outputs to be scaled separately via a channel-specific parameter.

¢ If a DP Com Unit fails, outputs can be set to zero, 0%, or 100%. In DPV1 systems, any
substitute value within the measuring range can be set for each channel.

* In addition to the choice of positive or negative logic, in DPV1 applications there is the
option of defining an ON delay and OFF delay for digital inputs.

e DP Com Units allow inputs and outputs to be linked together inside a bus station without
intervention from the master. DPV1 systems do not provide this option. The same
applies to software tools in DP systems for programming mathematical and logical
functions in the Com Units. In DPV1 Com Units this is left to the master.

¢ DPV1 Com Units are available for the most popular process control systems and have
passed system integration tests successfully. P+F Remote 1/O systems are used with
more than 20 different process control systems and PLC controllers from well-known
manufacturers. Hundreds of thousands of I/O modules are in use worldwide.
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Features of different Com Units

The table below contains an overview of available Com Units and their features.

Features of different Com Units

LB hardware (Zone 2) H 8103 H 8105 H 8106 H 8107 H 8108 H 8109
FB hardware (Zone 1) H 8203 H 8205 H 8206 H 8207 H 8209
Firmware version (*) 4.X 6.X 6.X 7X 8.X 9.X
Operator interface or DTM for FDT 0.98 4/5/6 6 6
Operator interface or DTM for FDT 1.2 7 @) @) 7 7
Operator interface as Profibus simulator PACTware PACTware | PACTware
Service bus required
Service bus usable [ [ O ) O [
HART via service bus @) @) @) @) @)
HART via Profibus () [ ] [ o [ ]
HART auxiliary variable, cyclic O O O O O
GSD/GSE file CGV40710 | CGV61710 | CGVE1711 CGV61712 | CGV61710
Profibus DP o o o o o
Profibus DPV1 ) ) ) ) )
Modbus ([
Redundancy [ [ ) O O [
HCIR (configure during active data exchange, [ [ ) ) [ [
depending on system)
CIR (configure during active data exchange, o
regardless of system)
Time stamp (in combination with master) [ ]
1x01, 1x02, 1x03 () ([ o ([ [ ] [ ]
1x08 [ ) ([ ([ o o
1007, 1014, 1015 [
2xxx, 2xxx (SIL) (] (] o o (] (]
3x01, 3x02, 3x03 () ® o [ [ [
3x04, 3x05 [ o o [ [
4x01, 4x02, 4x02 (SIL) ) ) ) ) ) )
4x04, 4x05, 4x05 (SIL) ° ° ° ° °
4x05 (LFD) () () 0] () ()
5x01, 5x02 () [ ] [ [ o [ ]
5x04, 5x05 [ ([ o o [ ]
5x06 ([ ([ ([ ([ o [ ]
6x01 [ ) [ o o [ ] [ ]
6x04, 6x05, 6x06, 6x08, 6x08 (SIL) () [ o o [ ]
6x10 - 6x15 ) ) ) ) )
6x10 - 6x15 (SIL) [ e e [ [
Max. analog channels (depending on 48 80 80 80 80 24-80
configuration)
Max. digital channels (depending on 144 184 184 184 184 96-184
configuration)
@ = fulfilled or compatible; O = on request
(*) The module support sometimes depends on the firmware subversion. X

[Table 3.1: Features of different Com Units
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Installing configuration software

Introduction to configuration software

This manual applies to Com Unit 8x05 with firmware version 6.x and also, with some
restrictions, to Com Unit 8x03 with firmware versions 4.x and 5.x. Only Com Unit 8x05 with
firmware version 6.x supports all the functions and 1/0O modules described in this manual.

The remote /O configuration software is used to configure remote 1/O components and to
display measured values and status information during maintenance and commissioning.

The software can be used in process control systems that support the FDT concept (FDT
0.98). There you can configure the remote 1/O system directly from the system engineering
tool. It is also possible to use the configuration software as an independent tool (connecting
a PC to the service bus).

If your process control system supports DPV1, only use this configuration software for
maintenance tasks. However, it is advisable when parameterizing the devices to use the
master engineering tools, as then all the data will be managed in a database that conforms
to the system.

If your process control system does not support DPV1, you can use the configuration
software to edit the relevant GSD/GSE files. In this case, the configuration must also be
set-up via the process control system configuration tool.

Some process control systems also use their own drivers to configure P+F remote 1/0
components from the operator level within the system and have their own configuration
manual. This manual is only of limited relevance in this case. For instance, for Siemens S7
you should use their available PDM specification.

Differences between DTM and firmware versions

Hardware

The Com Unit supports all /O modules produced since 1995, even multichannel analog
and binary I/O modules.

DTM software

* In DTM Version 6, the graphic representation of the modules from DTM Version 4 has
been replaced by a tree structure, which is familiar to you from such programs as

Windows® Explorer. The tree structure makes it possible to display several remote 1/0O
stations (Com Units) simultaneously in one project.

e DTM Version 6 no longer has a demo mode. The measured value display of the I/O
modules can only be shown when there is a service bus connection to the remote 1/0
station.

e DTM Version 6 is downward compatible to Version 4. You can continue to use the
configurations you created in earlier versions in V6. Existing configurations can also be
used for the new Com Unit models, which support additional hardware options such as
multichannel analog and binary I/O modules.
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X

e Com Units and I/0O modules are indicated in the DTM V6 tree structure by a symbol and
a TAG number. The channels of analog I/O modules are represented by a symbolic
measurement device with a right arrow (for output) or a left arrow (for input). The
channels of binary I/O modules are represented by the logic symbol 0/1 with a right
arrow (for output) or a left arrow (for input) (see table below).

The configuration window of the Com Unit now allows access to the new parameters.

E E redundant FB Com Unit
E multichannel I/O module
single-channel 1/0 module
04 binary channel (input)

.‘_

‘@ analog channel (input)

Com Unit firmware

Unlike older Com Units, Com Units with firmware version 5 also support multichannel
binary 1/0 modules. Firmware version 6 replaces the previous versions 4 and 5 and covers
all I/O modules, including multichannel analog I/O modules.

Hardware and software requirements

Your PC or laptop must meet the following (minimum) requirements so that you can install

the software.

¢ Processor with 500 MHz pulse frequency,
e 128 MB RAM,

* CD-ROM drive,

e 30 MB free hard disk space,

* Operating systems: Microsoft® Windows® 95/98/2000/NT/XP

Windows® is a registered trademark of the Microsoft Corporation.

Installing configuration software

P+F DTM software is suitable both for LB and FB remote I/O products. The CD-ROM

contains full documentation for all the modules, including ATEX certifications.
Installing configuration software

1. Insert the accompanying CD ROM in the CD/DVD drive.

2. Wait until the language selection window opens automatically (view Figure 4.1 on page
45). If the language selection window does not appear automatically on your screen,
open the setup.exe file in Windows Explorer.
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PROFIBUS COM UNIT
Installing configuration software

(T —)

“ Select the language for the installation from
: the choices below.

T — - |

I Ok I [ Cancel ]

Figure 4.1: Language selection window

3. Select the required language from the drop-down list.

4. Click OK to continue.
The welcome screen appears.
5. Click Next to continue.
The License agreementwindow opens.
6. Click Yes to accept the license agreement.

The User information window opens (view Figure 4.2 on page 45).

Customer Information

Please eﬁtﬁfiﬁour inlorm.ati.o.?._ EPEPPER’L‘II'_F.UCHS

Please enter pour name and the name of the company far which you wark.

User Mame:
P+F Used |

Company Mame:

|Pepper|+Fuchs Group |

IrigtallShield

< Back MNext > I I Canicel

Figure 4.2: User information

7. Enter your name and the name of your company in the appropriate boxes.

8. Click Next to continue.

The Select installation path window opens (view Figure 4.3 on page 46).
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DTM Collection Remote 1fO System - LB-FB ¥7.4.0 (FDT 1.2) Setup

Choose Destination Location

"I PEPPERL+FUCHS

Select folder where setup will install files.
SBtup_ will inztall Pepperl+Fuchz DT Caollection Remate [/0 System - LB-FE in the

following folder.

Tairstal to this folder, click Mest. Toinstall to a different folder. click Browse and select
another folder.

Destination Folder

£:4. ADtmFiemote |0 Systern - LE-FE

[ < Back ” Hext » ll Cancel ]

Figure 4.3: Selecting the target path

9. Click Next to confirm the default folder.

Click Browse to select a different folder. Select a folder and then click Next.

The Setup type window opens.

DTM Remote /0 System - LB-FB (¥6.7.0 / FDT 0.98) Setup engl.
Setup Type 3y
Select the zetup type to inztall Hed PEPPERL""FUCHS

Click the type of setup you prefer, then click Next.

(%) Typical Frogram wil be installed with the most common options. Recommended for
most users.
() Compact Program will be installed with minimum required optiores.
) Custam ‘rou may select the options you want ta install. Recommended for advanced
Ligerg.
< Back |[ Mest > I [ Cancel

Figure 4.4: Setup type window

10. Select the required setup type by activating the relevant option.

11. Click Next to continue.

If you selected Standard or Minimum as the setup type, installation will now begin.

Skip the next step.

12.1f you selected User-defined as the setup type, choose the components to install from

the Select options window. Then click Next.

Installation begins.

13.Enable/disable the check boxes to display/not display the read-me file containing
important information and to then start/not start the configuration software.

14.Click Finish to conclude the installation.
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Configuration software setup

Starting the configuration software

Starting the configuration software

1. In Windows, select Start > Programs > LB+FB Remote 1/0.
A dialog box opens.
2. Click OK to continue.

The Login window appears.

Login

User Mame:

Paszword: |

Done | Cancel

Figure 5.1: Login window

3. If you are using the software for the first time, enter "CGD" as your user name and
"Safety" as your password. These entries are case-sensitive (default master key).

If you have already set up your own user name and password, enter them in the boxes.

4. Click Next to continue.

If your user name and password were correct, an information window opens to inform
you of your user rights. If you have logged on using the default master key, you are
logged on as a "Supervisor" (unrestricted user rights).

If your user name or password were incorrect, a fault message is displayed and you are
merely logged on as an "Observer" (greatly restricted user rights).

Note!
Changing the default password

The default Supervisor user data allows unrestricted access to all the software functions
(Supervisor rights). To prevent unauthorized access, change the Supervisor password as
soon as possible (see chapter 5.3).
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Overview

The program window is divided into several areas.

Lz MMLLB/FP”_“pte 1f0: LB-810X => LB Comm. Module PROFIBUS =J2Ed
Fle Device D\ / Services Options Return Specials Help
== = @\ |2 m[e| 2| IModGEDE: ‘W(C-i) Application mode:  with HCiR Userrights:  SUPERVISOR
@— = HGRE® COML TAG-Na. [ shat | type acive [ch.(im) [ ch{ow |
= o1, Fe-820% i e-1o01 3 1001 ves 2 0
= o1, Feea0s @ e-3104 445 3104 ves 4 0
chot,
choz,
chos,
chod,
—= [ 02187810%
Bl G
g% c:m,
A chaz,
@— =@ 04,18-3104
chot,
choz,
chos,
chod,
Press Fi for help Powisr data:_1st backplans maxfcur 5v EEWILEY 12v [[EwWiaaW @ckplane maxjeur 5v BEW 000 12v [EEW 000 /)

Figure 5.2: Program window overview

Menu

Toolbar

Header

Project view as tree structure

Com Unit of the remote 1/O station (slave 2)
I/0 module LB 3104 in slave 2, slot 4+5
List of slave devices with their parameters

0 N O oA WODN =

Status bar, shows the power consumption of the selected slave

There are also two program window views, which are identical in structure but contain
different menus:

* Main window: This view is active once the program is started. The menu functions in
the main window are mostly general, such as connection setup, password settings,
documentation functions and communication settings.

To move from the device data window to the main window, select Back > Back to main
window from the menu.

¢ Device data window: The device data window is where you parameterize Com Units
and I/0O modules. Functions for loading and saving configurations are also available.
To move from the main window to the device data window, select Device data > Edit
device data from the menu.

The header shows which view is currently active.

Connection Diagnostics  Module data  Options  End

| ﬁ]ﬁ| 1@1“] _J %—| Jl _‘?_j Main Window Application mode:  with HCiR Us
Figure 5.3: Header of the main window

File Device Display Services Options Return  Specials

& 0S| o wlaa]ms 2| IMedileData Windov Application mode:  with HCGIR | Us

Figure 5.4: Header of the device data window
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In both program windows, the toolbar gives you fast access to important functions.

@@ D|=d| = F|2|5|@n 2
PEOOL ® OB O ®

Figure 5.5: Toolbar

Load project from read/write tag

Save project on read/write tag

Create remote 1/O station and add to project

Load remote I/O station from read/write tag

Save remote I/O station on read/write tag

Edit I/O module

Connect

Download (load data from configuration software to remote I/O station).
9 Upload (load data from remote 1/O station to configuration software).

00 N O o hs WODN =

10 Display measured value/status of selected 1/0O module
11 Read out FLASH-RAM area (for service personnel only)
12 Show welcome screen with version information

Setting up password protection and user levels

Parameter settings can be protected against unauthorized modification by passwords.
Whenever you start the configuration software and exit the welcome screen with OK, the
Login window appears, asking you for your user name and password.

Login

User Name:

Paszword: ] xxxxxx

Done | Cancel

Figure 5.6: Login window

There are four user levels with different authorizations to allow various employees access
to the different levels. The header of the program window indicates the user level to which
you are currently logged on.
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User level

Level

Authorization

Supervisor

Changing the Supervisor password
Setting up other users (Specialists, Maintenance)
Access to all other program functions

Specialist

No access to the Supervisor password

No access to other Specialist passwords, cannot set-
up Specialists

Setting up Maintenance users
Access to all other program functions

Maintenance

No access to the Supervisor password

No access to other passwords, cannot set-up other
users

No access to the RamView storage area
Access to all other program functions

Observer
(all users without a
password)

No access to passwords, cannot set-up other users

All program functions are disabled, apart from
displaying data and measured values

If you are starting the configuration software for the first time, enter the the factory default
Supervisor user data in the Login window (see chapter 5.1). We recommend that you
change the default Supervisor password as soon as you log on to prevent unauthorized

access.

Note!

Supervisor user data

As a Supervisor, you can change the Supervisor password at any time. But do not delete
the Supervisor user. If you delete the Supervisor user, you will not be able to set up a new

one.

As a Supervisor, the way that you set up new users is described below.

Installing new users

1. In the main window, select Options > Password > Settings.

The Change password / Install user window opens with a list of all the installed users.

Change Password f Install User

Installed Users:
User Lesvel
CGD 3

Change password
Read pazsward
Install user
Remove user

Figure 5.7: Change password / Install user window with 1 user (Supervisor)

2. To set up a new user, click Install user.

The Install user window appears.
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Install user

Access

" Maintenance {+ Specialist

Uszer Mame: ]Example User

Password: |

Install uzer [:! Cancel

Figure 5.8: Install window

In the Access area, select the level of user rights for the new user.

4. Enter the required values in the User name and Password fields.

5. To finish the process, click Install user.

The new user now appears in the list.

Change Password f Install User

Installed Users:

User. Lesvel

CGD 3
Example User 2

Change password
Read pazsward
Install user
Remove user

Figure 5.9: Change password / Install user window with 2 users

Other functions in the Change password / Install user window

* Change password: Changes the password of the selected user (your own password
and the passwords of all users at a lower user level).

¢ Read password: Displays the password of the selected user (your own password and
the passwords of all users at a lower user level).

¢ Delete user: Deletes the selected user (your own user and users at a lower user level).

Note!

Should the master password go missing, the CD-ROM is the key.

You only need the master password if you use the Device Type Manager as a stand-alone
application (independent tool) for configuration via the service bus. If you configure the
remote /O station directly via the process control system, the master will handle password

protection.
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Configuring communication

The communication software communicates with the remote I/O stations via the service
bus. Up to 31 nodes can be connected to the service bus. Repeaters can be used to
increase the number of nodes to 119.

The service bus is designed as a Modbus.

Connect a standard RS232—-RS485 interface converter (available separately) to the RS232
interface of your PC or laptop to provide a bus connection.

Note!

To meet all requirements, the standard interface converters must support automatic baud
rate detection and automatic change of direction.

Before you can establish a connection to a remote I/O station via the service bus, you must
set up the serial interface of your PC or laptop (Com1 ... Com4).

Configuring the PC serial interface

1. In the main window menu, select Options > Communication > COM Port settings.

The Serial interface settings window opens.

COM-Port Canfiguration &
FU Olne o Configu ston

P s

Paly  nona s Mgt 9500

Por  [Comn =

ok ] _cwes |
Figure 5.10: Serial interface settings window

2. Set which serial interface of your PC or laptop you would like to use to establish the
service bus connection (COM 1, COM 2, etc.). The settings for the port connections in
the Com Unit must match those in the configuration software. The defaults for the Com
Units are "Baud rate = 9600" and "Parity = none".

3. To finish the process, click OK.

You can also specify how often the software is to access data from the remote I/O station
(status and command register) in the Options > Communication > Refresh rate for
online data menu.
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Additional settings

Configuration Mode Settings

[+ Hot-Configuration-in-Bun [HCIR] support. configuration for commisioning
Profibuz without stopping data exchange [Comm Lnits Firmware >= 4.30]
Mote: HCIR capabillities vary with the Master DCS.

For OMLIME config. via zervice bus follow handling instructions.

[ Show analog onling value in the list view [right). The refresh rate could be
15 up to B0 [depends on the spstem)

I

Figure 5.11: Settings window

Additional settings can be made in the Settings window. To open the window, select
Options > Settings from the main window.

Note!
HCIR setting

This setting only applies to PROFIBUS Com Units. This setting is not used for Modbus
Com Units and has no effect on them.

* Hot Configuration in Run (HCiR) (PROFIBUS only): Enable this option if your process
control system supports HCIiR (see chapter 6.8). When the HCIR option is enabled, the
remote 1/O station can be configured during operation. It is necessary to restart the bus
for the new configuration to take effect.

* Display of analog measured values in the overview: Enable this option to query all the
slave devices connected to the service bus and display the analog measured values in
the overview. Note: Enabling this option slows down the response time of the service
bus. Leave this option deactivated if you want a fast response time.

Connecting to a remote I/0O station

For online configuration, the display of measured values or downloading/uploading
parameters from/to the remote I/O station, it is necessary to have a hardware connection
between the configuration software and the remote I/O station. The connection is
established via the service bus.

Please refer to the LB/FB hardware manuals for the connection layout of the remote 1/0
station.

If you are using the process control system engineering tool for configuration, follow the
instructions for the particular engineering tool.

Warning!
Online configuration

Not all process control systems support configuration changes without de-energizing the
outputs (process control systems without HCiR support). Avoid the online configuration of
parameters with process control systems of this type, as this may cause malfunctions.

200
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Note!

Default Com Unit address

[0

All Com Units are given the default service bus address 1.

§< Connecting

1. In the main window menu, select Connections > Connect or click Connect on the tool-
bar.

You will then be prompted to save the data.
2. Click Yes or No to save or not save your data.

3. The Address range for station search window opens.

Searching for Comm Units

Address area:  lower range 1|

upperrange |10

Mote: pleaze use proven
RAS-232 / RS-485 converter

Ok, | Cahcel ‘

Figure 5.12: Address range for station search window

4. Enter the address range in which to search for Com Units (Com Unit service bus
address). The setting 1 to 119 covers the possible address range in full. If you limit the
address range, the search will take less time.

5. Click OK to confirm.

The software will now search for connected Com Units in the specified address range.
While the search is ongoing, the progress of the search is displayed as a percentage.

Found stations: 00

Searching at 002

0% 50% 100%

20 % done
(o]

Figure 5.13: Station search status

6. If the search is unsuccessful, a fault message is displayed. In this case, read the
“Troubleshooting” chapter.
If the search was successful, a list of the Com Units that were found is displayed. The
list contains the TAG No. and address for each Com Unit that has been found. Mark the
Com Unit to which you would like to connect and then click OK.

The connection is now established.

54
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Configure Com Unit

Loading Com Units into the configuration software

To configure the Com Unit of a remote I/O station, you must first load a Com Unit into the
configuration software window. There are various ways of doing this:

* Create a new project (offline configuration) (see chapter 6.1.1)

* Load an existing project from the read/write tag (offline configuration) (see chapter
6.1.2)

* Load a remote I/O station from the field (online configuration) (see chapter 6.1.3)

Note!

A project file usually contains all the remote I/O stations connected to a common service
bus.

Creating a new project

Creating a new project

1. Start the configuration software and enter your user name and password.
This will take you to the main window.
2. To add a Com Unit, select Device data > Edit device data.

The Select fieldbus / Local bus window opens.

Create Comm Unit
‘What kind of Comm Unit do you want to create?
LB/FE Type Firrmwiare Description
LE H 8103 4 HEiR »= 4.3% [y
LB H 8103 Bur HCIR + bin. multi channel f
LB H 8108 Euxx HCiR + bin. + ana. multi channel
LE H 8107 Toum IODBUS with bin. + ana. multi channel
FB H 8203 4xx HCIR »= 4.3 3
FB H 8203 Bx HEiR + bin. multi channel 1
Ok | Cancel

Figure 6.1: Select fieldbus / local bus window

3. Select a Com Unit and then click OK.

This opens the Com Unit configuration window. The Com Unit configuration is described
below (see chapter 6.2).
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Loading an existing project from the read/write tag

Loading a project from the read/write tag

1. Start the configuration software and enter your user name and password.
This will take you to the main window.

2. To load an existing project, click the Load project from read/write tag icon.
The Open window appears.

3. Select the required project file (*.prj) and click Open.

The project opens. One or more Com Units are displayed in the tree structure,
depending on the project.

4. Move to the device data window by selecting Device data > Edit device data.

5. In the tree structure, right-click on the required Com Unit and select File > Configure
Com Unit.

This opens a window in which to configure the Com Unit. The Com Unit configuration is
described below (see chapter 6.2).

Loading a remote 1/O station from the field

You can load the configuration from a remote I/O station to an empty project (only Com
Units without I/O modules) or to a project to which I/O modules have been assigned (Com
Units with 1/0 modules).

First establish a connection and then select a remote I/O station (see chapter 5.6). The
Com Unit is now displayed in the tree structure in single mode or redundancy mode (a Com
Unit in redundancy mode is recognizable from the double Com Unit symbol).

Loading a configuration to an empty project

Now load the complete station configuration into the software. If the configuration in the
Com Unit is not appropriate for the inserted modules, the software asks how it is to
proceed. In this case, the user decides how to proceed.

Note!

Com Units can be configured in advance, before you insert them in the slot. This can be
done in the office, for example, using a separate remote 1/0O configuration slot.

Loading a configuration into an existing project

If the remote I/O station has already been configured with the configuration software, the
software recognizes the configuration and the slot positions of the I/O modules and the
Com Units.

The software also detects whether the configuration of the remote 1/O station has been
modified outside the software and no longer matches the software configuration (for
example, if a new I/O module has been inserted into the backplane, or an I/O module
removed from the backplane). In this situation, you can decide whether to adapt the
configuration in the hardware or the software.
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If the Com Unit firmware does not correspond to the user interface, a warning is displayed

The occupied slots of the remote I/O station are displayed, each with their respective slot
numbers and TAG nos.

Connection  Diagnostics  Module data Oplions  End

Iﬁ | a‘ | | ‘ Edit Module Data I
— T 1 1 1
=1 HURE (CEML | TAG-Ha,
[{ o1, Le-510% F we-sio

Figure 6.2: Accessing the device data window

Accessing the Com Unit configuration window

1. Move to the device data window by selecting Device data > Edit device data.

2. In the tree structure, right-click on the required Com Unit and select File > Configure
Com Unit.

This opens a window in which to configure the Com Unit. The Com Unit configuration is
described below (see chapter 6.2).

Editing Com Unit device data

You can configure the remote I/O station online or offline. If you configure offline, you can
load the configuration to the remote I/O station at a later date. For offline configuration,
there is no service bus connection required between the software and the remote 1/0O
station.

A service bus connection is required for online configuration.

Caution!
Online configuration only with HCIR

Online modifications to some Com Unit/l/O module device parameters and online
modifications to the slot configuration change the data structure of the bus data telegram.
These modifications, therefore, trigger an automatic bus restart, which may result in
functions being interrupted.

Never modify these parameters online when a system is in operation (active connection to
a device) unless your process control system supports Hot Configuration in Run (HCiR).

200180 2009-08
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Note!
Settings in the configuration software

For settings made in the configuration software to take effect, the settings must be loaded
from the configuration software to the remote I/O station. Click Download on the toolbar or
select Device > Save station in box from the device data window menu.

The Com Unit configuration window is divided into various boxes and tabs.

__I Comm Unit LB-8105

B
TAGMNo:  |LB-B1OX w 1 oK. |
Praject Title: ] Q) Cancel ‘

Module Data: LE Comm. Module PROFIBUS( 3
J U Save
~Version Mo.
Configuration: W@anware [ext.]: r@ Firmware (int.): ’_@ extendad fumt'
Hiwf-Indes: ‘_®erien-No.: ]U ‘ exvigion counter: ’U_@ red. Comm Lin

Help

Backplane l Power supply] Hed@cy] Service bus1 Plofibus] Extra ]

u LLL

Type: ]system for redundant comm units with 22/24 1/0 slots LB 9022/24)

Mumber of extensions: 1 A ]

Figure 6.3: Com Unit configuration window

TAG No. box

Station name box

Measuring point description box
Configuration box

Firmware (ext.) box

Firmware (int.) box

HW index box

Serial no. box

9 Revision counter box

10 Ext. functions button

11 Redundancy Com Unit button
12 Tabs with additional functions

O N O O s WDN =

TAG No. box
Enter any name (max. 32 characters).
2

Station name box

58

Enter any name for the remote I/O station (max. 32 characters).
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Configure Com Unit

3

Measuring point name box

Displays the name of the measuring point (cannot be edited).
4

Configuration box

Contains the version number of the configuration software that was last used to adjust the
Com Unit parameters.

5

Firmware (ext.) box

Contains the Com Unit firmware version (update possible).
6

Firmware (int.) box

Contains the chip version (update not possible).

7

HW index box

Contains the hardware index (later extensions).

8

Serial no. box

Contains the serial number of the Com Unit (later extension).
9

Revision counter box

Contains the number of parameter changes that were made with the configuration
software.

200180 2009-08
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10
Ext. functions button

Opens the Firmware-dependent device functions window. There you can
activate/deactivate the functions that are dependent on the Com Unit firmware version. A
detailed description of this window can be found in the section “Selecting firmware-
dependent device functions” (see chapter 6.2.1).

11
Redundancy Com Unit button

Opens the configuration window for the redundancy Com Unit (if available). This button is
only available to you if, on the Redundancy tab, you have activated the Add red. Com
Unit tab (see chapter 6.2.4).

The configuration window for the redundancy Com Unit is identical to the Com Unit
configuration window; however, some functions are deactivated.

12
Tabs with additional functions

This area contains tabs with additional Com Unit functions. The tabs are described below.

Selecting firmware-dependent functions

Some Com Unit and I/O module functions are only supported from a certain Com Unit
firmware version. You can activate and deactivate these functions in the Firmware-
dependent functions window for the relevant Com Unit.

firmware depended device functions
| Description of device function | Firrriware:
v Disable HART by module E14
¥ | Dizable HART by channel 615
W | Adjustable offset for device specific PE diagnosis [default = 0) E.19
W | Addiional 12 byte madule related diagnosis E19
W | Use of powerfull binar output driver Be<10-14 6.22
W | Dizable the self controlled HART device scan (1D, TAG, add. variables) E.22
¥ | Suppart of addlional HART variables within the data exchange of module 3402 B.23
comm units fimware version at least |E ]ﬁ oK Caricel
I

Figure 6.4: Firmware-dependent device functions window

Firmware-dependent functions are listed in the Device function description column. The
minimum firmware version that the Com Unit must have to support the relevant device
functions is displayed in the Firmware column on the right.
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Opening and editing the Firmware-dependent device functions window

1. In the Com Unit configuration window, click the Ext. functions button.
The Firmware-dependent device functions window opens.

2. Click on the required check box to the left of the Description of the device function
column to (de)activate the respective functions. The required firmware revision is

determined automatically and entered in the Firmware for the selected Com Unit box.

3. To save your selection and close the window, click the OK button.

Individual HART module deactivation function

This function is not supported by the configuration software.

Individual HART channel deactivation function

When you enable this function, you can deactivate the HART communication of I/O
modules 3x02, 3x03, 3x05, 4x02 and 4x05 for each channel individually.
We recommend using this function if

* a HART-compatible device is not connected to the corresponding channel of the 1/0
module,

* HART communication fails and fault messages begin to accumulate,

* HART communication is no longer required (saves time, which can then be used for
required HART communication).

If you do not enable the Individual HART channel deactivation function, HART

communication for the previously mentioned 1/0O modules is enabled as standard.

Offset adjustable for module related PB diagnostics function

If you enable this function, you can modify the Module offset for diagnostics parameter in
the DP parameters window (Com Unit configuration window, PROFIBUS tab, DP
parameters button).

You can use the Com Unit parameter Module offset for diagnostics to influence the
counting method of module-related PROFIBUS diagnostics. This parameter determines
whether the diagnostic data of I/O module 1 is transmitted as module diagnostics 0 (offset
= 0) or module diagnostics 1 (offset = 1). We recommend using this function if the
diagnostic visualization in the process control system indicates an offset in the
diagnostics/module allocation (counting method).

If you do not enable Offset adjustable for module related PB diagnostics, Module
offset for diagnostics is set to 0 by default.
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Additional 12 byte module related diagnostics function

If you enable this function, you can modify the Additional module related parameter
diagnostics parameter in the DP parameters window (Com Unit configuration window,
PROFIBUS tab, DP parameters button).

Additional module diagnostics allows you to extend device-specific PROFIBUS
diagnostics for each I/O module by 2 bits. We recommend using this function for systems
with limited diagnostic capabilities.

If you do not enable the Additional 12 byte module related diagnostics function,
Additional module related diagnostics is disabled by default and no additional module-
related diagnostics are transmitted.

Use powerful valve drivers 6x10 - 6x14 function

If you enable this function, you can use digital outputs 6x10 - 6x14 in the remote 1/O station.

Disable automatic HART device scan function

If you enable this function, you can deactivate automatic scanning of the HART channels of
I/0 modules 3x02, 3x03, 3x05, 4x02 and 4x05 for each channel individually.

During the HART scan, HART data is retrieved and saved to enable quicker external
access. We recommend enabling this function if external access to HART data is not
required.

If you do not enable the Disable automatic HART device scan function, all the active
HART channels of the 1/O modules listed above are scanned by default.

Use extended PROFIBUS modes for 3x02 ... function

If you enable this function, the Data transmission mode drop-down list appears in the
device data window of 1/0O module 3x02. Here you can activate the transfer of HART
auxiliary variables in cyclic data traffic.

If you do not enable the Use extended PROFIBUS modes for 3x02 ... function, no HART
auxiliary variables are transferred and the Measuring method drop-down list does not
appear.

Warning!
PROFIBUS will restart if the data transmission mode is changed (3x02 only)

If you change the setting in the Data transmission mode drop-down list for analog input
3x02, it can affect the structure of the PROFIBUS data telegram. You will then need to
restart the PROFIBUS!

Only if your process control system supports HCIR will a change to this parameter not
affect the function of the remote I/O station (see chapter 6.8).
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PROFIBUS COM UNIT
Configure Com Unit

6.2.2 Editing the "Backplane" tab
. . — .
Backplane |F'0wer supplyl Fledundanc_l,ll Service busl Ploflbusl Extra |
Type: Is_l,lstem for redundant comm units with 22/24 1/0 slots (LB 9022324]@ LI

Mumber of extenzions: |1 1 : ) vl

Figure 6.5: Backplane tab

1 Type box
2 Number of extensions drop-down list

1
Type box

Select the backplane type used in the remote 1/O station. This setting also determines
which power supply types are available, as well as the number of possible extensions. The
type "redundant system with 22/24 module slots (LB 9022/24)" is selected in the example.

2
Number of extensions drop-down list

Specify here whether an extension to the base backplane is available. The following
selection options are available in the above example:

"0": No extension available

"1." Extension available

Example: You are using the base backplane LB 9022 with 22 slots. If you select "1" in
Extensions, a remote 1/O station with 46 slots is configured (base backplane with 22 slots
+ extension backplane LB 9024 with 24 slots).
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PROFIBUS COM UNIT
Configure Com Unit

6.2.3 Editing the "Power supply" tab
Backplane Power supply I Hedundanc_l,ll Service busl Profibusl Extra | T |
uzed/monitored power supples————————————————————
Type: | 9006: 24 DC galv. isa. v | ¥ | B0 (Base Wit I | P-4 [Extension Unit)
@ F04 28V 00 [~ P2 [Base Uni] I | P5 [Extension Linit
[ P23 (Baze Unit) I P [Extension Unit)

Figure 6.6: Power supply tab

1 Type drop-down list
2 Power supplies check boxes

1
Type drop-down list

Select the power supply. The options depend on the type of backplane being used (see
Type drop-down list on the Backplane tab).

2
Power supplies check boxes

Enable/disable the relevant check boxes to specify which connected power supplies you
wish to monitor. The number of check boxes that can be edited will depend on whether or
not you are using an extension (see the Extensions drop-down list on the Backplane tab).
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Editing the "Redundancy" tab

Backplane] Power zupply  Redundancy l Service bus] Profibus] Extra ]

Twp
v include redundant urit " Application Redundancy (™ Line Redundancy

O

Figure 6.7: Redundancy tab,

1 Add red. Com unit check box
2 Type area

1
Add red. Com unit check box

When Add red. Com Unit is enabled, redundancy mode is activated with 2 Com Units. The
Redundancy Com Unit button for opening the redundancy Com Unit configuration window
also appears.

The adjustment options on the Power supplies tab also depend on this check box.

2
Type area

Select the redundancy type (system-dependent). This area is only visible once you have
enabled the Add red. Com Unit window.

Application redundancy: Enable this option if both Com Units are meant to participate in
bidirectional data transfer.

Media redundancy: Enable this option if the process control system is meant to see both
Com Units of a redundant remote I/O station as a single device. Only the active Com Unit
sends data to the master. In this case, the bus lines should then be implemented in
redundant form from the master module onwards.

Note!
Information on redundancy

Refer to the hardware manuals for LB/FB Remote I/O for more information on redundancy
(basic information, redundancy types, power supply redundancy).
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Editing the "Service bus" tab

Backplane] Povwer suppl_l,l] Redundancy Service bus l Profibus] Eutra ]

buz address [1..119) |1

Figure 6.8: Service bus tab

In the bus address box, enter the Com Unit service bus address (address range 1 ... 119).

Editing the "PROFIBUS" tab

Backplane] Pawer suppl_l,l] Hedundancy] Service bus  Profibus ] Eutra ]

Bus adresse (1..125]; W DP-Parameter! : )

[¥ Bus timecut for outputs (ms):  |2000 3: @

Figure 6.9: PROFIBUS tab

1 Bus address box

2 Watchdog for outputs check box
3 DP parameters button

1

Bus address box

Configure the bus address of the Com Unit if the master does not support automatic
PROFIBUS address configuration (address range 1 ... 125). The default Com Unit
PROFIBUS address is set to 126.

The configuration procedure varies, depending on the FDT base application. The topology
configuration is usually defined in the FDT base application.

2
Watchdog for outputs check box

Specify a time span in ms, after which the outputs initiate the preset substitute value
strategy if bus communication fails (max. 60000 ms = 1 min). The selected time must be
long enough for the master to address the slave promptly in the cycle.

Deactivate the check box to switch off the watchdog mechanism.

3
DP parameters button

Opens the DP parameters window (see screenshot).
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DP-Parameter N

Frofibus-DF 1D =1 ?1@ £
P-Mode

2 module status area

3 status/command

4 Suppress "Clear”

<1 71

Adv. diagnosiz parameters [>= P B.19)
uze additional module related diag.

diagnosiz module offzat

Advanced Bus Control

ok | Cancel

Figure 6.10: DP parameters window

Display of PROFIBUS ID number

Module status area check box
Status+command check box

Suppress "clear" check box

Add. module related diagnostics check box
Module offset for diagnhostics box

N o a s ON =

Additional bus monitoring check box

Caution!
PROFIBUS will restart if the parameters are changed

If you modify the Module status area, Status+command, Add. module related
diagnostics and Module offset for diagnostics parameters, this will trigger a PROFIBUS
restart! For this reason, these parameters must only be changed online in systems with
HCiR functionality.

Caution!
Suppress "clear" check box

If only digital outputs are available in the Remote 1/O station, you will only not be able to
deactivate all outputs. One output always remains active because Suppress "“clear" is
enabled and zero telegrams are suppressed or ignored. Set a minimum of one output
(virtual if necessary) in the telegram so that Clear is not suppressed.

200180 2009-08

2
Module status area check box

Enable this checkbox to include transmission of the module status area in the cyclic data
traffic. An error bit is transferred for each slot of the remote I/O station (1 bit per slot, 1 =
module OK, 0 = module faulty, 6-byte input).
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3
Status+command check box

Enable this check box to include transmission of the global status and command register in
the cyclic data traffic (the module related errors are listed). This function is important for
application redundancy (2-byte input/output).

4
Suppress "clear" check box

Following a restart or a redundancy switchover by the master, some systems issue a
"Clear" signal in the initialization phase of the connection (DataExchange with only 00...). If
Suppress "clear" is disabled, the slave deactivates all outputs. If you do not want the
system to deactivate all the slaves because a redundant remote I/O station has to
guarantee continuous operation in case a Com Unit/bus line fails, for example, enable
Suppress "clear".

5
Add. module related diagnostics check box

If you enable the Add. module related diagnostics box, 2 more bits are transferred per
I/0 module slot (I/O module OK, I/O module error, incorrect /0 module type, no I/O module
available). The data volume for the device-specific diagnostics, therefore, increases by 12
bytes (48 x 2 bits). The additional diagnostics are not transferred by default. This function is
designed for systems where diagnostics via DTM is not possible or where the diagnostic
options are limited.

Note!
Add. module related diagnostics box for Com Unit 8x05

For Com Unit 8x05, Add. module related diagnostics can only be edited if you have
activated the Additional 12 byte module related diagnostics function in the Firmware
dependent device functions window (only possible with Com Unit firmware version 6.19
or later). You open this window by pressing the Ext. functions button.
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6
Module offset for diagnostics box

The assignment of diagnostics to I/O modules in different master and diagnostic systems
may turn out differently due to the various counting methods. Adapt the counting method to
your system using Offset module diagnostics. The parameter can adopt the value "0" or
"1") the default value is "0." Changing the parameter is recommended if the diagnostic
visualization in the PCS indicates a shift in the diagnostics/module assignment.

If you enter the value "0," the diagnostics of the I/O module 1 is transferred as module
diagnostics 0. The value "1" transfers the diagnostics of I/O module 1 as module
diagnostics 1.

Note!
Module offset for diagnostics box for Com Unit 8x05

For Com Unit 8x05, Module offset for diagnostics can only be edited if you have
activated the Offset adjustable for module related PB diagnostics function in the
Firmware dependent device functions window (only possible with Com Unit firmware
version 6.19 or later). You open this window by pressing the Ext. functions button.

7
Additional bus monitoring check box

It is advisable to enable additional bus monitoring. This is only effective for the outputs in
combination with the watchdog time. Once the defined time has elapsed, the outputs are
set to values in accordance with the substitute values strategy.

Editing the "Extra" tab

Backplane] Power suppl_l,l] Hedundancy] Service bus] Profibus  Extra

Temperature clazs

* T4at55°C  TEat40°C

Figure 6.11: Extra tab

The Temperature class area is only visible on FB Com Units for Zone 1. On LB Com
Units, the Extra tab stays blank.

Select the temperature class for your FB remote I/O station. Based on this, the
configuration software calculates the maximum number of I/O modules for the particular
remote /O station.

This prevents the maximum permissible power consumption being exceeded. All 24 slots
can normally be used without restriction.
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Editing Redundancy Com Unit device data

The configuration window for the redundancy Com Unit is identical in structure to the
configuration window for the (primary) Com Unit. Most of the redundancy Com Unit
parameters are taken directly from the primary Com Unit, which is why the adjustment
options for the redundancy Com Unit are limited to a few parameters.

TAG No. box: Enter any name (max. 32 characters).

Service bus tab: The service bus address of the redundancy Com Unit is allocated
automatically on the basis of the service bus address of the primary Com Unit. The number
128 is added to the service bus address of the primary Com Unit. So overall, 2 x 119 = 238
nodes are provided on the service bus. The prerequisite is to have sufficient repeaters, as
the RS485 bus standard only allows 31 nodes per repeater.

PROFIBUS tab: The bus address of the Redundancy Com Unit can be assigned manually
when there is application redundancy. When there is media redundancy, the addresses of
the two Com Units are identical, as the master addresses them both with the same data
over separate bus lines.

Meaning of the DP configuration string

Process control systems that support the FDT concept use the P+F operator interface as a
component of a separate system by integrating the P+F DTM. Other process control
systems have either a separate driver for P+F Remote I/O (e.g. Siemens PDM) or they use
a text-based GSD file. In such cases, read the operating instructions provided by the
relevant manufacturer.

The following notes will help you to understand more about Profibus communication and
will be of particular use if you use the GSD file.

Note!

If you are operating a master that supports the FDT concept or has drivers/libraries, you do
not need to worry about the subsequent byte strings because the master adopts the details
automatically.

You can view the sequence of data words in the configuration string. The sequence
corresponds to the arrangement of the I/O modules on the backplane, whereby the input
and output bytes of the I/O modules are sorted into input and output blocks (view Figure
6.12 on page 71). The DP configuration string is therefore a direct representation of the I/O
module arrangement and configuration on the relevant backplane. Each 1/O module has a
DP configuration code (e.g. digital input 1x08 = "11"). The DP configuration string is
composed of individual DP configuration codes.

It is essential for successful Profibus communication that the DP configuration string in the
master and slave (= Remote /O station) are identical.

The table (view table "Data structure on the Profibus" on page 71) is a simplified version of
the same module arrangement shown in the illustration (view Figure 6.12 on page 71) and
represents the relationship between the data structure of the DP configuration string and
the input and output bytes of the /0O modules.
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| 1x02 || 2xxX | 5x01 || 4x02 | 6x01 || 3x02 |
—

\] v
—

— "
lo]1]2]34]5]6].... [o]1]2]3]4]5]6]....

O

Figure 6.12: Effect of the module arrangement on the data structure

1 Input bytes
2 Output bytes

Data structure on the Profibus

Module arrangement

Slot no. 1 2 3 4 5 6
I/0O module 1x02 2XXX 5x01 4x02 6x01 3x02
DP Config. string 10 30 50 60 20 50
Data 1 byte 1byte | 1word | 1word | 1byte | 1 word
ON ON ON OFF OFF ON

1 byte

OFF
Byte ON 1 1 2 2
Byte OFF 1 2 1
Input bytes
Byte no. 0 1 2 3 4 \ 5
I/O module (slot) 1;(10)2 2xxx (2) 5x01 (3) 3x02 (6)
Output bytes
Byte no. 0 1 | 2 3 4 5
I/O module (slot) 2xxx (2) 4x02 (4) 6x01 (5) | Empty | Empty

ITable 6.1: Data structure on the Profibus

Initially, all output data is transferred to the slave as specified in the Profibus standard
(DataExchangeRequest). Then all input data is transferred to the PCS as a response
(DataExchangeResponse). Refer to the following table for the individual hexadecimal

values that make up the DP configuration string. The table also contains the meaning and
the input and output bytes of each hexadecimal value.

For more detailed information on the data and bit structure within the input and output bytes
of individual 1/0 modules, refer to the chapter “Configuring /0O modules” (see chapter 8).

You can access the DP configuration string of your remote 1/O station in the configuration
software device data window. Select a Com Unit in the tree structure and select Displays >
PROFIBUS > DP configuration string. Once you have accessed the menu, the
Character strings display window opens.
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PROFIBUS COM UNIT
Configure Com Unit

Profibus-DF configuration sting
Bpte - 15 lonno oo c043 4000 1100 5300 3000 cO043
Byte 16- 310 l4000 11

Figure 6.13: Display of DP configuration string

Note!

[—10

Special feature of /0 modules 1x03 and 3x02

Depending on the configuration (function type), the length of frequency input 1x03 is 2, 4 or
6 bytes and the DP configuration code is 50, 51 or 52.

Depending on the configuration (number of HART auxiliary variables), the length of analog
input 3x02 (transmitter power supply, input isolator) is 2, 6, 10, 14 or 18 bytes and the DP
configuration code is 50, 52, 54, 56 or 58.

200180 2009-08
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DP configuration codes

DP Config.

DP Config. | code (*)

code (hex) | (decimal) | Length Meaning

00 0 Empty slot or Com Unit without data

10 16 1 byte ON Digital input (1x01, 1x02)

11 17 2 byte ON Digital input (1x08)

(1007, 1014, 1015 only with Com Unit
8x08)

15 21 6 byte ON Com Unit with module status (8x0x)

20 32 1 byte OFF Digital output (6x01)

30 48 1 byte ON Digital input/output (valve with

1 byte OFF feedback) (2xxx, 6x05, 6x1x)
31 49 2 byte ON Com Unit with global
2 byte OFF status/command register (8x0x) or
digital output with status (6x06,
6x08)

50 80 1 word ON Frequency, 12 bit counter (1x03),
analog input (3x01, 3x02, 3x03),
temperature input (5x01, 5x02, 5x06)

51 81 2 words ON 32 bit counter (1x03)

52 82 3 words ON Frequency + 32 bit counter (1x03),
analog input (3x02) with 1st HART
auxiliary variable

53 83 4 words ON Analog input (3x04, 3x05),
temperature input (5x04, 5x05)

54 84 5 words ON Analog input (3x02) with 1st + 2nd
HART auxiliary variables

56 86 7 words ON Analog input (3x02) with 1st — 3rd
HART auxiliary variables

58 88 9 words ON Analog input (3x02) with 1st - 4th
HART auxiliary variables

60 96 1 word OFF Analog output (4x01, 4x02)

Ccoo0o107 ([19217 8 byte ON Com Unit with global

2 byte OFF status/command register and
module status (8x0x)

C04340 |1926764 |1 word ON Analog output (4x04, 4x05)

4 words OFF

(*) In many older master systems, you have to use decimal numbers instead of the
hexadecimal numbers in order to parameterize the PLC (e.g. S5) using the ET200
operator interface.

[Table 6.2: DP configuration codes

In the DP configuration string, the first configuration code is always assigned to the Com

Unit (the bus connection). The redundancy Com Unit (if available) is incorporated implicitly

in the configuration code of the bus connection and is not listed separately.
The Com Unit may have one of four different DP codes depending on the configuration
(see table below).

The global status register occupies 2 input bytes. The 6 input bytes for the module status (1
bit per 1/0 module) follow the input bytes of the global status register. The module status bit

I PEPPERL+FUCHS

73



6.5

74

adopts the status 1 if the associated I/0O module is active and free of faults. Otherwise the
status 0 is adopted.

The DP configuration codes for the individual I/O modules only follow the Com Unit with the
global status/command register and the module status (view table "Sequence of the DP
configuration code in the DP configuration string" on page 74).

Sequence of the DP configuration code in the DP configuration string

DP Config.
Slot Device Description code
0 Com Unit Without data 00
(W'th one .Of the . With status/command 31
configurations on the right) register
With module status 15
With status/command Co o1 07
register and module status
1 I/0 module Type-dependent Type-
dependent
n I/0 module Type-dependent Type-
dependent
[Table 6.3: Sequence of the DP configuration code in the DP configuration string

Command register

The command register comprises two bytes. The first byte is the parameter byte, the
second the command byte. These bytes can be used to transfer commands from the
master to the remote 1/O station via the bus.

The command they contain is only executed if the command register has changed.
Therefore, a command is only executed once, namely, when the changed command
register has been transferred to the Com Unit for the first time.

The command register can be transferred together with the global status register as part of
the cyclic Com Unit data. The global status register occupies the first two bytes in the
response telegram (DataExchangeResponse from slave to master). The command register
occupies the first two bytes in the request telegram (DataExchangeRequest from master to
slave).

The following commands are supported by the current PROFIBUS Com Units 8x05 (6.25),
8x06 (6.25), 8x08 (8.x) and 8x09 (9.03).
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Parameter Command

(Byte 1) (Byte 2) Meaning

0x00 0x08 Clear all 32-bit counters.

Oxnn 0x08 Clear 32-bit counter of slot nn.

0x00 0xF8 Cold start

0x00 0xF9 Warm restart

0x00 O0xF5 Become passive (command to active Com Unit).

Since the two Com Units of a redundant system cannot
both be passive, the partner Com Unit becomes active
because of this command. The command is meaningless if
sent to the passive Com Unit.

0x00 OxF6 Become active (command to passive Com Unit).

Since the two Com Units of a redundant system cannot
both be active, the partner Com Unit becomes passive
because of this command. The command is meaningless if
sent to the active Com Unit.

0x00 OxF7 Redundancy switchover

This command generates a redundancy switchover,
whichever Com Unit it is sent to. Therefore, it is not
essential to know which Com Unit is currently
active/passive.

[Table 6.4: Command list of the command register

Adding I/0O modules — General information

Using single and multichannel 1/0 modules

1 and 2-channel I/O modules

Important process circuits that require high availability should be configured with 1 or 2-
channel, single-width 1/0 modules because the channels of these modules are galvanically
isolated from the bus and from one another. These I/O modules each occupy one slot and
can be combined with any multichannel I/O modules within a Remote I/O station.

Multichannel I/O modules

Multichannel I/O modules significantly reduce the costs for each channel. One I/O module
can process up to 8 digital or 4 analog inputs or outputs.

The channels are galvanically isolated from the bus but not from one another. Multichannel
I/0 modules are twice as wide and therefore occupy 2 slots.

Multichannel I/O modules reduce space requirements by 30%, or as much as 50% on
analog circuits.

Slot allocation

Multichannel I1/0 modules are twice as wide and occupy 2 slots. Remember, therefore, that
the subsequent I/O module should be inserted in the next slot but one. For example, the 8-
channel digital input 1x08 occupies slots 3 and 4, whereby slot 4 is empty.

After configuring a dual-width 1/0 module, always leave one slot free. Exception: Do not
configure an empty slot if the dual-width I/O module is located in the last slot in the Remote
I/O module or if you do not intend to insert any other I/O modules.
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Single and dual-channel I/O modules only occupy one slot.

The 8-channel digital input with the module identifier "11" is entered in the PROFIBUS
configuration string. The additional slot occupied by the dual-width module is automatically
treated as an empty slot (code "00" in the PROFIBUS configuration string).

The table below shows how 1 or 2-channel and multichannel I/O modules appear in the
PROFIBUS configuration string.

Example DP configuration string

Slot 1/0 module DP Config. code
1 Digital input, 2-channel 10

2 Digital output plus 2 inputs 30

3+4 Digital output, 8-channel 3100

5 Digital input, 2-channel 10

6+7 Digital input, 8-channel 11 00

8 Analog input 50

[Table 6.5: Example DP configuration string

Note!
Differing slot assignment on the LB 9121, 9022 and LB 9029 backplanes

Slots 1 and 2 on backplanes LB 9121, 9022 and 9029 are reserved for the redundant Com
Unit, regardless of whether a redundant Com Unit is actually present or not. Configure the
I/0 modules for these backplanes from slot 3.

Compatibility and maximum number of /0O modules

Single and multichannel LB or FB I/O modules can be mounted on all LB and FB
backplanes.

Multichannel I/O modules are supported by Com Units of firmware version V6.x or later.

Single-channel 1/0 modules provide a maximum of 144 digital inputs or 48 digital outputs
per station. Using multichannel /O modules increases the number of possible digital inputs
per station from 144 to 184. The number of possible digital outputs increases from 48 to
184.

Using multichannel I1/0 modules increases the number of analog input and output channels
from 48 to 80.

The maximum number of analog and digital inputs and outputs is only limited by the
number of slots on the backplanes (max. 46 slots on LB Remote I/O in Zone 2, max. 48
slots on FB Remote I/O in Zone 1).
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Adding or deleting I/O modules

Whenever you add an 1/0 module to the configuration, delete an 1/0O module from the
configuration, or replace the 1/0 module with another of a different type, the structure of the
PROFIBUS data telegram changes. This change causes the PROFIBUS to restart. If
possible, configure the slots on the remote 1/O station before commissioning to prevent
the PROFIBUS from restarting unnecessarily.

12 3 4567 8 9 10 11

12 3 4567 8 9 10 11

Figure 6.14: Adding an I/O module changes the structure of the Profibus data telegram

Note!
Process control systems with Hot Configuration in Run function (HCiR)

If your process control system supports HCiR, you should also read the following
subchapter containing information on HCIiR (see chapter 6.8).

Caution!
Function interruption on control systems without HCIiR function

The Com Unit can only be configured while the system is operating if the control system
supports HCIR. Otherwise there is a risk of function interruptions.

If the control system does not support HCiR, do not configure the Com Unit while the
system is operative. We recommend preconfiguring empty slots in the master and slave
with virtual I/O modules prior to commissioning.

200180 2009-08

Virtual /0 modules

We recommend pre-configuring any vacant slots on the backplane with I/O modules prior
to commissioning. Virtual I/O modules are included in the software configuration of the
master and the slave, but are deactivated. A slot is, therefore, reserved for these modules
in the PROFIBUS data telegram even though they are not yet inserted in the backplane.
This allows you to add a pre-configured I/O module to the remote I/O station at a later
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stage without triggering a PROFIBUS restart.

To pre-configure a virtual I/O module, first add the relevant I/O module to the configuration
software tree structure as described below. Then deactivate the I/0O module (see chapter
7.2.2). You can insert the pre-configured I/O module into the allocated slot on the
backplane at a later stage and reactivate it.

Adding I/0 modules

Remember that on redundant remote I/O stations, slots 1 and 2 are reserved for the
redundant Com Unit. Also be aware that dual-width /O modules require 2 slots.

1. Right-click the required Com Unit in the tree structure.

A context menu opens.

2. In the context menu, select File > Edit station.

The Station structure window opens with an overview of all the station slots.

_ I System Configuration

Selected module [

inslot [ ] TaG-Mo: |

Status: | ]

List of all modules:

ak. ‘ Cancel |

Slot: TAG-Mo.: Device Dezcription: Device:  Status:
1: Fs
2 =
3 LB-1002 Switch Amplifier, 3 Ch 1002 Mo Connection | =
4: LE-4105 Output lzolator, HART, Ex, 8. 4105 Mo Connection
B rezerved
E: LE-1108 Switch &rmplifier, Ex. 8 Ch 1108 Mo Connection
T reserved
&
S %
10 o,
T ln:dl]

Help I Mew I

: |

o

Figure 6.15: Station structure window

3. Double-click a vacant slot. The new I/O module is inserted in this slot.

The Standard module list window opens. All the available I/O modules are listed there,

divided into functions.
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P =

~IList - Standard Modules

Selected module:
|S|:|Ien|3i|:| Yalve Driver: 2105 Ex, Uo=22%, Ra =230 Ohm

Available module classes Device: Device Description:
Binary |nput 2002 Uo=24V, Ra =210 Ohm A
Solenoid Yalve Driver 2101 Ex. Uo=22%. Ba =315 Ohm a
Tranzmitter Power Supply 2102 Ex, Uo=24%, Ra =210 Ohm 1=
Cutput lzolator 2103 Ex Uo=24¥.Ra =360 Ohm '
Temp./olt. -Converter 2104 Ex Uo=22¢.Ra =220 Ohm
Digital Dutput 2105 Ex Uo=22. Ra =290 Ohm

2106 Ex Uo=17¥.Ra=115Ohm (i

k. Cancel Help

Figure 6.16: Standard module list window

4. First, on the left, select the basic type of /O module you would like to add. Then double-
click on the exact device description on the right.

This opens the device data window of this I/O module.

5. To add the I/0O module in the standard configuration, click OK. Alternatively, you can first
adapt the I/O module parameters and then click OK.

The software returns you to the Station structure window. The new I/O module
appears in the list there.

6. Assign I/0O modules to other slots, as required, by repeating steps 3 to 5.
If you do not want to assign any further /O modules, click OK.

The new 1/0 module now appears in the tree structure.
—-|-HORE= COM1
+ ;A 01, FE-g20%
-] 0z, Le-s10%
+ 03, LB-1001

+ 04, LB-3104
+ 06
i ;

M 08, FB-g20%

Figure 6.17: Tree structure with Com Units and I/O modules

Deleting I/0 modules

1. In the tree structure, right-click on the 1/0 module entry you would like to delete from the
configuration.

A context menu opens.

2. In the context menu, select File > Delete object(s).
A dialog box opens.

3. Confirm the delete operation by clicking Yes in the dialog box.
The 1/0 module is deleted from the configuration.

4. Repeat steps 1 to 3 to delete other I/O modules.
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Tip
An easier way to delete an 1/0 module is to select the required I/O module in the tree
structure and then press Delete key.

Assigning 1/0O modules to slots using the HCIR function

Note!

Ignore this section if your process control system does not support Hot Configuration in
Run (HCIR).

Activating/Deactivating HCiR
To activate/deactivate HCiR, select Options > Settings from the main window.

New configurations and settings made using HCiR only become effective when the master
restarts the PROFIBUS. If you would like parameter changes to take effect immediately,
do not activate HCIR.

Function of HCiR (principle: Remote I/O with two data records)

The configuration of the master and slave in Profibus systems must be the same at all
times otherwise data communication will not be possible. Communication cannot be
guaranteed if you modify the configuration of a Remote I/O station. Measures must
therefore be taken to ensure that the system can tolerate temporary differences between
the master and slave configuration without entering an error state.

P+F has developed a process that allows the slave to have two configurations
simultaneously, regardless of whether a redundant system is present. If HciR mode is
active, a new configuration can be transferred to the slave in the form of a passive data
record. The master may access the slave with the old configuration until he has
implemented the necessary changes in the master system. The Profibus restarts when the
new configuration is activated in the master. When the new configuration in the slave
matches the configuration in the master, the new configuration in the slave is activated
automatically and the old configuration is deleted. However, if the Profibus is started with a
different configuration (e.g. because of a line failure or problems loading the master), the
old configuration in the slave remains active.
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Warning!
The procedure depends on the process control system

The procedure may differ from the one that follows depending on which process control
system you are using.

Process control systems that support HCIiR (such as ABB Symphony), automatically
control the parameter download and PROFIBUS restart sequence. On process control
systems that do not support HCiR, make sure that all parameters are downloaded to the
Com Unit before the master is configured.

Editing PROFIBUS-relevant configuration data in process control systems without HCiR
support while the plant is operating requires maximum concentration. On process control
systems of this kind, we recommend preconfiguring empty slots in the master and slave
with virtual I/O modules during commissioning. Deactivate these I/O modules to ensure
that the data in the master and slave are consistent at all times. You can assign actual 1/0
modules to the slots and activate the /O modules in the master at a later stage. The
activation of these preconfigured /0 modules does not interrupt the exchange of
PROFIBUS data.

6.8.1

Adding 1/0O modules with HCIiR
Add I/0 modules using HCIR

Danger!
Working in Zone 1 or Zone 2

There is a risk of explosion or damage to the station.

Always read the LB/FB hardware manual before removing or inserting /0O modules into the
backplane.

200180 2009-08

1. Insert an I/O module in a free slot on the backplane and connect the wires correctly.

2. Now create a new configuration containing the new 1/0 module. To do this, start the
configuration software.

3. Open the project file containing the configuration of the required remote 1/O station.

4. Add the new I/O module to the tree structure. Proceed as described in the “Adding or
deleting I/0 modules” section (see chapter 6.7). The slot that you configure in the
software must correspond with the actual slot of the new I/O module on the backplane.

5. Now establish a connection to the remote I/O station, by selecting Connection >
Connect from the main window menu or by clicking Connect on the toolbar. Continue
as described in the "Connecting to a remote I/O station" section (see chapter 5.6).

A connection to the Com Unit is established.
6. Right-click the Com Unit entry in the tree structure.

A context menu opens.
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7. From the context menu, select Device > Save station in box.
The new configuration with the additional I/O module is written to the Com Unit as a
passive data record (parameter download). The remote I/O station remains stable and
continues to use the old configuration that does not yet include the new I/O module.

8. Then configure the new I/O module in the class 1 master.
The class 1 master restarts the PROFIBUS automatically.
During the PROFIBUS restart, the outputs of the remote I/O station retain their pre-
restart status.
After the restart, the remote 1/O station remains stable and uses the new configuration
containing the new 1/0O module. The old configuration is deleted.

Note!

You can use the procedure described above to add several new I/O modules
simultaneously.

Deleting or replacing I/O modules with HCIR

Delete or replace 1/0 modules via HCIR

1.
2.
3.

Start the configuration software.
Open the project file containing the configuration of the required remote 1/O station.

Clear the required I/O module. Proceed as described in the “Adding or deleting 1/0
modules” section (see chapter 6.7). If you would like to replace the deleted 1/0O module
with a new one, add a new I/O module to the tree structure. The slot that you configure
in the software must correspond with the actual slot of the replaced 1/0 module on the
backplane.

Now establish a connection to the remote I/O station by selecting Connection >
Connect from the main window menu or by clicking Connect on the toolbar. Continue
as described in the "Connecting to a remote I/O station" section (see chapter 5.6).

A connection to the Com Unit is established.

Right-click the Com Unit entry in the tree structure.

A context menu opens.

From the context menu, select Device > Save station in box.

The new configuration with the deleted/replaced I/0O module is written to the Com Unit
as a passive data record (parameter download). The remote I/O station remains stable
and continues to use the old configuration that still includes the current I/O module.

Now delete the I1/0 module in the class 1 master as well. If you would like to replace the
removed I/0O module with a new one, configure the new I/O module in the class 1
master.

The class 1 master restarts the PROFIBUS automatically.

During the PROFIBUS restart, the outputs of the remote I/O station retain their pre-
restart status.

After the restart, the remote 1/O station remains stable and uses the new configuration
that either no longer contains the old /O module or contains its replacement. The old
configuration is deleted.

Remove the relevant I/O module from the backplane or replace the current I/O module
with a new one.
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Note!

You can use the procedure described above to delete/replace several I/O modules
simultaneously.

Changing the operation mode of an I/O module

The data structure of some 1/0O modules may vary depending on the task. For example,
frequency input 1x03 can be used in "Counter" or "Frequency" mode. Although the
hardware remains unchanged, the data structure of the PROFIBUS telegram changes
depending on the operation mode, which is equivalent to replacing the 1/0 module with a
new one.

Changing the operation mode of an 1/0 module with HCiR

1. Leave the relevant I/O module unmodified in the backplane.

2. Change the operation mode in the device data window of the respective 1/O module
(see chapter "Configuring I1/O modules").

The rest of the procedure is identical to the procedure for replacing the 1/0 module with a

new one. Continue with step 4 from the previous section.

Digression: Commissioning

Introduction

At this point we would like to give a few important tips on using the bus interfaces. For more
detailed information on Profibus connections, please refer to the technical literature or
internet sources such as

¢ PROFIBUS DP quick start,

* PROFIBUS technical documentation (obtained from the PROFIBUS User Organization
in Karlsruhe),

* http://www.profibus.com (PROFIBUS User Organization in Karlsruhe).

GSD files are used as a quick means of interfacing Profibus slaves from different
manufacturers to the process control system or the PLC and are supplied for P+F Remote
I/O devices on a CD-ROM or can be downloaded from the internet (http://www.pepperl-
fuchs.com).

Bus protocols define the structure of the data packets, which can then be recognized by
bus users regardless of the transmission paths used. They define the manner in which data
is requested from other devices, how devices respond to requests, and how errors can be
detected and flagged. The master/slave principle is applied here.

The master is the only bus user that is allowed to request data from other devices (slaves)
and issue commands to them. Class 2 masters can share the use of a single bus with class
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1 masters. Token passing is used to control the bus usage times of the different master
modules.

Parallel access by class 1 and class 2 masters is required in systems in which the class 1
master does not support acyclic services (DPV1) or HART functionality. HART
communication via the Profibus can be established via the class 2 master.

Profibus GSD file

The Profibus identification numbers (PB ID) of the GSD files for the P+F Remote 1/0O
system are codes allocated by the Profibus User Organization (PNO). This number
uniquely identifies a P+F Remote I/O station in a network containing stations from different
manufacturers. The Profibus identification number varies from Com Unit to Com Unit and is
printed on the sticker on the front of the unit.

Switching on

Do not start to operate all the slaves simultaneously, but connect each slave to the master
in succession. For fault analysis, we recommend using a standard bus monitor that is
capable of passively monitoring bus telegrams.

Remote 1/O stations receive their addresses via the service bus (default address: 1).
The 1/0 modules are addressed automatically relative to the station address.
LEDs on the front of the Com Unit indicate active data communication:

* If ayellow LED does not flash on the Com Unit when a slave is accessed, there is an
interruption in the transmitting cable to the master (interface fault in the master or cable
fault).

¢ If communication cannot be established, the wrong station address may have been
selected. Alternatively, the terminator may not be connected, or connections may have
been made that are not permitted.

When installing the bus, make sure that the transmitting and receiving lines RTD-P and

RTD-N have not been swapped. Swapping these lines may block access to one slave but

allow access to all the others. If the lines are swapped when looping through to the

terminals on the slave, access to all other subsequent stations is blocked.

Make sure that the parameterization of the master and slave corresponds and that the
correct Profibus ID number is selected.

You can use the DP configuration string to check the configuration. You can access the DP
configuration string in the configuration software (section “Meaning of the DP configuration
string; see chapter 6.4).
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Configure the station either

e using your master configuration software and the GSD file,

e using appropriate master software that includes an FDT base application for the
integration of DTMs and Profibus class 2 services for configuring the Remote I/O station
or

e using PDM in Siemens systems.

In addition, note the following points to successfully commission the bus.

e A terminator must be present at the start and the end of the bus (available from P+F as
an accessory).

* The master read cycle and the Com Unit watchdog must be adapted to one another.
This is usually a standard function for the PCS or PLC.

¢ Remember that some process control systems can only process limited data records.
Older Siemens Teleperm systems, for example, are only able to process 32 bytes of
input and output data per slave as a result. However, the accuracy of analog circuits
requires the transfer of 2 bytes per channel, i.e. in this case only 16 analog inputs can
be used in one station.

Refer to the hardware manuals for the LB/FB Remote I/O system for more information on

Remote I/O hardware.

Replacing or adding Com Units

Read the LB/FB Remote I/O hardware manuals before replacing or adding Com Units.

Note!
Default Profibus address

The default Profibus address of the Com Unit is 126 and the service bus address is 1. The
Profibus address 126 is a preallocated address that is not available in Profibus systems for
operative slaves. When a new Com Unit is used, this preallocated address prevents
conflicts with the addresses of other slaves in the bus line.

Caution!
Conflicts when replacing redundant Com Units

Incorrect Profibus addresses can lead to conflicts.

In a redundant system, Com Units should only be replaced while the plant is operating if
the Com Units have line redundancy and the Profibus address in the Com Unit is preset to
126 (default setting). The Com Units begin to exchange setting information after
installation.
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Replacing Com Units (1:1 replacement)

1. Make sure that the firmware version of the new Com Unit is the same as the Com Unit
being replaced.

2. Make sure that the Profibus address of the new Com Unit is the same as the Com Unit
being replaced. Use a separate Remote 1/O configuration slot to perform checks and
configure the correct Profibus address in the Com Unit.

3. Replace the old Com Unit with the new one.

Adding redundant Com Units

Note!

The redundant Com Unit automatically adopts the parameters of the primary Com Unit via
an internal connection. Before installing the redundant Com Unit, establish the internal
connection on the FB Remote 1/0 between the two Com Units via the front cable
connection. With LB Remote I/O, the internal connection is established automatically via
the backplane.

1. Make sure that the Com Unit being added does not occupy a Profibus address that is
already used by another slave in the system. The default Profibus address setting 126 is
also suitable here because another slave cannot occupy this address.

2. Add the redundant Com Unit.
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7 Basic DTM software functions

This chapter includes the most important basic functions of the P+F DTM software.

7.1 Menu of the device data window

File Device Display Services Options Return  Specials

| g®DS|| | w[2|2|@]#] 2| MeduleDataWindew! | Application mode:  with HGR | Us

Figure 7.1: Header of the device data window

The most important menu functions of the device data window are explained below, if they
have not already been dealt with in previous sections.

200180 2009-08
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711 "File" menu

Commands in the File menu

Command

Use

New project

Creates a new, empty project file. The project that is currently
open is abandoned, unless it has been saved.

A project can contain several remote 1/O stations and Com
Units (all the remote 1/O stations connected to a bus line).

Save project

Saves the project that is currently open to the hard disk (file
extension *.prj).

Load project

Loads an existing project file from the hard disk. Before you
access this menu item, save all the changes you have made
to the project that is currently open. Otherwise these
changes will be irretrievably lost.

New station

Creates a new remote 1/O station within the project that is
currently open.

Save station

Saves the currently selected remote I/O station to the hard
disk (file extension *.lbu).

Load station

Loads an existing remote I/O station from the hard disk
(*.Ibu). This allows you to simply copy similar station
configurations. The currently selected remote 1/O station in
the project will be replaced and unless it has been saved, will
be irretrievably lost.

If a remote I/O station has been loaded from the field, the
station file can be reloaded at a later date, as the extensive
comments that can be entered for a slot are only saved in the
files and not on the Com Unit. The configuration is all that is
saved on the Com Unit.

You can also send your *.Ibu files to our engineers for error
analysis.

Edit station

Opens the Station structure window for the currently
selected Com Unit. There you can edit the slot assignment.

Configure Com Unit

Opens the configuration window for the currently selected
Com Unit.

Save module

Saves the configuration of the currently selected /0O module
to the hard disk. This allows you to simply copy similar
module configurations. Module files are given the file
extension *.mXY (X = first digit of the module name, Y = last
digit of the module name). For example, temperature input
5x04 has the file extension *.m54.

Load module

Loads an existing module configuration for the currently
selected 1/0 module from the hard disk. The file extension
must be appropriate to the 1/0O module. For example, if you
have selected a type 5x04 1/0 module, you can only load a
module file with the file extension *.m54. The configuration of
the currently selected I/O module will be overwritten.

Edit module Opens the configuration window for the currently selected I/O
module.
Add module Adds a new I/O module to the currently selected remote 1/0

station (= Com Unit).

Delete object(s)

Deletes the selected object from the project.

Load planning
parameters

Loads the planning parameters and notes from a *.Ibu file to
the selected remote 1/O station.

88
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"Device" menu

The commands in the Device menu are only available if there is a service bus connection

to a remote 1/O station.

Commands in the Device menu

Command

Use

Load station from the
field

Loads the configuration of the remote 1/O station to the
configuration software (upload). Before you access this
command, save all the changes you have made to the file
that is currently open. Otherwise these changes will be lost.
If you have only configured an "empty" Com Unit in the
software configuration (without I/O modules), you can use
this command to transfer the remote 1/O station configuration
to the software. Since the data structure is the same for
intrinsically safe and non-intrinsically safe I/O modules, when
loading, you are asked which version (intrinsically safe, non-
intrinsically safe or explosion-protected) should be displayed
in the configuration software.

If you have already mapped the remote I/O station in the
software configuration, you can also use this command to
transfer the remote I/O station configuration to the software.
If the number of /0O modules in the remote 1/O station does
not match the number of I/O modules in the software
configuration, a fault message is output. A fault message is
also output if the Com Unit firmware does not match the
configuration software.

If an 1/0O module is detected in the remote I/O station, but is
not configured in the software, a fault message will be
displayed during the loading process. This enables you to
automatically check during commissioning whether the
planned station configuration has been correctly installed. If
you do not accept the module that has been identified as
incorrect into the configuration software during loading, the
corresponding slot in the software will remain empty.

Save station in the field

Loads the software configuration to the remote 1/O station
(download). The Com Unit then restarts. Changes take effect
only after they have been loaded to the remote 1/O station.
The progress of the data transmission is displayed as a
percentage. After data transmission has finished, unused
slots are deleted to prevent data conflict. This procedure
must not be interrupted. If an error occurs during data
transmission, a fault message is output. In this case,
transmission must be repeated.

Load module from
station

Loads the configuration of an I/O module from the remote 1/0
station to the relevant I/O module in the configuration
software. This loads the complete 1/0 module configuration.
If this was a new 1/O module for the slot, the parameter
default settings are loaded.

If the 1/0 module in the remote /O station is not the same 1/O
module that has been configured for this slot in the software,
a fault message is displayed.

Save module to station

Loads the configuration of an I/O module from the software
to the remote I/O station. Changes only take effect after they
have been loaded to the 1/0 module.
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"Displays" menu

Commands in the Displays menu

Command

Use

Measured value +

Shows the current measured value and status of the

status selected 1/0 module (see chapter 7.3). A service bus
connection to the remote I/O station is required.
PROFIBUS Shows the DP configuration string for PROFIBUS Com

Units.
This command is not available (grayed out) on Modbus Com
Units.

"Services" menu

Commands in the Device menu

Command

Use

Set planning Used to create feedback documentation.

parameters

Modbus register With Modbus Com Units, 1/0 module addressing can be
assignment edited here (see chapter 6).

This command is not available for PROFIBUS Com Units.

Auto-allocation

For Modbus Com Units: compresses the data structure for
the measured values.
This command is not available for PROFIBUS Com Units.

Change PROFIBUS ID

Changes the PROFIBUS ID. This command is only available
for type LB/FB 8x03H Com Units.
This command is not available for 8x05 and 8x07 Com Units.

HCIR: Apply all changes

With this menu command, all parameter changes plus any
deleted or added I/0O modules for this station take effect. It
triggers a PROFIBUS restart.

This command is not available for Modbus Com Units.

Remove all
multichannel
components

Clears all multichannel I/O modules from the station view.
When all multichannel I/O modules are cleared, it is possible
to return to Com Units that can only support single-channel
I/O modules (firmware versions < V5).

Recalculate channel
data

Updates channel data.

Convert station to
station with ...

Converts the configuration of the remote 1/O station so that it
is compatible with specific Com Unit firmware versions. A
choice of two options is available:

* Binary multichannel (V5.xx): Only single-channel I/O
modules and multichannel binary I/O modules are
allowed (compatibility with Com Unit firmware version
V5.xx)

* Analog + binary multichannel (V6.xx): Single-channel
I/0 modules and multichannel binary and analog I/O
modules are allowed (compatibility with Com Unit
firmware version V6.xx or later)

Conversion is also required with ABB Symphony, for
example, when making a switch from Com Unit 8x03 and
FDT 0.9x to FDT 1.2. It is also necessary to replace the
hardware
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Command Use

Activate/deactivate all Activates/deactivates the line fault detection functions for all
line fault detection the 1/0 modules of a remote I/O station.

Switch all channels to Switches all the 1/0 modules of a remote I/O station to
NORMAL operating "Normal" operating mode (cancels the simulation).

mode

"Options" menu

Define the temperature class for FB remote I/O stations in Zone 1. The temperature class is
important for determining the permissible self-heating of the remote I/O station.

For most I/O modules, there is no restriction regarding the maximum number of modules
that can be used in a station. Depending on the power supply, temperature class T4 or T5
can be used with the required ambient temperature. Please refer to the EC type
examination certificate for more detailed information.

Commands in the Options menu

Command Use

Temperature class * T4 at 55 °C: Permissible self-heating to 55 °C
* T6 at 40 °C: Permissible self-heating to 40 °C

"Service" menu

The Service menu is used primarily by our service engineers for fault location. This manual
contains no further description of the menu.

The "Device data" window of the I/O modules

Each 1/0 module in the project tree structure has its own device data window. All the
parameters of an I/O module can be edited in this window. In the sections that follow, you
will learn how to access the I/0O module device data windows and the structure of the
windows (universal screen elements).

Chapter “Configuring I/0 modules” contains a detailed description of all the available 1/O
modules and their specific parameters (see chapter 8).
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Accessing the "Device data" window

There are many possible ways to access the Device data window of an I/O module. Two of
the options are described below.

If you are in the main configuration software window, you must first move to the device data

window. From the main menu, select Device data > Edit device data.

The header of the software then looks like this.

File Device Display Services Options Return Specials

@E| D]§1H] _] Eﬂ = 1 |~| | _‘EJ Module Data Window

Application mode:  with HCIR | Us

Figure 7.2: Header of the device data window

Edit station

1. In the tree structure, right-click on the Com Unit with the /O modules you would like to
configure.

A context menu opens.

- HOREZ COML [ Tag-ta,
- [ 01, LE 8107 T E———
w03 te-1gl FilE B Mew project
0 04, LE-4 Device » Save project
+ 0, LE-1108 Load project:
+ 05, LE-2105 B
- m 112, FE-520% Mew station
= 01, FB-2203 Qpen stat.lon.ﬁle.
u_’/z chit, Sa.vE sta.tlun in file Chrl+5
U1 choe, Edit station [%
b, Eﬂ Chil3, Edit Camm Unit

Figure 7.3: File > Edit station context menu

2. Select File > Edit station.

The Station structure window opens.

—_I System Configuration

Selected module | |
inslot [ ] TaG-Mo: | ]

Status: | ]

Lizt of all modules:

Slot: TAG-Mo.: Device Dezcription: Device:  Status:
1: |
2 =
3 LB-1002 Switch Amplifier, 3 Ch 1002 Mo Connection
4. LE-4105 Output [zolator, HART,Ex, 8. 4105 Mo Connection
B reserved
6. LE-1108 Switch Amplifier, Ex, 8 Ch 1108 Mo Connection
T rezerved
&
3 %
10 }
Tl b

g0 [Tl || |
. | |

Figure 7.4: Station structure window
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3. From the list, double-click on the I/O module that you would like to configure. If there is
no I/0O module in the required slot, you can first select an I/O module to insert after
double-clicking.

The Device data window of the particular IO module opens.
4. Edit the parameters of the /0O module and then click OK.
The software returns you to the Station structure window.

5. Now configure another I/O module (repeat steps 3 and 4) or close the Station
structure window by clicking OK.

§< Editing a single 1/0 module

1. In the tree structure, right-click on the 1/0 module you would like to configure and select
File > Edit module from the context menu
or
use the left mouse button to select the I/O module and then click Edit module on the
toolbar.

W 0, LE-4105

- R R 1R

Figure 7.5: Edit module icon

The Device data window of the particular I/O module opens.
2. Edit the parameters of the /0 module and then click OK.

3. Repeat steps 1 and 2 to configure additional I/O modules.
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72.2 "Device data" window — universal screen elements

Described below are the screen elements of the Device data window that are identical for
all I/0 modules.

Device Data

Modul - TAGNo.: [LB510 ) @ Help |@ Reset
Channel 1 |Eh@| Ehanne].S'I EhanneMI

TAG-Mo:
Analognput
operating mode: Secaling in Bits [0...65535) Line fault detection
Harmal e with statuz v v on
Eor mode; LFD delay: 10 cycles
curment value v begin of range: | 10000~

full szale: 5 -
Extended. @

Transmitter Settings
- methode of meas.: | intemal CIC i -senzon (K =
- range: from |0.00 “C lo 10000 *C

- enginesring units: * °C °F

Femark.s: @

Figure 7.6: Device data window — universal screen elements

Module/Type box

Module active check box

Slot box

Module TAG No. box

OK button

Cancel button

Help button

Load button

Save button

Reset button

Modbus register button (only for Modbus Com Units)
Channel X tabs

Area with module related parameters

© 00 N O O s WODN =

- ok
- O

— d -k
H WON

Note box
Explanations:

1

Module/Type box

Displays the name of the I1/0O module (cannot be edited)
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2
Module active check box
Enable or disable this check box to activate or deactivate the 1/O module.

¢ If you deactivate the I/O module, it is present in the data traffic as a data set, but does
not generate current measured values or diagnostic data.
This option is particularly useful for process control systems that do not allow online
extension. In cases such as these, any I/O module can be preconfigured, even if it has
not yet been plugged into the backplane (virtual I/O module). The 1/0O module can be
upgraded in the relevant slot on the backplane at a later date and re-activated via
Module active.

* If you activate the I/O module, it operates normally and generates current measured
values and diagnostics data.

3
Slot box

Indicates the slot number of the I/O module. The slot number cannot be edited. If you wish
to position the I/O module in another slot, delete the slot from the tree structure and insert
again in a new slot. The slots in the tree structure must correspond with the actual
arrangement on the backplane.

4

Module TAG No. box

Enter any name for the 1/0 module (maximum 32 characters).
5

OK button

Saves the current configuration and closes the window.

6

Cancel button

Closes the window without saving changes to the configuration. All changes made are lost.

7
Help button

Accesses the Help function.
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8
Load button

Loads the existing configurations from a file or directly from the remote 1/O station
(selection in a dialog box). A service bus connection is required to load a configuration from
the remote 1/O station.

9
Save button

Saves the current configuration in a default file, a device file or directly to the I/O module of
the remote 1/O station (selection in a dialog box, see the following screenshot). The Device
data box remains open.

* Default file: The configuration of the I/0 module is saved in a default file, which applies
to all I/O modules of the same type. This simplifies the configuration when there are
several, similarly populated slots. Now when you add another /O module of the same
type, it is given the basic configuration you have just saved in the default file.

Changes made to the default file only affect /O modules that are added to the
configuration later. /O modules already included in the configuration are not affected by
the changes.

* Device file: The configuration of the I/O module is saved in a device file with the
extension *.myx (e.g., *.m52 for temperature input 5x02). This device file can be loaded
for individual I/0O modules of the same type as required.

* Remote I/O station: The configuration of the 1/0 module is saved in the remote /O
station (service bus connection required).

Data Destination

Drats will be stored an file as

" default data

(+ device data

ar
-

ak. | Cancel

Figure 7.7: Dialog box for saving the device data of an /0O module
10
Reset button

Restores the basic settings of the /0 module. These are not the settings in the default file,
but are the factory defaults.
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PROFIBUS COM UNIT
Basic DTM software functions

11
Modbus register button

Displays the Modbus address setting (applies to Modbus Com Units only). This button is
not available on PROFIBUS Com Units.

12
Channel X tabs

With multichannel, analog I/0O modules, each channel is displayed on a separate tab. Click
on the relevant tab to display a specific channel.

13
Area with module related parameters

This area contains parameters that are specific to the relevant I/O module. A detailed
description of each I/0 module can be found in the chapter “Configuring I/O modules” (see
chapter 8).

14
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

200180 2009-08
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Accessing the measured value display

The measured value display shows the current measured value and status of an /O
module. A description of the measured value display can be found in the subsections
below.

Accessing the measured value display

Prerequisite: A remote I/O station with a Com Unit and at least one I/O module is open in
the project view. A service bus connection is established to a remote 1/O station.

1. In the tree structure, mark the required I/O module channel.

@ MMI-LB/FB Remote 1/0: LB-1
File Device Display Services Opk

@EI—[ Profibus k_&

—|-HGREES (CC—
= 01, LE-310%

+f| 03, LB-1002

04, LB-4105

06, LB-1108

08, LB-2105

09, LB-5105

choz,

Figure 7.8: Accessing the measured value display

][] [+

2. In the toolbar, click the Measured value/Status icon
or
if you are in the device data window, select Display > Measured value/Status from the
menu.

The measured value display opens.
Tip
If you would like to access the measured value display of a digital /O module, you only
need to mark the required I/O module in the tree structure (instead of a single channel).
Reason: The measured value display shows all the channels in one window for digital I/O

modules. With analog I/0 modules, on the other hand, each channel has its own measured
value display.
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7.3.1 Measured value display for digital I/O modules

The only different thing about the measured value display for digital I/O modules is the
number of displayed channels. For this reason, the measured value display is only
described in one example for all

¢ Digital inputs,
¢ Digital outputs,

¢ Relay outputs.

StatusLB-1108
Measured value of module: [Switch Amplifier, Ex, 8 Ch / Typ: 1108 w

in slat; ’3_@

TAGMao: [LB-1108 Q)

~ Module-Status

oK @

Channel  TAG In/Out LFD State
1 Kanal 1Y Ch1 | In O
2 Kanal 7Y Ch2 Cn O
'3 Kanal 1%v¥Ch3 [ In o
@ Kanal 1AV Chd 7N @

[Kanal 1267 Ch 5

|6 Kanal =YY ChE [ In @
[7  [Kanal 17YCh7 [In o
'8 Kanal 1XYY ChE | ln O

Dane | Help | O

Figure 7.9: Measured value display of digital input 1x08

Measured value from module box

At slot no. box

TAG No. box (TAG number of the I/O module)
Module status box

Channel box (channel number)

TAG box (TAG number of the channel)

In/Out box (input or output channel)

Line fault detection indicator

Switching state indicator (contact open or closed)
10 Data transmission activity on the service bus

© 00 N O 0o A~ WODN =
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In the example shown, line breakage detection has operated for channels 5 and 6
(indicator lights up red). There are no line faults for the remaining channels (indicator stays

gray).

The contacts of channels 1 and 8 are closed (indicator lights up yellow). The remaining
contacts are open (status indication stays gray).

The indicator on the bottom right of the window flashes yellow when data is being
transmitted on the service bus.

Note!
Line fault detection

Not all the I1/O modules have line fault detection. The relevant status indicators are not
present in these 1/0 modules.

Measured value display for analog I/O modules

There are only slight differences between the measured value displays of the analog I/O
modules. For this reason, the measured value display is described using one example for
all

* Frequency inputs,

* (HART) analog inputs,
* (HART) analog outputs,
e Temperature inputs,

e Voltage inputs.
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Signal / Status of LB-3105

Device data: [Transmitter Power Supply, Ex, HART, 4 Ch / Type (1

i glot; E@ channel: ﬂ@

Module TAG: LE-3105 (4)

Channel-TAG: (5)

todule Status
Ol
<

Q i Jline: fault
e 0 Jline break

range: fram @ to

| Done I Help |@C>

Figure 7.10: Measured value display of analog input 3x05

Measured value from module box

At slot no. box

Channel no. box

Module TAG box (TAG number of the 1/0 module)
Channel TAG box (TAG number of the channel)
Channel status box

Line fault detection indicator

Breakage indicator (contact open or closed)

© 00 N O g s WODN =

Start of range, end of range and measured value on a scale of 0% ... 100%
10 Display of measured value and physical unit
11 Data transmission activity on the service bus

No errors have occurred in the example shown. The Line fault detection and Breakage
indicators stay gray and the Channel status box displays the value "OK". When there is an
error, the relevant indicators light up red.

The indicator on the bottom right of the window flashes yellow when data is being
transmitted on the service bus.

200180 2009-08
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Note!
Line fault detection/breakage detection

Not all the I/O modules have line fault/breakage detection. The relevant status indicators
are not present in these 1/0 modules.

Measured value processing

This section explains the methods for processing measured values of analog 1/0O modules.
Detailed descriptions on each I/O module are included in the chapter "Configuring I/0
modules" (see chapter 8).

Scaling the measuring area

Normally, analog measured data is transferred in whole numbers without a prefix within a
range between 10,000 (0 %) and 50,000 (100 %). For process control systems that are not
capable of processing number ranges this large, you can adapt the number range for each
channel of an analog I/0O module separately.

Please note that scaling is based on live zero signals (0% = 4 mA, 100% = 20 mA).
Therefore, when using 10,000 (beginning of range) to 50,000 (end of range) scaling, 50% is
equal to the numerical value 30,000. If the value 0 is transferred by the bus, the output
assumes the value 0 mA. And so input signals of 0 mA are signaled to the PCS by the
numerical value 0.

The scaling could also be set to between 4000 and 20,000 so that correspondence with
the 4-20 mA signal range is maintained. This setting is also suitable for 0 to 20 mA signals
with an extended range.

Enter the required number range in the Scaling area of the device data window of the
particular /O module. Permitted here are whole numbers within the range 0 ... 65535.
Alternatively, you can select a few frequently used scaling values directly from the drop-
down lists.

Scaling in Bitz [0...65535]

with status [

beqin af range:lmﬂﬂﬂ -
full zcale: |5|:||:||:||:| =

Figure 7.11: Scaling area
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Note!

For example: A process control system operates better within a range between 0 and 4095
instead of 0 and 65535. Select the following settings in the PCS to adapt the scaling:
Beginning of range: 625

End of range: 3125

Scaling factor: 1,3107

Overranges and underranges of the 4 to 20 mA signal that extend beyond the measured
value can also be displayed.

Note!

Some process control systems prefer scaling the inputs and outputs directly in the process
control system instead of scaling in the remote I/O system.

HART communication

I/0O modules

e 3x02, 3x03, 3x05,
e 4x02, and 4x05

are suitable for communication with intelligent field devices using the HART protocol. HART
field devices can be addressed, activated, and operated via the PROFIBUS. P+F can
provide drivers for standard HART software on request.

Note!

Always use single-channel I/0O modules 3x02 for HART communication with active
(separately powered) field devices.
Note that the connection layout is different from that of the supply circuit.

Make sure that the output current during HART communication is between 4 and 20 mA.
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HART communication is based on the transmission of frequency packages according to
the Bell standard (1200 Hz = 1, 2200 Hz = 0). The frequency packages are modulated onto
the 4-20 mA signals in FSK mode (Frequency Shift Keying) by the I/O modules. Two types
of communication are possible.

e Communication using a certified, Ex-approved handheld connected to the I/O module
terminals. A 250 Q communications resistor is built into all analog I/0 modules.
Transmitters that do not use the standard HART protocol may need to be reset after
they have finished operating (see section below). This problem can be identified when
the measurement circuit freezes. The circuit can be reset by disconnecting the power
supply (pull out the I/O module briefly).

e Communication with the Com Unit via the Profibus using acyclic DPV1 services (as per
the PNO profile for HART on Profibus V 1.0) and with the 1/O modules without additional
equipment. For HART communication, use a suitable communications program to
access the functions of the HART field devices via the Profibus. Field device
manufacturers provide separate DTMs for their field devices so that all the functions of
the field devices are accessible via the Profibus using the HART protocol. In addition,
Profibus class 2 masters can also be used if the master PCS does not provide HART
functionality. These options are also available using a PCS with suitable HART drivers
(e.g. PDM).

Each field device requires a unique address to prevent address conflicts between the

measuring points. Standard commercial software packages can automatically import the

field device addresses using teach-in functions. The sequential connection of field devices
described below for initial commissioning then no longer applies.

Should the software you have available not have any teach-in functions of this type, only
connect one field device to begin with and establish the connection to this field device with
the HART software. Give the field device a so-called long address (e.g., addressing via the
TAG No.). Then commission the second field device and proceed in the same way. Follow
this with the third device, etc. Once all the field devices have been given a communication
address, they can each be addressed separately.

Note!
Note on Com Units with firmware version V6 - V9

Unlike firmware version V4 Com Units, Com Units with firmware version V6 - V9 are
equipped with HART cross talk protection, which makes sure that HART channels are only
signaled as faulty if the fault is pending for more than 500 ms. The channel data is frozen
until the HART signal faults are rectified. The channel becomes active again as soon as the
HART fault is rectified.

In addition, the Com Unit resets 1/0 modules that have experienced a HART
communication fault. A manual reset where the I/O module is disconnected and then
reconnected is therefore no longer required.
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Practical experiences

The following HART communication limitations were found during tests.

* HART communication with transmitters is possible in the operating range 4-20 mA.
Some transmitters go overrange (22 mA) or underrange (< 4 mA) when there is no input
signal (lead breakage). In this situation, HART communication with this transmitter is
often not possible. This is also the case for handhelds.

¢ HART incompatibilities: Some transmitter manufacturers supply devices that work with
a proprietary protocol. However, communication via the bus in combination with Remote
I/0 using HART standard commands is possible,. As soon as the device-specific
commands (not HART compliant) are issued, the error counter in the I/O module may
reach saturation (depending on the firmware and hardware of the I/0O module). This
applies both for bus communication and transmitters operated using intrinsically safe
handhelds from the manufacturer. In this case, the field device then needs to be reset by
briefly removing the I/O module and then plugging it back in (interrupting the power
supply).

* HART-like signals: Some moving-coil positioners without HART functionality may
generate HART-like signals in 20 mA loops. These signals can be produced by
vibrations at the installation location of the positioner which fall within the HART
frequency band. This causes the error counter on the I/O module 4x02 to overflow. The
I/0 module stops communicating with the Com Unit, which then issues an error
message to the PCS.

If you should encounter similar HART communication problems with the 1/0O module, a
reset will be necessary. You can avoid this problem from the outset by using an 1/0
module without HART functionality (4x01) or by deactivating the HART function on the
affected channel. This function is supported by Com Units running firmware version >
V6. Earlier firmware versions do not provide this function.

Operating mode and error mode

Different function modes for each channel of an I/O module can be selected in the DTM
configuration window. The operating modes "Normal" and "Simulation" and the error
modes "Current value", "Substitute value", and "Last valid value" are available. Read the
following subsections and the chapter "Configuring the /0O modules" to find out more (see
chapter 8).

Setting the operating mode

During commissioning or service work, you have the option of switching the channels of the
I/O modules from "Normal” to "Simulation" operating mode. The channel then adopts a
defined simulation value. You can preset both the operating mode and the simulation value
for each channel in the device data window for the relevant I/O module (see chapter 8).

operating mode;

MHormal j

MHarmal
Simulation

Figure 7.12: Setting the operating mode
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Tip
Saving the configuration

Before setting multiple channels to "Simulation" mode, we recommend saving a copy of the
current configuration to the hard disk so that you can easily reset all channels from
"Simulation" to normal mode at a later time.

The simulation function can be used while the fieldbus is operating and does not interrupt
data communication. Only the channel that is switched to "simulation” is processed with
simulation values rather than current field signals.

If "Simulation” is selected, the fieldbus values are simulated. Input data is transferred via
the fieldbus as preset data (simulation value). Output data (simulation value) still has to run
through the internal signal processing of the LB/FB Remote /O first so that you can
simulate sensor signals during commissioning without modifying the sensor to check that
data is communicated correctly to the process control system. Also, you can check the
function of valves, even if bus communication has not yet been established.

You can check the results of the simulation setting in the process value display. After
finishing commissioning or service work, reset the operating mode to "Normal".

Adjusting error mode settings

In the event of a fault, the I/O modules automatically switch over to error mode. The
affected channel then adopts an adjustable substitute value. You can define which value
the channel adopts in the device data window for the relevant I/O module (see chapter 8).

eror mode;

curent value - |

curent walue
substituted value
lazt walid walue

Figure 7.13: Adjusting error mode settings

Error mode for outputs

Substitute values for outputs are adopted when the watchdog time expires or the "invalid"
identifier is preset in the process value. The watchdog time is preset in the Com Unit and
monitors communication between the master and slave. If this time is set to zero
(watchdog deactivated), the substitute value function becomes ineffective if the bus fails.
If during the start-up phase (connecting the power supply) a corresponding fault condition
is detected (e.g. no bus communication), the outputs are transferred from the status
"Power off" to the corresponding substitute value as specified in the options for the
selected substitute value.
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The following substitute value options can be modified for error mode:

e Current value:
The current value is the value currently being transferred from the PCS, which is still
issued despite having an "Invalid" identifier.

e Substitute value:
The substitute value can be changed manually to any permissible value within the
operating range of the /0 module.

e Last valid value:
The last valid value before the fault occurred is retrieved from the memory of the Com
Unit. If an error bit is detected when the new value arrives, the Com Unit uses this value
to form the output value.

If communication between the I/O module and the Com Unit fails, the affected outputs are
deactivated after a watchdog time of approx. 500 ms.

Error mode for inputs

Inputs send substitute values to the PCS when a lead breakage, a short circuit, or a
general module-related error (I/O module defective) is pending.

The following substitute value options can be modified for error mode:

e Current value:
The current value is the faulty measured value that is transferred with an error bit when
a sensor error occurs (invalid data).

e Substitute value:
The substitute value can be modified manually. From version 7 of the DTM, the status of
the substitute value is set to "Invalid" permanently.

e Last valid value:
The last valid value before the fault occurred is retrieved from the memory of the Com
Unit and used to form the input value if an error bit is detected when the new value
arrives. From firmware version 6.17 and above, an "Invalid" identifier is also transferred
here to specify the status.
If communication between the I/O module and the Com Unit fails, the status of the affected
inputs is set to "Invalid data". An alarm bit is set in the corresponding slot from the module
status area.

Error mode - Responses
The diagram and table below use an example of a digital output to demonstrate the data
flow resulting from different situations and parameter settings.

* In normal mode, the data is transferred directly from the Com Unit to the output.

¢ If an inversion has been configured, the signals are inverted beforehand according to
their parameter setting.

» If simulation values are output instead of the current bus data, these simulation values
are processed in the same way as bus data and are inverted if necessary.

» If the error bit (invalid data) is set, the relevant substitute values, the last valid values, or
the current values are transferred to the outputs depending on the error mode.

All processes are applied to each individual channel. The table shows a selection of the
possible combinations that the diagram generates when the flow of data is traced.
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simulation

values N g m \
S

simulation inverter substituted error 500 ms after
value mode communication
fieldbus to Com unit
fault bit was interrupted
T fault bit
no bus simulation | |
communication | fault bit T
simulation
Figure 7.14: Data flow from Com Unit to a digital output
Function table (digital outputs)
Com Unit /0 module
Operating Error
State Data bit | Error bit | Com 1 Simul. mode Com 2 Inv. | mode Output
Operation 0 0 Yes - normal Yes 0 - 0
Operation 1 0 Yes - normal Yes 0 - 1
Operation 0 0 Yes - normal Yes 1 - 1
Operation 1 0 Yes - normal Yes 1 - 0
Operation 0 1 Yes - normal Yes 0 Curr. 0
Error bit value
Operation 1 1 Yes - normal Yes 0 Curr. 1
Error bit value
Operation 0 1 Yes - normal Yes 1 Curr. 1
Error bit value
Operation 1 1 Yes - normal Yes 1 Curr. 0
Error bit value
Bus Old - No - normal Yes - Curr. Old
fault value
Abbreviations: Com 1 = Communication with fieldbus; Simul. = Simulation; Com 2 = Communication with Com
Unit; Inv. = Signal negation; Curr. value = current value
[Table 7.1: Function table (digital outputs)

77 Global status register

The global status register comprises 2 input bytes located at the start of the DP
configuration string (see chapter 6.4). It contains information about the status of the Com
Unit, the I/O modules and the power supply of a remote I/O station.

The settings you make in the device data of the Com Unit determine whether or not the
global status register is transferred in cyclic data traffic (PROFIBUS tab > DP parameters
button, see chapter 6.2.6).
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§< Accessing the global status register

Prerequisite: A remote I/O station with a Com Unit and at least one I/O module is open in
the tree structure. A service bus connection is established to this remote I/O station.

Double right-click the required Com Unit.

The window with the global status register opens.

Comm Unit Status Display: -ACTIVE-

s

Figure 7.15: Global status register of the Com Unit

Note!

[0

In DPV1 systems, standard DP diagnostics are automatically made available. Device,
module and channel related (extended) diagnostics are also available (see screenshot). An
in-depth description is not possible at this point, as the diagnostics are evaluated by the
process control system and are then available as plain text based on the GSD file.

The following table explains the meaning of the individual bits of the global status register
(2 bytes).

200180 2009-08
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Structure of the global status register

Byte

Bit / State

Meaning

2

15

Com Unit is passive

Com Unit is active

14

Operating mode: No simulation.

Operating mode: A minimum of one 1/0O module is
simulated.

13

No error

Fault

12

General error

Module fault

11

10

The error code consists of bits 11t08,e.9g.01 1 1
produces an error code of 7 (hexadecimal) = power
supply fault. The meaning of all error codes is shown in
the table below.

One error

Multiple errors

No parameterization/processing

Parameterization/processing in progress

N| W &~ O

—_

Bits 5 to O:

* If a single error occurs (bit 7 = 0), the faulty slot can
be determined with reference to the bits, e.g. 00 0
1 0 0 indicates slot 4 (hexadecimal).

* If multiple errors occur (bit 7 = 1), the number of
errors can be determined.

 If only power supply faults occur (value bit 11 - 8 =
7, bit 7 = 0), one bit is assigned to each power
supply (power supply 1 =bit 0, ..., power supply 6 =
bit 5), whereby the status 1 represents one fault.
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Error code of the global status register

Error
code
(hex)

Clear text message

No error

Memory error PIC (RAM)

Memory error PIC (register)

Memory error PIC (flash)

PIC internal error

Command error PIC

Module fault

Power supply fault

Memory error CPU32 (RAM)

Memory error CPU32 (flash)

CPUS32 internal error (watchdog)

Redundancy error, arithmetic

Redundancy error, partner not present (no redundancy Com Unit)

Redundancy error, link

Redundancy error, parameter inconsistent

MmO O W > © o Nl o o] A W] M| =| O

Reserved

Note!

In the screenshot, the global status register contains the hexadecimal character string
"A604" (module error in slot 4). The table below shows how the character string is made up

Character string "604"

and how it is to be interpreted.
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Example of the global status register (character string "A604")

"A604" Bit / State Meaning

A 15 =1 The Com Unit is active.
14 = Operating mode: No simulation.
13 = Error.
12 =0 General error.

6 11 = Bits 11 - 8 with states 0 1 1 0 produce the hexadecimal
10 _ error code "6." The error with the highest priority is,
5 — therefore, a module error.
8 =0

0 7 =0 Single error (not a multiple error).
6 =0 No parameterization/processing at present
5 =0 As there is a single error (bit 7 = 0), the faulty slot can
4 _— be determined _with reference to these bits. In this

2 3 - example, the bit sequence 0 0 0 1 0 0 produces slot 4.
2 =1
1 =0
0 =0

Documentation

Once a station has been configured, the I/O modules appear in the tree structure in the
program window. You can see from the tree structure whether the I/O modules have been
arranged in the required sequence on the backplane. Your work is documented
immediately.

You also have the opportunity to create printable documentation. The documentation
contains detailed information about the station configuration. During installation, the
backplane can be populated with I/O modules with the help of the documentation. The

following information is included:

a wiring diagram with terminal assignments,

all the parameter settings of the Com Unit and the I/O modules,

the slot layout of the 1/0 modules.
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The menu options contained in the Options menu in the main window can be used to
document the station configuration:

The commands in the Options menu for documentation

Command Use

Printer setup Opens the dialog box for setting up the printer.

Print Prints the current station configuration

Documentation Opens a window with input options for documentation and then

displays a preview of the documentation.

Print TAG labels This command is no longer available.

Print station layout | This command is no longer available.

The remaining items on the Options menu have already been described.

A description of how to create and print the documentation is given below.

Creating documentation

1.

In the tree structure, mark the remote I/O station for which you would like to create doc-
umentation.

= HOR== COM1

- [ 01,1B-810%!
+ 03, LE-1001
+ 04, LE-4002

o 05, LB-3104

Figure 7.16: Selected remote I/O station in the tree structure

2.

In the main window, select Options > Documentation.

This opens the window Documentation of the station parameters (view Figure 7.17
on page 114).

Make entries in the drop-down lists and boxes as required. For a description, see
beneath the following screenshot (view Figure 7.17 on page 114).

Click Next.

This opens a window with the complete documentation preview (view Figure 7.18 on
page 116). You can use the appropriate buttons to zoom in/zoom out, scroll through the
preview or print it out.

5. To close the preview window, click Close.

So that you do not lose the entries you have made, save the project to a read/write tag.
You can recall the documentation at any time by selecting Options > Documentation
from the main window.
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Project Name: [ B-810% O] Done (11)  Cancel |
Cable: |LivY 40:05 (2)) =] Help |

Module List:

Slot: TAG-Mo.: Device:

1

2 @

3+ LB-1002 1002

5

& LE-1108 1108

Klemme: F.abel van: K.abelname: AderNr: Beschreibun

2 j Pl-43-1 Fieldl 16 Description

Pl-43-1 17 Descriptinn

@ Pl43-1 @ @ Descrip
| P43 Dezcriptir

B «| | PH3 Description

Madify: | Pl-43-1 | (o) [15 | Description

| Update Actual Fow @

Figure 7.17: Station parameter documentation window

Project name box
Cable drop-down list
Module list box
Connector box
Cable from box
Cable name box
Wire no. box
Description box
Modify boxes

10 Update actual row button
11 Done button

© 0O N O O A~ ODN =

Project name box

Enter the name of the remote 1/O station or of the project (max. 20 alphanumeric
characters).

2
Cable drop-down list

Select one of the 4 specified cable types from the list, or enter your own text.
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3

Module list box

Shows the I/0 modules of the remote I/O station with their associated slot number and

TAG No. The boxes below (numbers 4 to 8) relate to the particular entry marked in this list.

4

Connector box

Indicates the terminals of the selected 1/0O module.
5

Cable from box

Contains the description of the cable destination, if one has been entered (see Modify
boxes).

6

Cable name box

Contains the name of the cable, if one has been entered (see Modify boxes).

7

Wire No. box

Contains the wire number of the cable, if one has been entered (see Modify boxes).
8

Description box

Specify the destination of device terminal Mx:y, in plain text if necessary (see Modify
boxes).

9
Modify boxes

To add data to boxes 4 to 8 or to modify the existing data, mark a row in boxes 4 to 8. The
marked row corresponds to a specific terminal of an I/O module, in this screenshot,
terminal 2 of analog output LB 4002. Then enter the required data for the marked row in the
Modify boxes. To apply the changes, click in one of rows 4 to 8.
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10

Update actual row button

Fills the complete column with the current value from the active box. If, for example, in the
Description column of the Modify fields (9) you enter the word "Print" and then
immediately click on Update actual row, all the rows of the Description box (8) will be
assigned the value "Print".

11

Done button

Saves the entries you have made, closes the window and opens the documentation
preview.

HotPaon | ~ | TwePaon | Toww | - 0| pea |

Pl i

TRE

e IR OO dE

HHEHEHHE
I

Figure 7.18: documentation preview
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8 Configuring /0O modules

The sections below describe the features and configuration options for I/O modules
compatible with the Com Unit.

The sections are always similar in structure:

* Brief description of the relevant I/O module with block diagram,
¢ Information on resolution and measuring/cycle time,

¢ Information on data transfer, function table with bit assignment,
¢ Information on line fault detection and diagnostics functions,

* Description of adjustment options.

200180 2009-08
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LB/FB 1x01 digital input

T
FANRVAN

+O—*
T
+OJ>
oo

Ch.1
Ch.2

COM

Figure 8.1: Connection diagram 1x01

The digital input is the interface between process signals from digital sensors (mechanical
contacts, NAMUR initiators, optocouplers, etc.) and the process control system or PLC.

Versions

e LB 1001, not intrinsically safe
e LB 1101, intrinsically safe

e FB 1201, intrinsically safe

e FB 1301, Ex-e

Features
¢  Module width: 1 slot
¢ NAMUR in accordance with DIN 19234

e 2 channels

¢ Channels galvanically isolated from the bus and from one another

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The maximum input frequency of the signals is 50 Hz. Whether signals of this frequency
can actually be measured, however, depends on the cycle time of the data traffic on the

Profibus (e.g. only 1 Hz with 500ms sampling interval).

Short signals can be extended to suit the sampling cycles of the process control system
using a parameterizable OFF delay (see section "Editing device data" for this I/O module).
The signals are transmitted to the Com Unit every 6.5 ms irrespective of the sampling

interval of the process control system.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The DP configuration code of the digital input is 10.

Device function - bit assignment in the data telegram

Digital input 1x01

Byte Bit | Meaning

Input byte 1 0 Status channel 1
1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Status channel 2
3 Line fault detection channel 2 (0 = OK, 1 = error)
4 Empty
5 Empty
6 Empty
7 Empty

Output bytes Without output bytes

[Table 8.1: Device function - bit assignment in the data telegram

Line fault detection

Each channel has a function for line fault detection and can distinguish between a lead
breakage and a short circuit (NAMUR input only). Line fault detection can be switched on
and off via software.

If you are using mechanical contacts, either deactivate line fault detection or connect the
mechanical contact at the installation location using a NAMUR replacement resistor (see
illustration below). The NAMUR replacement resistor replicates a NAMUR initiator. Using
the NAMUR replacement resistor, the electronic circuit can distinguish between a closed
switch and a short circuit. The NAMUR replacement resistor is available from P+F as an
accessory.
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10K Mo oka

Figure 8.2: NAMUR equivalent resistance

8.14 Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote /O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

200180 2009-08
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Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

~ Device Data ’—I |
oK Load Reset
Module/Type: [(T001__| [Switch Amplifier, 2 Ch |
Aetive v 1 Cancel | Save |
Slot: |11
TaGMNo.:  |LB-1001 Help |

-~ Input

closed contact

TAG-Ma. Ch. = operating mode; ermaor mode: [LFD]
01
Input 1 (K0): I ~ (g O INorma LI Isubsti ed value:l v
Input2 (K1) | Gj @ Nomh_4 LI supd 5 value:l

lie: Fault detection

Extended...
E d..

Remarks:

Figure 8.3: Digital input 1x01: Device data window

Measuring point data area + buttons

TAG No. channel box

Closed contact = option

Operating mode drop-down list

Error mode drop-down list

Short circuit / breakage detection check box
Extended button

Note box

O N O O s WODN =

Explanations:
1

Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements” (see chapter 7.2.2).

2

TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
3

Closed contact = option

Choose between positive or negative logic for the digital signal.
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4
Operating mode drop-down list
Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

e "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

¢ "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

7
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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8
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

b3
“ON delay in ms IU _Ij
OFF delay in ms IU 3:
- Substitute Yalues

Data: .0  Statuss  [ata ik
(| & Data invalid

- Simulation Yalues
Dats: (+ 0 Statuss " DataOK
- & Datainvalid

(114 I Cancel

Figure 8.4: Digital channel window with additional channel settings

ON delay box
OFF delay box
Substitute value area

B WO DN =

Simulation value area
Explanations:

1

ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

200180 2009-08
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2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).

N .

i
© ®

Figure 8.5: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-
tivated in the bottom half (short signals are filtered out).

2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and
activated in the bottom half (short signals are extended).

3
Substitute value area
Define a substitute value for when there is a fault.

e Data: Select a substitute value of either 0 or 1.

e Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

¢ Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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8.2 LB/FB 1x02 digital input
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Figure 8.6: Connection diagram 1x02

The digital input is the interface between process signals from digital sensors (mechanical
contacts, NAMUR initiators, optocouplers, etc.) and the process control system or PLC.

Versions

e LB 1002, not intrinsically safe
e LB 1102, intrinsically safe

e FB 1202, intrinsically safe

e FB 1302, Ex-e

Features

* Module width: 1 slot

* NAMUR in accordance with DIN 19234

* 3channels

* Channels galvanically isolated from the bus, with shared negative conductor

Refer to the corresponding data sheet and operating instructions for further information.

8.2.1 Measuring time and cycle time

The maximum input frequency of the signals is 50 Hz. Whether signals of this frequency
can actually be measured, however, depends on the cycle time of the data traffic on the
Profibus (e.g. only 1 Hz with 500ms sampling interval).

Short signals can be extended to suit the sampling cycles of the process control system
using a parameterizable OFF delay (see section "Editing device data" for this I/O module).
The signals are transmitted to the Com Unit every 6.5 ms irrespective of the sampling
interval of the process control system.

200180 2009-08
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The DP configuration code of the digital input is 10.

Device function - bit assignment in the data telegram

Digital input 1x02
Byte Bit | Meaning
Input byte 1 0 Status channel 1
1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Status channel 2
3 Line fault detection channel 2 (0 = OK, 1 = error)
4 Status channel 3
5 Line fault detection channel 3 (0 = OK, 1 = error)
6 Empty
7 Empty
Output bytes Without output bytes
[Table 8.2: Device function - bit assignment in the data telegram

Line fault detection

Each channel has a function for line fault detection and can distinguish between a lead
breakage and a short circuit (NAMUR input only). Line fault detection can be switched on
and off via software.

If you are using mechanical contacts, either deactivate line fault detection or connect the
mechanical contact at the installation location using a NAMUR replacement resistor (see
illustration below). The NAMUR replacement resistor replicates a NAMUR initiator. Using
the NAMUR replacement resistor, the electronic circuit can distinguish between a closed
switch and a short circuit. The NAMUR replacement resistor is available from P+F as an
accessory.
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Figure 8.7: NAMUR equivalent resistance

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive

diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in

the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels

(specifying the slot, channel, input/output ID, reason for fault).

Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

__| Module Data: Switch Amplifier LB-1002

TaGMNo: |LB-1002

Help

Input —

clozed contact line Fault detection

Device Data
_ _ ok | Load ‘ Reset ‘
Module/Type: [1002 Switch Amplifier, 3 Ch ]
Active v @ Cancel ‘ Save ‘
Slat: 3

T4G-No. Ch. i operating mode: error mode; [LFD]
o 1
Input 1 (KO): ] o Mormal LJ ]substituted valueLJ v Extended...
Input 2 [K1]: ] w W LJ ,@ valueLJ @ d...
Input 3 [K.2): ] - 1N0rmal L] ]substituted valuej v Estended...
Remarks:

Figure 8.8: Digital input 1x02: Device data window

Measuring point data area + buttons

TAG No. channel box

Closed contact = option

Operating mode drop-down list

Error mode drop-down list

Short circuit / breakage detection check box
Extended button

Note box

O N O g B» WODN =
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section ""Device data’ window — universal screen elements" (see chapter 7.2.2).

2

TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).

3

Closed contact = option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the /0O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

e "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

¢ "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.
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6
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

7
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

8
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

=
O
O

Digital channel

OM delay in ms

M

OFF delay in ms

- Substitute Yalues
Data: &+ Status: [

1
Sirnulation Yalues
Data: (+ 0 Statust  Data 0K
I A ' Datainvalid

Ok Cancel

Figure 8.9: Digital channel window with additional channel settings

ON delay box
OFF delay box
Substitute value area

B W N =

Simulation value area
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Explanations:
1
ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).

M I
I T

Figure 8.10: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

¢ Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.
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4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

» Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

8.2.6 Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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LB/FB 1x03 frequency input
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Figure 8.11: Connection diagram 1x03

The digital input is the interface between process signals from digital sensors (mechanical
contacts, NAMUR initiators, optocouplers, etc.) and the process control system or PLC.

Versions

e LB 1003, not intrinsically safe
e LB 1103, intrinsically safe

e FB 1203, intrinsically safe

e FB 1303, Exe

Features

¢  Module width: 1 slot

¢ NAMUR in accordance with DIN 19234

¢ 1 channel, galvanically isolated from the bus

* Channel 1 for frequency measurement or pulse counting

» Additional rotation direction input for rotation direction detection (e.g. for rotating
machine) or counting direction detection (forwards or backwards); no separate

channel

Note!

Bandwidth limitation

The bandwidth of 15 kHz is not suitable for bouncing contacts. In this case, select a model

with a bandwidth of 400 Hz (see catalog).

Refer to the corresponding data sheet and operating instructions for further information.
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Measuring time and cycle time

The conversion time is approx. 50 ms. The immediacy of the measured value depends on
the cycle time of the data traffic in the Profibus. The signals are transmitted to the Com Unit
every 6.5 ms irrespective of the measuring time.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The I/O module LB/FB 1x03 has three types of function. The different function types create
different data structures in the Profibus data telegram. The frequency input actually
represents three devices. All require different drivers to operate in the process control
system and all have different DP codes in the GSD file.

If you wish to change the function type of the I/O module, remember that changing the
function type means that you will have to change the 1/0 module. Changing the function
type during operation is therefore only possible with HCiR. The following function
types are available:

¢ Frequency input up to 15 kHz (with or without direction detection) or 12-bit counter up to
15 kHz (with or without direction detection)
DP configuration code: 50

e 32-bit counter (with or without direction detection)
DP configuration code: 51

¢ Combined 32-bit counter and frequency input up to 50 kHz (with or without direction
detection)
DP configuration code: 52
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Device function - bit assignment in the data telegram

Frequency input 1x03
Combined with 32
Frequency input or | bit counter and
12 bit counter up to | frequency input up | 32 bit counter up to
15 kHz to 50 Hz 15 kHz
Byte Bit | Meaning Meaning Meaning
Input byte 1 0 Status channel 1 High word of
1 Line fault detection channel 1 (0 = OK, countedb};alue (16
1 = error) it)
2 Empty
Empty or direction detection (0 =
forwards, 1 = backwards)
4 Frequency (12 bit) | Frequency (12 bit)
counted value (12
6 bit)
7
Input byte 2 0-7
Input byte 3 0-7 - High word of Low word of
: : counted value counted value
Inputbyte 4| 0-7 (16 bit) (16 bit)
Input byte 5 0-7 - Low word of -
. . counted value .
Input byte 6 0-7 (16 bit)
Output bytes Without output Without output Without output
bytes bytes bytes
[Table 8.3: Device function - bit assignment in the data telegram

Line fault detection

Each channel has a function for line fault detection and can distinguish between a lead
breakage and a short circuit (NAMUR input only). Line fault detection can be switched on
and off via software.

If you are using mechanical contacts, either deactivate line fault detection or connect the
mechanical contact at the installation location using a NAMUR replacement resistor (see
illustration below). The NAMUR replacement resistor replicates a NAMUR initiator. Using
the NAMUR replacement resistor, the electronic circuit can distinguish between a closed
switch and a short circuit. The NAMUR replacement resistor is available from P+F as an
accessory.

If you are using rotation direction detection, connect the rotation direction input to a
NAMUR shunt resistor. The rotation direction input is ignored for devices without rotation
direction detection.
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Figure 8.12: NAMUR equivalent resistance

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

Rotation direction detection

The second digital input (rotation direction input) is used to detect the direction of rotation

from the phase shift between the two incoming pulses (view Figure 8.13 on page 135).

If the direction detection has not been specified in the parameter settings, then the pulse
count is incremented. If the direction detection has been specified in the parameter
settings, the 1/0 module processes the field signals as follows:

¢ The counter adds the incoming pulses if the rotation direction input is logic 0.
* The counter decrements the incoming pulses if the rotation direction input is logic 1.

The master detects the counting direction of the 32-bit counter by comparing the count
values of successive cycles. For the 12-bit counter, a direction bit is transmitted.

sensor 1

|
ch1 T
sensor 2 : :
I incrementing |
direction 0: counter !

\/

\/

\/

| |
ch1
| |
| |
T 1 decrementing
direction : counter :

Figure 8.13: Rotation direction detection

\
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10

Function types

Frequency input up to 15 kHz

Frequencies up to 15 kHz can be measured using this function type. The result of the
frequency measurement is transferred to the Com Unit as an integer with a degree of
accuracy of 0.1 %. New measured results are available in the Com Unit every 100 ms to
1000 ms (1 Hz) (every 10 seconds at 0.1Hz) depending on the frequency. The frequency
measurement operates with the internal 16 MHz quartz to measure the time between 2
pulses. The shortest pulse is 20 ps.

Counter

The module operates in the same way as a 12 bit counter and records counter values up to
4095 (corresponds to 12 out of 16 bits), whereby the first 4 bits contain status information.
In the same way as a 32 bit counter, the /0 module uses a 4 bit counter in the Com Unit

that records counter values up to 4294967295 (2%2).

A counter quotient can be applied to the counters to prevent them from reaching the
maximum counter reading (overflow) before the next bus query when the counting
frequencies are high. When a counter and frequency input are combined, the counter
quotient is not available.

Combination of counter and frequency input

When a counter and frequency input are combined, the minimum pulse time/pulse pause is
10 ms. The maximum detectable frequency is then 50 Hz.

Frequency input up to 400 Hz

A version of the /0O module is available with a maximum frequency of 400 Hz for sensors
with bouncing contacts (special order number, see catalog). Even if all functions of the 15
kHz version can be selected in the configuration software, a software package enables the
suppression of pulses with a duration of < 1 ms. In spite of this, the 400 Hz version is
treated in the same way as the 15 kHz version.

If the start of range setting is > 0 Hz, check whether the formula

End of range / (1 - start of range / end of range)

produces a result less than 400. The interrupt control prevents higher values from being
processed.

Note!
32 bit counter values

32 bit counter values are stored in the Com Unit and are deleted when the Com Unit is
removed, the power supply is disconnected (power failure), and during switching between
redundant systems. Switching between redundant systems only applies to Com Units
which support redundancy (for example, LB 8108 does not support redundancy).
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12 bit counter values are always accurate because they are stored in the actual I/O module.
The PCS must add up the difference between two successive queries in order to calculate
the 12 bit counter total. When adding up the values after a counter overflow, make sure that
the current counter value is less than the previous one. Values are usually counted at
relatively low frequencies. The master is therefore in a position to retrieve counter values
so regularly that a maximum of 1 counter overflow between queries can be expected.

Note!

10

The bus cycle time is 500 ms and the value counted by the 12 bit counter is a maximum of
4095 resulting in a maximum frequency of 4095/0.5 sec = 8190 Hz. If the bus cycle time
does not match the counting frequency, the 32 bit counter can be used subject to limitations
relating to redundancy switchover and disconnection from the power supply.

200180 2009-08
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8.3.7 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

Device Data

Ok, I Load
Module/TypeA003 | [Cnt/Freq Converter.1 Ch ] I
Module active  Iv /h Cancel | Save I
Slat: IT
Modul- TAGNo.: [LB-1003 Help | Fesst |
'E'hannel‘l |
TaG-No:| 2
— Analog-lnput U
operating made: Scaling in Bits [0...65535) Lire fault detection
Mormal with statuz v @ v on
errar mode:

current value o‘ begin of rangs: | 1000 LFD delay: |'ID cycles
Extended [freq) .. e il 0000

E stended [counter] ..

I Trans_mitfer Settings

-‘l'h‘t‘emal op.-mnods; @
- beE‘u] of range: |D.DDD HZ@|| scaler 100000 Hz

Hemalk}.] *

Tranzmitter Setting
z= - intermal op.-mode: |32-B it counter 10) =
N ()

Figure 8.14: Frequency input 1x03: Device data window

Measuring point data area + buttons

TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists (scaling)
Line fault detection check box

LFD-delay box

Operating mode drop-down list

Start of range/End of range boxes (physical unit)
Counter quotient box (not always visible)

Note box
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- ok
- O
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Note!
Hidden areas

The Scaling (0...65535) area is only visible when you use the /0 module as a frequency
input.

The Counter quotient box only appears when you use the I/O module as a counter.
Explanations:

1

Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section ""Device data’ window — universal screen elements" (see chapter 7.2.2).

2

TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

¢ "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.
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5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8
Line fault detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

9
LFD-delay box

This field only appears if you have activated Line fault detection.

Specify the number of measuring cycles during which a measured value must be free of
errors before the value is signaled as good. This option can be used for suppressing loose
contacts.
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10
Operating mode drop-down list

Select the function type for the I/O module. Online modification of the function type is
restricted because the different function types have different DP configuration codes. If
online modification is not possible, the DTM displays an error.

The following function types are available. Here, the rotation direction detection input can
be used either to count up or down or as a status indicator for the direction of rotation.

¢ Frequency input: Select between "Frequency" and "Frequency and rot. direction".

¢ Counter: Select between "32 bit counter”, "32 bit counter and rot. direction”, "12 bit
counter" and "12 bit counter with rot. direction". The Counter quotient box only
appears if you have selected one of these counters as a measuring method.

* Frequency input combined with counter: The maximum input frequency in this mode is
50 Hz. Select between "Frequency + 32 bit counter" and "Frequency + 32 bit counter
and rot. direction". Frequency measurement is the primary measuring method.

11

Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.
12

Counter quotient box

This box only appears if you use the I/O module as a counter ("Counter" setting, see
paragraph above).
Enter a value x to determine how frequently the pulse is counted.

13
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Note!

The structure of the Extended parameters window that you access via the Extended
button differs depending on which 1/O module function type is selected. In the 12-bit and
32-bit counter function types, some of the areas cannot be edited (grayed out).
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min. value in Bits
max, value in Bits

~ Substitute Valu

Analog Fiter in %/sec IU
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Counter value:

¥ with Status

Ig ™ switch state
¥ Dataimvaid [ Direstion
' Simulation Y alue:
Counter value: v with Statug

IU— I switch state

¥ Datairvalid [ Direction

ak. I Cancel

Figure 8.15: Extended parameters window (12-bit counter) with additional channel settings
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Figure 8.16: Extended parameters window (32-bit counter) with additional channel settings
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Figure 8.17: Extended parameters window (frequency input) with additional channel settings

Analog filter box

Min./max. transmitted value boxes
Analog value as % box (substitute value)
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Explanations:
1
Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.

If you are using the I/O module as a counter, enter an absolute counter value rather than a
% analog value.

4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available that you can use to
(de)activate the following status information, depending on the function type of the 1/0
module.

Stat. input: Transfers the status of the input channel with the substitute value.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

Direction: Transfers the direction information with the substitute value.

I PEPPERL+FUCHS
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5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

If you are using the I/O module as a counter, enter an absolute counter value rather than a
% analog value.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information, depending on the function type of the 1/0
module.

Stat. input: Transfers the status of the input channel with the simulation value.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Direction: Transfers the direction information with the simulation value.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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LB/FB 1x08 digital input
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Figure 8.18: Connection diagram 1x08

The digital input is the interface between process signals from digital sensors (mechanical
contacts, NAMUR initiators, optocouplers, etc.) and the process control system or PLC.

Versions

e LB 1008, not intrinsically safe
e LB 1108, intrinsically safe

e FB 1208, intrinsically safe

e FB 1308, Ex-e

Features

* Module width: 2 slots

* NAMUR as per DIN 19234 or24 V DC or 5V DC

* 8 channels

* Channels galvanically isolated from the bus, shared negative conductor

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The maximum input frequency of the signals is 50 Hz. Whether signals of this frequency
can actually be measured, however, depends on the cycle time of the data traffic on the
Profibus (e.g. only 1 Hz with 500ms sampling interval).

Short signals can be extended to suit the sampling cycles of the process control system
using a parameterizable OFF delay (see section "Editing device data" for this I/O module).
The signals are transmitted to the Com Unit every 6.5 ms irrespective of the sampling
interval of the process control system.
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10

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD

file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

Note!

Dual-width 1/0 module

Dual-width I/O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/0 module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).

The DP configuration code of the digital input is 11.

Device function - bit assignment in the data telegram

Digital input 1x08

Byte Bit | Meaning

Input byte 1 0 Status channel 5
1 Line fault detection channel 5 (0 = OK, 1 = error)
2 Status channel 6
3 Line fault detection channel 6 (0 = OK, 1 = error)
4 Status channel 7
5 Line fault detection channel 7 (0 = OK, 1 = error)
6 Status channel 8
7 Line fault detection channel 8 (0 = OK, 1 = error)

Input byte 2 0 Status channel 1
1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Status channel 2
3 Line fault detection channel 2 (0 = OK, 1 = error)
4 Status channel 3
5 Line fault detection channel 3 (0 = OK, 1 = error)
6 Status channel 4
7 Line fault detection channel 4 (0 = OK, 1 = error)

Output bytes

Without output bytes

[Table 8.4: Device function - bit assignment in the data telegram
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Line fault detection

Each channel has a function for line fault detection and can distinguish between a lead
breakage and a short circuit (NAMUR input only). Line fault detection can be switched on
and off via software.

If you are using mechanical contacts, either deactivate line fault detection or connect the
mechanical contact at the installation location using a NAMUR replacement resistor (see
illustration below). The NAMUR replacement resistor replicates a NAMUR initiator. Using
the NAMUR replacement resistor, the electronic circuit can distinguish between a closed
switch and a short circuit. The NAMUR replacement resistor is available from P+F as an
accessory.

24V and 5 V inputs can only be used with line fault detection disabled.

10 KQ 29 KO

Figure 8.19: NAMUR equivalent resistance

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/0O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).
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8.4.5 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

— Device Data
L _ - | ok I Load | Feset

Module/Type: 1102 Switch Amplfier, Ex, 8 Ch
botive W @ Cancel | Save |
Slat: IB_
TAGMo: |LB-1108 Help

 Input

contact closed:conlacl line fault detection
TAGMa. Ch, mode: e - operating mode: ernar mode: [LFD]

Input 1 (K0): I Initiator LI 0 | Momal ;I substituted valuell v Extended...
Input 2 (K13 | Initator »| € & [Nomal | |substited vale ¥| W Extended...
Input 3(K2E | IInit\amr _I i INnrmaI LI Isuhstituted valueLI ird Extended..:l
Input 4 (K3 | INnrm ;I Isuhsht IueLI
Input 5 [K4): I_@— r@:’ @ W@_j ’m@@ @ Ex .
Input B [K&]: IImhamr _I . O INnrmaI LI Isuhshtuted valueLI v Estended...
Input 7 (KE): IImt\ator _I o INormaI ;I Isubstltuted valueLI ird Estended |
Input 8 [K7]: I IImt\ator _I g INormaI ;I |substituted value;l v E xtended |

Remarks: | @

Figure 8.20: Digital input 1x08: Device data window

Measuring point data area + buttons

TAG No. channel box

Contact type drop-down list

Closed contact = option

Operating mode drop-down list

Error mode drop-down list

Short circuit / breakage detection check box
Extended button

Note box

© 0O N O O~ WODN =

Explanations:

Measuring point data area + buttons

This area is identical for all /O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements” (see chapter 7.2.2).

2
TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
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3
Contact type drop-down list

Select the input type, e.g. counter, current, resistance, NAMUR, 24 V, etc. (depending on
the 1/0O module).

4

Closed contact = option

Choose between positive or negative logic for the digital signal.

5

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted from the field.

* "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
6
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value™:

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

7
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.
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8

Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

9
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

23
OM delay in ms |IJ _Ij
OFF delay in ms ID - l

-~ Substitute Values
Data: ' 0 Status: ¢ Dm0k

.l & [ata invalid

- Simulation Y aluss
Data: + 0 Statuss " Datak
I Al @ Datainvalid

0K I Cancel |

Figure 8.21: Digital channel window with additional channel settings

ON delay box

OFF delay box
Substitute value area
Simulation value area

B WO DN =

Explanations:
1
ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).
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2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).

N .

i
© ®

Figure 8.22: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-
tivated in the bottom half (short signals are filtered out).

2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and
activated in the bottom half (short signals are extended).

3
Substitute value area
Define a substitute value for when there is a fault.

e Data: Select a substitute value of either 0 or 1.

e Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

¢ Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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8.5 LB/FB 2xxx digital output
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o
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Figure 8.23: Connection diagram 2xxx without output disable input
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Figure 8.24: Connection diagrams 2xxx with output disable input

The digital output is the interface between the process control system or the PLC and
solenoid valves, acoustic sensors or lamps (LED).

Versions
e LB 2002, not intrinsically safe
e LB 21xx, intrinsically safe

* FB 22xx, intrinsically safe

200180 2009-08
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Note!

"xx" replaces the different versions. Versions are available with or without both bus-
independent output disable input and line fault detection. The DTM cannot identify the
special features of the different versions.

Select the appropriate version from the catalog in line with the valve type. Note which
backplane types are compatible with the different versions.

The module is suitable for the following applications depending on the version:

¢ Solenoid valve control

¢ Lamp and signal control,

* Processing digital inputs,

¢ NAMUR inputs or mechanical contacts independent of the valve circuit.

Refer to the LB/FB hardware manuals for more information on controlling or connecting
solenoid valves to an LED.

Features
¢ Module width: 1 slot
¢ 1 output channel

e 2input channels (feedback inputs) behave in the same way as the inputs on module
1x02

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The maximum input frequency of the signals is 50 Hz. Whether signals of this frequency
can actually be measured, however, depends on the cycle time of the data traffic on the
Profibus (e.g. only 1 Hz with 500ms sampling interval).

Short signals can be extended to suit the sampling cycles of the process control system
using a parameterizable OFF delay (see section "Editing device data" for this I/O module).
The signals are transmitted to the Com Unit every 6.5 ms irrespective of the sampling
interval of the process control system.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
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and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The DP configuration code of the digital output is 30.

Device function - bit assignment in the data telegram
Digital output 2xxx

Byte Bit | Meaning

Input byte 1 Valve output status

Line fault detection valve output 1 (0 = OK, 1 = error)

Status channel 1

Line fault detection channel 1 (0 = OK, 1 = error)
Status channel 2
Line fault detection channel 2 (0 = OK, 1 = error)
Empty
Empty
Valve output
Empty
Empty
Empty
Empty
Empty
Empty
Empty

Output byte 1

N| O O A W = O N OO A W N =O

[Table 8.5: Device function - bit assignment in the data telegram

8.5.3 Line fault detection

Each channel has a function for line fault detection and can distinguish between a lead
breakage and a short circuit (NAMUR input only). Line fault detection can be switched on
and off via software.

If you are using mechanical contacts, either deactivate line fault detection or connect the
mechanical contact at the installation location using a NAMUR replacement resistor (see
illustration below). The NAMUR replacement resistor replicates a NAMUR initiator. Using
the NAMUR replacement resistor, the electronic circuit can distinguish between a closed
switch and a short circuit. The NAMUR replacement resistor is available from P+F as an
accessory.

The valve control circuit is monitored by a current pulse. This current pulse is brief enough
not to operate a connected valve. The I/O module is available in a version without current
pulse for use with LEDs and acoustic alarms. I/O modules delivered from 2007 onwards
have a current pulse that can be disabled in the configuration software.
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It is not always possible to monitor the valve circuit when booster valves are used and so
each case must be assessed individually. In many cases, monitoring is possible using an
auxiliary circuit.

It is not always possible to monitor the valve circuit when booster valves are used because
these valves have a storage capacitor that behaves like a short circuit when the valve is off.
For some types of booster valve, line fault detection can be achieved by connecting a shunt
resistor of 10 kQ. If a lead breakage is still detected when the valve is off, even with the
shunt resistor connected, disable the line fault detection function.

1oKa 2.2 KQ

Figure 8.25: NAMUR equivalent resistance

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).
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8.5.5 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

— Device Data
: - 0K I Load | Resst
Maodule/Type: [2101__] [Ex.Ra=3150Ohm_ ]
Aetive v Cancel | Save |
Slat: |13
TaGMo: |LB-2101 M
—Walve
forze valve ’ line: fault detection
TAG-Mo. Ch ko operating mode: enor mode: 1
(2) (5) () HENONO
Walve [KO): I i INormaI LI Isubstitute value * Extel ed...l
—Input
closed contact . ling Fault detection
TAG-Mo. Ch = operating mode: ermor mode: [LFD]
o1
Input 1 (K1) I I INormaI j Isubstituted valuej v Ex[ended___l
Input 2 (K2 I o O INormaI LI Isubstituted valueLI v Exlended...l
Remarks:

Figure 8.26: Digital input 2xxx: Device data window

1 Measuring point data area + buttons

2 TAG No. channel box

3 Set valve with and Closed contact = option
4 Operating mode drop-down list

5 Error mode drop-down list

6 Short circuit / breakage detection check box
7 Extended button

8 Note box

Explanations:

1

Measuring point data area + buttons

This area is identical for all /O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements" (see chapter 7.2.2).

2
TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
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3

Set valve with and Closed contact = option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

7
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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8

Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

OM delay in ms m
OFF delay in ms Iﬁ
- Substitute Yalues
Data: .0  Statuss  [ata ik i )
@ Datainvald
— Simulation Yalues
Data: Status: (" Data OK
*+ Dala |nva||di

(114 I Cancel

Figure 8.27: Digital channel window with additional channel settings

ON delay box
OFF delay box
Substitute value area

A WO DN =

Simulation value area
Explanations:

1

ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay
on both digital inputs to filter out brief disturbing pulses (contact bounce) (see illustration
below).

The ON delay is of little importance for the digital output because it is located at the end of
the active chain and the upstream links of the chain play an important role in determining
the time response.
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2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
on the two digital outputs to extend short pulses. In this way, even extremely short signals
from the fieldbus cycle can be detected(e.g. go-devil control) (see illustration below).

The OFF delay is of little importance for the digital output because it is located at the end of
the active chain and the upstream links of the chain play an important role in determining
the time response.

M I
I T

Figure 8.28: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

e Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

¢ Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.
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8.5.6 Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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LB/FB 3x01 analog input

Figure 8.29: Connection diagram 3x01
e Use terminals 4 or 5 (+) and 6 (-) as input isolators for active signals from the field. The
input resistance is 15 Q.

e Use terminals 2 or 3 (+, power supply), 4 or 5 (+, return line), and 6 (-) as a transmitter
supply device for 3-wire transmitters.

e Use terminals 2 or 3 (+) and 4 or 5 (-) as a transmitter supply device.

The analog input is the interface for the process signals from the pressure and differential
pressure transmitters, level transmitters, externally supplied analysis devices and flow/fluid
level transducers to pass to the process control system or the PLC.

Versions
¢ LB 3101, intrinsically safe
¢ FB 3201, intrinsically safe

Features

* Module width: 1 slot

* 1 channel

* Supply voltage 14.5V

* Secondary voltage 24 V (Ex-i)

* Short-circuit current 90 mA (Ex-i)

At 20 mA, the minimum supply voltage is 14.5 V. The voltage is adapted to the needs of the
field device up to this limit value. When the mA value decreases to 4 mA, the supply
voltage increases to approx. 19 V.
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Note!

HART bus communication is only possible via the HART analog inputs LB/FB 3x02, 3x03,
or 3x05.

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Input signals within a range of 0 ... 25 mA are detected with a resolution of 12 bits. The
actual measurement range is calculated based on this resolution.

For the range 4 to 20 mA (corresponds to 0 ... 100 %), a resolution of 2500 measurement
points is obtained, which corresponds to 0.04 %. Underranges and overranges are taken
into consideration.

Measuring time and cycle time

The conversion time is approx. 100 ms. The immediacy of the measured value depends on
the cycle time of the data traffic in the Profibus. The signals are transmitted to the Com Unit
every 6.5 ms irrespective of the measuring time.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

The DP configuration code of analog outputs 3x01 and 3x03 is 50. The DP configuration
codes of the analog input 3x02 are 50, 52, 54, 56, or 58, depending on the number of
HART auxiliary variables being transferred (see section "Editing device data" for the analog
input 3x02).
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Device function - bit assignment in the data telegram

Analog output 3x01/3x02/3x03

Byte Bit | Meaning
Input byte 1 0 Live zero if current < 3.6 mA (%)
(low byte) 1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value (12 bit)
5
6
7
Input byte 2 0-7
(high byte)
Output bytes Without output bytes

(*) The live zero monitor transmits an error bit (=1) if the current falls below the minimum
of 3.6 mA.

[Table 8.6: Device function - bit assignment in the data telegram

Line fault detection

The I/0 module has a line fault detection function that can detect lead breakages and short
circuits. Line fault detection can be switched on and off via software. You can preset the
switching points at which a lead breakage or a short circuit is signaled, e.g. < 1 mA and >
21 mA.

In addition, the circuit provides live-zero monitoring (fault bit = 1 if the current drops below
the minimum level of 3.6 mA).

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.
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8.6.6 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

/ Device Data ’T‘ Load |

Module/Type: 3100 |  [Transmitter Power Supply, Ex, min. 154 |
Module active W ﬂ Cancel | Save |
Slat: IT
Modul - TAG-Na.: |LE-3101 Help | eset |
Channel 1 I
TAG-No.| (2)
-~ #nalog-nput
opetating mode: Sealing in Bits [0...65535]— - Line fault detection
INormaI 1 : !:I with status v @ ¥ an
errar mode; alarm paint

Icurrent value °‘ begin of range: | 10000~ shorts: I21— mﬂ.
Extended..! : ) full szale: 500 line: Fault: |1 mé.

Buz specific parameters

Data tranzfer mode:

ISlandard [2 Byte] LI

Femarks:

@

Figure 8.30: Analog input 3x01: Device data window

Measuring point data area + buttons
TAG No. box

Operating mode drop-down list
Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists
Line fault detection check box

9 Short circuit box

10 Lead breakage box

11 Note box

0 N O g s WODN =

Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements” (see chapter 7.2.2).
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2

TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.
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7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
Short circuit box

Enter the threshold value for short circuit detection (e.g. 21 mA). When the current strength
exceeds this value, the line fault detection function reports a short circuit.

10
Lead breakage box

Enter the threshold value for lead breakage detection (e.g. 1 mA). When the current
strength falls below this value, the line fault detection signals a lead breakage.

1
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
Dtz i

Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.31: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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LB/FB 3x02 and 3x03 HART analog inputs

HHC

Figure 8.32: Connection diagrams 3x02 and 3x03

Use terminals 1 (+) and 6 (-) as input isolators for active signals from the field and
operate via the HART protocol. The input resistance is 236 Q (dynamic).

Use terminals 4 or 5 (+) and 6 (-) as input isolators for active signals from the field. The
input resistance is 15 Q.

Use terminals 2 or 3 (+, power supply), 4 or 5 (+, return line) and 6 (-) as a transmitter
supply device for 3-wire transmitters.

Use terminals 2 or 3 (+) and 4 or 5 (-) as a transmitter supply device.

HART handhelds with a Certificate of Conformity are connected to terminals 3 (+) and 4
(-). The communication resistor is already fitted.

The analog input is the interface for the process signals from the pressure and differential
pressure transmitters, level transmitters, externally supplied analysis devices and flow/fluid
level transducers to pass to the process control system or the PLC.

Versions

LB 3002, not intrinsically safe, HART

LB 3102, intrinsically safe, 16.5 V, HART
LB 3103, intrinsically safe, 15V, HART
FB 3202, intrinsically safe, 16.5 V, HART
FB 32083, intrinsically safe, 15V, HART
FB 3302, Ex-e, HART
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Features

¢ Module width: 1 slot

¢ 1 channel

e Supply voltage 16.5 V or 15 V (different Ex-I data, depending on the version)

At 20 mA, the minimum supply voltage is 16.5 V or 15 V. The voltage is adapted to the
needs of the field device up to this maximum value. When the mA value decreases to 4
mA, the supply voltage increases to approx. 22 V or 19 V.

Note!

Terminals 3 and 4 on modules with increased safety (FB 3302, Ex-e) are not built in. HART
bus communication is possible in combination with the features of the master (PCS).

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Input signals within a range of 0 ... 25 mA are detected with a resolution of 12 bits. The
actual measurement range is calculated based on this resolution.

For the range 4 to 20 mA (corresponds to 0 ... 100 %), a resolution of 2500 measurement
points is obtained, which corresponds to 0.04 %. Underranges and overranges are taken
into consideration.

Measuring time and cycle time

The conversion time is approx. 100 ms. The immediacy of the measured value depends on
the cycle time of the data traffic in the Profibus. The signals are transmitted to the Com Unit
every 6.5 ms irrespective of the measuring time.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).
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The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

The DP configuration code of analog outputs 3x01 and 3x03 is 50. The DP configuration
codes of the analog input 3x02 are 50, 52, 54, 56, or 58, depending on the number of
HART auxiliary variables being transferred (see section "Editing device data" for the analog
input 3x02).

Device function - bit assignment in the data telegram

Analog output 3x01/3x02/3x03

Byte Bit | Meaning
Input byte 1 0 Live zero if current < 3.6 mA (%)
(low byte) 1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value (12 bit)
5
6
7
Input byte 2 0-7
(high byte)
Output bytes Without output bytes

(*) The live zero monitor transmits an error bit (=1) if the current falls below the minimum
of 3.6 mA.

[Table 8.7: Device function - bit assignment in the data telegram

Line fault detection

The 1/0 module has a line fault detection function that can detect lead breakages and short
circuits. Line fault detection can be switched on and off via software. You can preset the
switching points at which a lead breakage or a short circuit is signaled, e.g. <1 mA and >
21 mA.

In addition, the circuit provides live-zero monitoring (fault bit = 1 if the current drops below
the minimum level of 3.6 mA).
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Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.

HART communication

If required, you can activate or deactivate HART communication for each channel of the I/O
module. Open the device data window for the I/O module (see section below) to modify this
setting.

Refer to the section "Basic functions of DTM software" (see chapter 7) for more information
on HART communication.
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8.77 Editing device data
Access the Device data window of the I/O module (see chapter 7.2.1).
Device Data
o | Load
Module/Type: 102 [Trarsmiter Power Sugol, Ex FART i 1657 |
Module active W ﬂ Cancel | Save |
Slat: IF
Modul - TAG-No.; |LE-3102 Hep | Resst |
Channel 1 I
TAGNo:| @)
~ #nalog-input
operating mode: Sc:alir]g in Bitz [0..65535)— - Line fault detection
INormal 1 : !:I with status v @ W on
error mode: alarm point
Icurrent value o‘ begin of ramge: | 10000+ shorts: |2'| mﬂ,
Extended. | full scale: 500 Jine: Falt; |1 mé.
Buz specific parameters —HART
[D'ata tranzfer mode: o @
IStandard [2 Byte] @ W with szan (10, TAG, Var) @
Femarks: @
Figure 8.33: Analog input 3x02/3x03: Device data window
1 Measuring point data area + buttons
2 TAG No. box
3 Operating mode drop-down list
4 Error mode drop-down list
5 Extended button
6 With statuscheck box
7 Start of range/End of range drop-down lists
8 Line fault detection check box
9 Short circuit box
10 Lead breakage box
11 Data transmission mode drop-down list (3x02 only)
12 Active check box
13 With scan (ID, TAG, variables) check box
14 Note box
3
]
Q
&
bS]
5
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
Short circuit box

Enter the threshold value for short circuit detection (e.g. 21 mA). When the current strength
exceeds this value, the line fault detection function reports a short circuit.

10
Lead breakage box

Enter the threshold value for lead breakage detection (e.g. 1 mA). When the current
strength falls below this value, the line fault detection signals a lead breakage.

Note!
Data transmission mode drop-down list

Data transmission mode can only be edited if, in the Firmware-dependent device
functions window of the Com Unit you activated the function Use of the extended
PROFIBUS modes for 3x02 ... (see chapter 6.2.1).
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Warning!
PROFIBUS will restart if the data transmission mode is changed (3x02 only)

If you change the setting in the Data transmission mode drop-down list for analog input
3x02, it affects the structure of the PROFIBUS data telegram. You will then need to restart
the PROFIBUS!

Only if your process control system supports HCiR will a change to this parameter not
affect the function of the remote I/O station (see chapter 6.8).
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11
Data transmission mode drop-down list

This drop-down list is only valid for the analog input 3x02 and not for analog input 3x03.
Select the number of HART auxiliary variables that should be included in the cyclical data
traffic (max. 4). HART auxiliary variables each occupy 4 bytes in the cyclical data traffic.
The I/O module occupies a total of 18 bytes in the cyclical data traffic, including all 4 HART
auxiliary variables. 13 of these I/O modules fill the entire data area (13*18 = 234). The
HART auxiliary variables are updated less frequently than the standard process data.

The following selection options are available.

"Standard": 2 bytes of data are available in standard mode (see the table in the previous
section "Data transfer" for more comprehensive details). DP Config. code (hex): 50

e "Standard + 1st HART variable": The first HART auxiliary variable is made available (2
bytes + 4 bytes = 6 bytes). DP Config. code (hex): 52

e "Standard + 1st + 2nd HART variable": The first and second HART auxiliary variables
are made available (2 bytes + 8 bytes = 10 bytes). DP Config. code (hex): 54

* "Standard + 1st - 3rd HART variable": The first, second and third HART auxiliary
variables are made available (2 bytes + 12 bytes = 14 bytes). DP Config. code (hex): 56

e "Standard + 1st - 4th HART variable": The first, second, third and fourth HART auxiliary
variables are made available (2 bytes + 16 bytes = 18 bytes). DP Config. code (hex): 58

I3 PEPPERL+FUCHS
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12
Active check box

Activate or deactivate HART communication to the channel. Deactivate HART
communication,

¢ if no HART-compatible devices are connected,
* if HART communication fails and fault messages occur frequently,

e if HART communication to the HART-compatible I1/O module is no longer required
(saves time, which can be used for essential HART communication).

Refer to the Chapter "Basic functions of DTM software" (see chapter 7) for more

information on HART communication.

Note!
Active check box

Active can only be edited if you have activated the Individual HART channel
deactivation function in the firmware-dependent device functions window of the Com
Unit (see chapter 6.2.1) . Otherwise the active option is enabled as standard.

13
With scan (ID, TAG, variables) check box

This check box only appears if you have activated HART communication (see paragraph
above).

You can use this option to activate or deactivate the automatic scanning of HART
communication IDs, tags and variables. All active HART channels are scanned
automatically as standard, whereby HART data is retrieved and saved to enable quicker
external access.

Note!
With scan (ID, TAG, variables) check box

With scan (ID, TAG, variables) can only be edited if you have activated the Disable the
self-controlled HART device scan function in the firmware-dependent device
functions window of the Com Unit DTM (see chapter 6.2.1). Otherwise the with scan (ID,
TAG, variables) option is enabled as standard.

14
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
Dtz i

Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.34: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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LB/FB 3x04 and 3x05 (HART) analog input
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Figure 8.35: Connection diagrams 3x04 and 3x05

e Use terminals 3 (+) and 4 (-), 7 (+) and 8 (-), 11 (+) and 12 (-), and 15 (+) and 16 (-) as
input isolators for active signals from the field. The input resistance is 15 Q (without
HART).

e Useterminals 1 (+)and 2 (-),5 (+) and 6 (-), 9 (+) and 10 (-), and 13 (+) and 14 (-) as a
transmitter supply device.

* HART handhelds with a Certificate of Conformity are connected in parallel to the signal
converter. The communication resistor is already fitted.

The analog input is the interface for the process signals from the pressure and differential
pressure transmitters, level transmitters, externally supplied analysis devices and flow/fluid
level transducers to pass to the process control system or the PLC.

Versions

e LB 3005, not intrinsically safe, HART
e LB 3104, intrinsically safe

e LB 3105, intrinsically safe, HART

e FB 3204, intrinsically safe

e FB 3205, intrinsically safe, HART

e FB 3305, Ex-e, HART

Features
¢ Module width: 2 slots
e 4 channels

e Supply voltage 15 V
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At 20 mA, the minimum supply voltage is 15 V. The voltage is adapted to the needs of the
field device up to this maximum value. When the mA value decreases to 4 mA, the supply
voltage increases to approx. 19 V.

Note!

HART bus communication is only possible with LB/FB 3x05 in combination with the
features of the master (PCS). LB/FB 3x04 does not have HART functionality.

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Input signals within a range of 0 ... 25 mA are detected with a resolution of 12 bits. The
actual measurement range is calculated based on this resolution.

For the range 4 to 20 mA (corresponds to 0 ... 100 %), a resolution of 2500 measurement
points is obtained, which corresponds to 0.04 %. Underranges and overranges are taken
into consideration.

Measuring time and cycle time

The conversion time for all 4 channels combined is approx. 80 ms. The immediacy of the
measured value depends on the cycle time of the data traffic in the Profibus. The signals
are transmitted to the Com Unit every 6.5 ms irrespective of the measuring time.

During HART communication, new values are only transmitted to the Com Unit every third
internal data cycle. 50 ms is required. In the worst case scenario, the total time is 130 ms.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.
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In the cyclic data exchange process, data is communicated in the same order as the
channels (channel 1, channel 2, etc.).

Note!

Dual-width 1/0 module

Dual-width I/0 modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).

The DP configuration code of the analog input is 53.

Device function - bit assignment in the data telegram

Analog inputs 3x04/3x05

Byte Bit | Meaning

Input byte 1 0 Live zero if current < 3.6 mA (%)

(low byte) 1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value channel 1 (12 bit)
5
6
7

Input byte 2 0-7

(high byte)

Same structure for channe

modul

Is 2, 3, and 4. The 4 channels are spread over 2 slots (the I1/0
es is twice as wide); total of 8 input bytes

Output bytes

Without output bytes

of 3.6 mA.

(*) The live zero monitor transmits an error bit (=1) if the current falls below the minimum

[Table 8.8: Device function - bit assignment in the data telegram

Line fault detection

The I/0 module has a line fault detection function that can detect lead breakages and short
circuits. Line fault detection can be switched on and off via software. You can preset the
switching points at which a lead breakage or a short circuit is signaled, e.g. < 1 mA and >

21 mA.

In addition, the circuit provides live-zero monitoring (fault bit = 1 if the current drops below
the minimum level of 3.6 mA).
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Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.

HART communication

If required, you can activate or deactivate HART communication for each channel of the I/O
module. Open the device data window for the I/O module (see section below) to modify this
setting.

Refer to the section "Basic functions of DTM software" (see chapter 7) for more information
on HART communication.
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8.8.7 Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

Module Data: Transmitter Power Supply f Input Isolator LB-3105

- Device Data 1
_ ok | load |
Module/Type: 105 | [Tranamitter Power Supply, Ex, HART 4 Ch |
Madule active v @ Cancel ‘ Save J
Slat: 16
Modul - TAG-No.: |LE-3105 Hep | Reset |

Channel 1 ]Ehannel2] Charmel 3] Channel 4 |

TAGNo.:| (2)
Analog-lnput-
operating mode: Scaling in Bitz [0...65535) Lire Fault detection
Harmal ( : ): with statuz v @ v on
error mode; alarrn point
begin of range: {10000~ shorts: IE‘I—. mﬁ.
E:-:tended.! : ) full scale: j5ﬂﬂéiv lire: Fault: ]1—‘ mﬂ.
- Bus specific parameters : H.t‘-\FE-T.
D ata tranzfer mode: v o @
| —J v with zzan (10, TAG, Var] @

Remarks:

©)

Figure 8.36: Analog input 3x04/3x05: Device data window

Measuring point data area + buttons
TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists
Line fault detection check box

Short circuit box

Lead breakage box

Active check box

With scan (ID, TAG, variables) check box
Note box

00 N O B~ WODN =

O e T
wWw N = O

Note!

HART communication

10

The check boxes for HART functionalities are available for I/O modules 3x05/4x05, but not
for I/0 modules 3x04/4x04.
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
Short circuit box

Enter the threshold value for short circuit detection (e.g. 21 mA). When the current strength
exceeds this value, the line fault detection function reports a short circuit.

10
Lead breakage box

Enter the threshold value for lead breakage detection (e.g. 1 mA). When the current
strength falls below this value, the line fault detection signals a lead breakage.
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1
Active check box

Activate or deactivate HART communication to the channel. Deactivate HART
communication,

¢ if no HART-compatible devices are connected,
* if HART communication fails and fault messages occur frequently,

e if HART communication to the HART-compatible I1/O module is no longer required
(saves time, which can be used for essential HART communication).

Refer to the Chapter "Basic functions of DTM software" (see chapter 7) for more

information on HART communication.

Note!
Active check box

Active can only be edited if you have activated the Individual HART channel
deactivation function in the firmware-dependent device functions window of the Com
Unit (see chapter 6.2.1) . Otherwise the active option is enabled as standard.

12
With scan (ID, TAG, variables) check box

This check box only appears if you have activated HART communication (see paragraph
above).

You can use this option to activate or deactivate the automatic scanning of HART
communication IDs, tags and variables. All active HART channels are scanned
automatically as standard, whereby HART data is retrieved and saved to enable quicker
external access.

Note!
With scan (ID, TAG, variables) check box

With scan (ID, TAG, variables) can only be edited if you have activated the Disable the
self-controlled HART device scan function in the firmware-dependent device
functions window of the Com Unit DTM (see chapter 6.2.1). Otherwise the with scan (ID,
TAG, variables) option is enabled as standard.

13
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
Dtz i

Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.37: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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PROFIBUS COM UNIT
Configuring 1/0 modules

8.9 LB/FB 4x01 and 4x02 (HART) analog output

|/ P
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o) +L|-% o O

[
COM

Figure 8.38: Connection diagrams 4x01 and 4x02 without output disable input

e Use terminals 2 or 3 (+) and 4 or 5 (-) for output isolators.

* HART handhelds with a Certificate of Conformity are connected to terminals 3 (+) and 4
(-). The communication resistor is already fitted.

& || 1/P | | 0000 &5 | | 1/P | | 0000
’_‘ F"'\_TJ": HHC ’J F"'\_TJ": HHC
Ll Ll
1 2 3 4 5 6 1 2 3 4 5 6
o 0 0 o 0 0
Ex ExX
COM COM
oV

O—l ext.

OFf /
12Vint.

Figure 8.39: Connection diagrams 4x02 with output disable input

The analog output is the interface between process signals from actuators sensors, I/P
converters, proportional valves, on-site displays and the process control system or PLC.
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Versions

e LB 4002, not intrinsically safe, HART
¢ LB 4101, intrinsically safe

¢ LB 4102, intrinsically safe, HART

¢ FB 4201, intrinsically safe

e FB 4202, intrinsically safe, HART

e FB 4302, Ex-e, HART

Note!

Versions of the I/O module LB/FB 4x02 are available with and without a bus-independent
output disable input. Select the appropriate version from the catalog. Note which backplane
types are compatible with the different versions. Refer to the LB/FB hardware manuals and
the P+F SIL manual for more detailed information.

Features

* Module width: 1 slot

* 1 channel

e Qutput load: 750 Q

e Output voltage: 15V

At 20 mA, the output voltage is at least 15 V.

Note!

HART bus communication is only possible with LB/FB 4x02 in combination with the
features of the master (PCS). LB/FB 4x01 does not have HART functionality.

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Output signals within a range of 0 ... 25 mA are generated with a resolution of 12 bits. The
actual measurement range is calculated based on this resolution.

For the range 4 to 20 mA (corresponds to 0 ... 100 %), a resolution of 2500 measurement
points is obtained, which corresponds to 0.04 %.

Measuring time and cycle time

The conversion time is approx. 50 ms. The immediacy of the measured value depends on
the cycle time of the data traffic in the Profibus. The signals are transmitted to the Com Unit
every 6.5 ms irrespective of the measuring time.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD

file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.
If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.
A 16-bit word is available for transferring data to each channel. The most important 12 bits

are used.

Digital information can be transmitted in the remaining 4 bits.

The DP configuration code of the analog output is 60.

Device function - bit assignment in the data telegram

Analog output 4x01/02

(high byte)

Byte Bit | Meaning
Input bytes Without input bytes
Output byte 1 0 Empty
(low byte) 1 Empty
2 Empty
3 Empty
4 Process value (12 bit)
5
6
7
Output byte 2 0-7

[Table 8.9: Device function - bit assignment in the data telegram

Line fault detection

The I/O module has a line fault detection function that can detect lead breakages. The non-
linear voltage of modern HART actuators means that short circuits cannot be detected.
Line fault detection can be switched on and off via software.
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Line fault detection works on the basis of measuring a minimum current of 1 mA. This
current still flows even when the control system specifies 0 mA. The line fault detection
function is therefore unsuitable for 0 ... 20 mA outputs. When currents < 0.1 mA are
detected, a lead breakage is signaled.

Watchdog (watchdog circuit)

The 1/0 module has a watchdog that switches off the output channel/channels after 500 ms
if three successive unsuccessful attempts are made to communicate with the Com Unit.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in
the module status register and the global status register.

HART communication

If required, you can activate or deactivate HART communication for each channel of the I/O
module. Open the device data window for the I/O module (see section below) to modify this
setting.

Refer to the section "Basic functions of DTM software" (see chapter 7) for more information
on HART communication.
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8.9.9 Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

~ Module Data: Output IsolatorL B-4102
Device Data
ak. | Load
Module/Typpe: [4102 | [OutputTsclator, Ex, HART, 800 Ohm | J
Module active i @ Cancel ‘ Save J
Slat; 18
Madule - TAGHNo. [LB-4102 Help | Resst |
Chanrel 1 ]
TAG-Ha. | @
Analog Output
operating mode: Scaling in Bits [0...65535) 1 Line fault detection [LFD]-
]ND”'“E" Z : 5 '] with Status [ @ ¥ on
error mode; iy
: ecid
]suhstituted valu{ : ) - begin. of 10000 = B
ke 50001 = mir. current: ’_1_ mﬂ«@
Extended.. .
HART 1
]7 ar Ophions... ( :)
I:/' with Scan (1D, TAG, War)

Remarks: @

Figure 8.40: Analog output 4x01/4x02: Device data window

Measuring point data area + buttons

TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists
Breakage detection check box

9 Min. current field

10 Active check box (4x02 only)

11 With scan (ID, TAG, variables) check box (4x02 only)
12 Further options button (4x02 only)

13 Note box

O N O O s WODN =

Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements" (see chapter 7.2.2).
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2

TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted via the fieldbus.

e "Simulation": In simulation mode, a process value is simulated. This parameter is preset
in a separate window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the /0O module responds in the event of a communication fault or if the "Invalid”
identifier is preset. Select between "Current value", "Substitute value" and "Last valid
value":

* "Current value": The process value is issued unchanged in spite of the error (the value
may be simulated).

* "Substitute value": A substitute value is issued. The substitute value is preset manually
in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last valid value is issued.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.
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7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

8
Breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage only), a diagnosis is transmitted.

9
Min. current field

Enter the threshold value for the lead breakage detection (e.g. 0.8 mA). When the current
strength falls below this value, the line fault detection signals a lead breakage.

10
Active check box

Activate or deactivate HART communication to the channel. Deactivate HART
communication,

* if no HART-compatible devices are connected,
¢ if HART communication fails and fault messages occur frequently,

¢ if HART communication to the HART-compatible I/O module is no longer required
(saves time, which can be used for essential HART communication).

Refer to the Chapter "Basic functions of DTM software" (see chapter 7) for more
information on HART communication.

Note!
Active check box

Active can only be edited if you have activated the Individual HART channel
deactivation function in the firmware-dependent device functions window of the Com
Unit (see chapter 6.2.1) . Otherwise the active option is enabled as standard.
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10

1
With scan (ID, TAG, variables) check box

This check box only appears if you have activated HART communication (see paragraph
above).

You can use this option to activate or deactivate the automatic scanning of HART
communication IDs, tags and variables. All active HART channels are scanned
automatically as standard, whereby HART data is retrieved and saved to enable quicker
external access.

Note!
With scan (ID, TAG, variables) check box

With scan (ID, TAG, variables) can only be edited if you have activated the Disable the
self-controlled HART device scan function in the firmware-dependent device
functions window of the Com Unit DTM (see chapter 6.2.1). Otherwise the with scan (ID,
TAG, variables) option is enabled as standard.

12
Further options button

The button opens a window with HART communication adjustment options. There you can
define the number of protocol preambles and enter how often telegrams with errors are to
be repeated. These parameters affect the processing speed of the HART communication.

13
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analug Channels

Analog Filter in %4sec

rhin. valug in Bits ( )

may, valug in Bits 0000
Substitute Values

AnalogValue ih % v with Status
D \@

% Simulation Yalues
AnglogValuein % W with Status.

U
¥ Data \nvahd\@

’T‘ Cancel J

Figure 8.41: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filters for damping the signal are activated if the output signals fluctuate.

Enter a value in % for defining the rate of change of the output value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is issued when a communication fault occurs or the "Invalid" identifier is set
and you have selected "Substitute value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, a further check box will become available:

Invalid data: Transfers the substitute value with an "Invalid data" identifier. The status for
the output signal has no other use.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is issued if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, a further check box will become available:

Invalid data: Transfers the simulation value with an "Invalid data" identifier. The substitute
value is output if you activate Invalid data.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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Configuring strain gage measurement

The I/0 modules 5x02 and 4x01 can be interconnected for strain gage readings. Use the
4x01 analog output to produce a constant current, and the measurement input of the 5x02
temperature input to process the millivolt signal from the voltage generated across the
bridge. The measured value is tranmitted to the PLC or process control system via the
fieldbus.

A constant current of 20 mA is suitable for supplying a 350 Q bridge. This produces a
bridge voltage of 7 V. If the bridge sensitivity is 2 mV/V, then the full-load voltage is 14 mV.

Configuring I/O modules for strain gage measurement

Prerequisite: You have already created a project file in the configuration software. This
project file is open and the tree structure contains a Com Unit and the I/O modules 4x01
and 5x02. Communication with the remote 1/O station is working properly.

1. Either set
the operating mode of analog output 4x01 to "Simulation" (Device data > Operating
mode drop-down list) and set 20 mA as the simulation value (click the Extended button)
or
set a fixed value of 20 mA via the fieldbus.

2. Set temperature input 5x02 to millivolt measurements "mV" (Device data > Sensor
drop-down list).

3. For temperature input 5x02, select "external reference junction" (Device data >
Measuring method drop-down list ).

4. Deactivate reference junction compensation on temperature input 5x02 by setting the
thermostat temperature of the external reference junction to 0 °C (Device data > Ext.
reference junction box).

5X02 Bus

4X01

Figure 8.42: Example: Strain gage bridge

I PEPPERL+FUCHS

201



PROFIBUS COM UNIT
Configuring 1/0 modules

8.10 LB/FB 4x04 and 4x05 (HART) analog output
0000 0000
Vo Vo
Vo Vo
/ /P

+
—omn H U0
RN
—On
+

—OOOo
o~ —
—O o —

Figure 8.43: Connection diagrams 4x04 and 4x05 without output disable input

e Useterminals 1 (+) and 2 (-), 3 (+)and 4 (-), 5 (+) and 6 (-), and 7 (+) and 8 (-) for output
isolators.

e HART handhelds with a Certificate of Conformity are connected in parallel to the field
device. The communication resistor is already fitted.

@ 1/P ||0000||HHC @ 1/P || 0000|| HHC

Ch.1 Ch.4 Ch.1 Ch.4
1 2 3 4 5 6 7 8

Ch.

| COM | COM |

O—l ext.

OFF /
12Vint.

Figure 8.44: Connection diagrams 4x04 and 4x05 with output disable input

200180 2009-08

202 FPEPPERL+FUCHS



[—10

[0

8.10.1

8.10.2
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The analog output is the interface between process signals from actuators sensors, I/P
converters, proportional valves, on-site displays and the process control system or PLC.

Versions

e LB 4005, not Ex-i, HART

e LB 4104, intrinsically safe

e LB 4105, intrinsically safe, HART
¢ FB 4204, intrinsically safe

¢ FB 4205, intrinsically safe, HART
e FB 4305, Ex-e, HART

Note!

Versions are available with and without a bus-independent output disable input. Select the
appropriate version from the catalog. Note which backplane types are compatible with the
different versions. Refer to the LB/FB hardware manuals and the P+F SIL manual for more
detailed information.

Features

* Module width: 2 slots

* 4 channels

e OQutput load: 750 Q

e Output voltage: 15V

At 20 mA, the output voltage is at least 15 V.

Note!

HART bus communication is only possible with LB/FB 4x05 in combination with the
features of the master.

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Output signals within a range of 0 ... 25 mA are generated with a resolution of 12 bits. The
actual measurement range is calculated based on this resolution.

For the range 4 to 20 mA (corresponds to 0 ... 100 %), a resolution of 2500 measurement
points is obtained, which corresponds to 0.04 %.

Measuring time and cycle time

The conversion time for all 4 channels combined is approx. 60 ms. During HART
communication, this time is extended to 110 ms. The immediacy of the measured value
depends on the cycle time of the data traffic in the Profibus. The signals are transmitted to
the Com Unit every 6.5 ms irrespective of the measuring time.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

Note!
Dual-width 1/0 module

Dual-width I/0 modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).
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The DP configuration code of the analog output is CO 43 40.

Device function - bit assignment in the data telegram

Analog output 4x04/05

Byte Bit

Meaning

Input byte 1

Empty

(low byte)

Line fault detection channel 1 (0 = OK, 1 = error)

Empty

Empty

Empty

Line fault detection channel 2 (0 = OK, 1 = error)

Empty

Empty

Input byte 2

Empty

(high byte)

Line fault detection channel 3 (0 = OK, 1 = error)

Empty

Empty

Empty

Line fault detection channel 4 (0 = OK, 1 = error)

Empty

Empty

Output byte 1

Empty

(low byte)

Invalid channel 1

Empty

Empty

N OO A WO =O N0 AW N =O NO| O Al W N = O

?
\l

Output byte 2
(high byte)

Process value channel 1 (12 bit)

Other output bytes

Same structure for channels 2, 3, and 4

[Table 8.10: Device function - bit assignment in the data telegram

Line fault detection (4x05D only)

The I/O module has a line fault detection function that can detect lead breakages. The non-
linear voltage of modern HART actuators means that short circuits cannot be detected.

Line fault detection can be switched on and off via software.

Line fault detection works on the basis of measuring a minimum current of 1 mA. This
current still flows even when the control system specifies 0 mA. The line fault detection

function is therefore unsuitable for 0 ... 20 mA outputs. When currents < 0.1 mA are
detected, a lead breakage is signaled.
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Note!

The I/O module 4x05 is available with or without a lead breakage monitoring function. The
Com Unit and the operator interface of the two different versions are the same. Note the
special code in the order number (4x05D).

The I/O module 4x04 does not have a line fault detection function.

Watchdog (watchdog circuit)

The I/0 module has a watchdog that switches off the output channel/channels after 500 ms
if three successive unsuccessful attempts are made to communicate with the Com Unit.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0 module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

HART communication

If required, you can activate or deactivate HART communication for each channel of the I/O
module. Open the device data window for the I/O module (see section below) to modify this
setting.

Refer to the section "Basic functions of DTM software" (see chapter 7) for more information
on HART communication.
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Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

=
Device Data
_ = ok | Load |
Module/Type: (3105 [Dutput Teclator, HART, Ex, 500 Ohm, 4 Ch ]
Module active vl Cancel | Save |
Slat: |4_
Module - TAG-No. [LB-4105 hoe | Reset |
Channel 1 |Ehannel 2| Channel 3| Channel 4 |
TAG-Ho.: | @
—dinalog Dutput
operating mode; Sealing in Bits [0...65535)  Line fault detection (LFD))
|Normal Z : ) j‘ with Status [
errar mode;

[t e (4) =] | Bea ol % Specid
Tl 5000 = min. current: I'I_mA
Extehg:led..@ '
H&RT
F o [omme (1)

@ W with Scan (1D, TAG, Vai)

Remarks: @

Figure 8.45: Analog output 4x04/4x05: Device data window

© 00 N O O A~ WODN =

Measuring point data area + buttons

TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists
Min. current field

Active check box (4x05 only)

10 With scan (ID, TAG, variables) check box (4x05 only)
11 Further options button (4x05 only)
12 Note box

Note!

HART communication

The check boxes for HART functionalities are available for I/O modules 3x05/4x05, but not

for I/O modules 3x04/4x04.
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted via the fieldbus.

e "Simulation": In simulation mode, a process value is simulated. This parameter is preset
in a separate window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the 1/0 module responds in the event of a communication fault or if the "Invalid"
identifier is preset. Select between "Current value", "Substitute value" and "Last valid
value":

e "Current value": The process value is issued unchanged in spite of the error (the value
may be simulated).

* "Substitute value": A substitute value is issued. The substitute value is preset manually
in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last valid value is issued.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

8
Min. current field

Enter the threshold value for the lead breakage detection (e.g. 0.8 mA). When the current
strength falls below this value, the line fault detection signals a lead breakage.

9
Active check box

Activate or deactivate HART communication to the channel. Deactivate HART
communication,

* if no HART-compatible devices are connected,
¢ if HART communication fails and fault messages occur frequently,

¢ if HART communication to the HART-compatible I/O module is no longer required
(saves time, which can be used for essential HART communication).

Refer to the Chapter "Basic functions of DTM software" (see chapter 7) for more
information on HART communication.

Note!
Active check box

Active can only be edited if you have activated the Individual HART channel
deactivation function in the firmware-dependent device functions window of the Com
Unit (see chapter 6.2.1) . Otherwise the active option is enabled as standard.
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10
With scan (ID, TAG, variables) check box

This check box only appears if you have activated HART communication (see paragraph
above).

You can use this option to activate or deactivate the automatic scanning of HART
communication IDs, tags and variables. All active HART channels are scanned
automatically as standard, whereby HART data is retrieved and saved to enable quicker
external access.

Note!
With scan (ID, TAG, variables) check box

With scan (ID, TAG, variables) can only be edited if you have activated the Disable the
self-controlled HART device scan function in the firmware-dependent device
functions window of the Com Unit DTM (see chapter 6.2.1). Otherwise the with scan (ID,
TAG, variables) option is enabled as standard.

11
Further options button

The button opens a window with HART communication adjustment options. There you can
define the number of protocol preambles and enter how often telegrams with errors are to
be repeated. These parameters affect the processing speed of the HART communication.

12
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analug Channels

Analog Filter in %4sec

rhin. valug in Bits ( )

may, valug in Bits 0000
Substitute Values

AnalogValue ih % v with Status
D \@

% Simulation Yalues
AnglogValuein % W with Status.

U
¥ Data \nvahd\@

’T‘ Cancel J

Figure 8.46: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filters for damping the signal are activated if the output signals fluctuate.

Enter a value in % for defining the rate of change of the output value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is issued when a communication fault occurs or the "Invalid" identifier is set
and you have selected "Substitute value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, a further check box will become available:

Invalid data: Transfers the substitute value with an "Invalid data" identifier. The status for
the output signal has no other use.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is issued if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, a further check box will become available:

Invalid data: Transfers the simulation value with an "Invalid data" identifier. The substitute
value is output if you activate Invalid data.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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8.1 LB/FB 5x01 temperature input

e
4
-
(]RZgéSG
mV
COM

Figure 8.47: Connection diagram 5x01

* Use terminals 5 and 6 for a 2-wire configuration.
e Use terminals 1, 5, and 6 for a 3-wire configuration.

For slide-wire sensors, bypass the central plug socket with one end of the sensor to
form a 3-wire configuration connected to terminals 1, 5, and 6.

e Use terminals 1, 2, 5, and 6 for a 4-wire configuration.

The signal converter is the interface between process signals from Pt100 sensors in a 2, 3,
or 4-wire configuration and the process control system or PLC. Slide-wire sensors up to
400 Q can also be connected.

Versions

e LB 5001, not intrinsically safe
e LB 5101, intrinsically safe

e FB 5201, intrinsically safe

Features

* Module width: 1 slot

* 1 channel

* Measurement range: 0 QQ ... 400 Q

* Smallest span: 20 Q

* Maximum line resistance: 50 Q

* Temperature effect: 0.025% of the max. span/ 10 K
* Linearity error: 0,1 %

* Sensor current: 200 pA

200180 2009-08

Refer to the corresponding data sheet and operating instructions for further information.
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Resolution

Temperatures within a range of -200 °C to 850 °C are detected with a resolution of 16 bits.
The actual measurement range is calculated based on this resolution.

For the smallest range (0 to 100%), a resolution of 2500 measurement points is obtained,
which corresponds to 0.04 %.

Measuring time and cycle time

The internal module processing times depend on the preset measuring process:

e 20 ms without line fault detection,
¢ 125 ms with line fault detection.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time. A filter is available for smoothing the input signals.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

The DP configuration code of the temperature input is 50.
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Device function - bit assignment in the data telegram

Temperature input 5x01/02
Byte Bit | Meaning
Input byte 1 0 Empty
1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value (12 bit)
5
6
7
Input byte 2 0-7
Output bytes Without output bytes
[Table 8.11: Device function - bit assignment in the data telegram

8.11.4 Line fault detection

The device has a line fault detection function that can distinguish between a lead breakage
(resistance > 1 kQ at Pt100) and short circuit (resistance < 10 Q at Pt100). Line fault
detection can be switched off via software.

The broken-wire delay function prevents measured values from being enabled after a line
fault occurs so as to avoid constant toggling between OK/fault if there is a loose contact.

8.11.5 Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0 module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.
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Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

Module Data: RTD Transmitter LB-5001

- Device Data

Module/Type 5001 | [BTD - Converber

l | (4 | Load

Module active W

Slat: ﬁs—

@ Cancel ‘ Save

Modul - TAG-Na.: |LE-5001

Channel 1 ]

Help ‘ Feset

e

TaG-No.| @

Scaling in Bite [0...65535)
Mormal 1 : ): with status [V @
ermor mode:

current valie 0‘ begit of range: mﬂﬂzv
E:-:tended..[ ) full scale: a00

— Tranzmitter Settings

Analoglnput

operating mode;

- method of meas.: |2-wile _‘J
- range: from |0.00 i 10000 ¢

- line resistance:

Line fault detection-

LFD delay: |10 cucles @

-senson | PT-100 ¥
-line fiterHz): 80 O B

'G

-enginesringunit. ™ T

Remarks;

Figure 8.48: Temperature input 5x01: Device data window

1 Measuring point data area + buttons

2 TAG No. box

3 Operating mode drop-down list

4 Error mode drop-down list

5 Extended button

6 With statuscheck box

7 Start of range/End of range drop-down lists (scaling)
8 Line fault detection check box

9 LFD-delay box

10 Measuring method drop-down list

11 Start of range/End of range boxes (physical unit)

12 Line resistance box

13 Sensor drop-down list
14 Line filter option

15 Temperature unit option
16 Note box

Explanations:
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Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted from the field.

* "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value™:

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
LFD-delay box

This field only appears if you have activated Line fault detection.

Specify the number of measuring cycles during which a measured value must be free of
errors before the value is signaled as good. This option can be used for suppressing loose
contacts.

10
Measuring method drop-down list

Set the measuring method currently in use and select between a 2, 3, and 4-wire
configuration. If you select the 2-wire configuration, enter the line resistance in the Line
resistance box.

11
Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.
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12
Line resistance box

This box only appears if you have preset a 2-wire configuration under Measuring method
(see paragraph above).

Enter the resistance value of the spur to compensate for measurement errors. Refer to the
hardware manuals for the LB/FB Remote I/O bus systems for information on how to
measure the line resistance.

13
Sensor drop-down list

Select the sensor. Depending on the sensor, the correct linearization is automatically
used.. The following table lists the sensors that can be used together with the temperature
input

Sensor Beginning of range (min.) End of range (max.)
Resistance 0Q 400 Q
Pt100 -200 °C 850 °C

14

Line filter option

Select the right line filter to compensate for system-related interference (50 Hz and 60 Hz).

15

Temperature in option

This option can only be edited if you have selected a Ptxxx or Nixxx sensor under Sensor.

Select the temperature unit in which you wish to enter the beginning and the end of the
measuring range and display the measured value (°C or °F).

16
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
Dtz i

Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.49: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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LB/FB 5x02 temperature input

mV

COM

Figure 8.50: Connection diagram 5x02

Connect the Pt100 reference junction element to terminals 1 and 2 in a 2-wire
configuration. The element compensates for ambient temperature effects (not
necessary for millivolt measurements or external reference junctions).

Connect the thermocouples or millivolt sources to terminals 5 (+) and 6 (-).

The signal converter is the interface between process signals from thermocouples and the
process control system or PLC. Millivolt signals can also be connected to the module.

Versions

LB 5002, not intrinsically safe
LB 5102, intrinsically safe
FB 5202, intrinsically safe

Features

Module width: 1 slot

1 channel

Measurement range: -75 mV ... +75 mV

Smallest span: 5 mV for 0.1% accuracy

Thermocouple types: U, B, E, T, K, S, R, L, J, N, and Pallaplat
CJC internal or external (thermostat)

Linearity error: 0,1%

Sensor current of CJC: 200 pA

Refer to the corresponding data sheet and operating instructions for further information.
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Resolution

Temperatures within a range of -200 °C to 1850 °C are detected with a resolution of 16 bits.
The actual measurement range is calculated based on this resolution.

For the smallest range of 5 mV (0 to 100 %), a resolution of 2500 measurement points is
obtained, which corresponds to 0.04 %.

All conventional thermocouple curves and Pallaplat are linearized.

Measuring time and cycle time

The internal module processing times depend on the preset measuring process:

¢ External reference junction (CJC)
20 ms without line fault detection; 80 ms with line fault detection

¢ Internal reference junction (CJC)

120 ms without line fault detection; 240 ms with line fault detection
The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time. A filter is available for smoothing the input signals.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

The DP configuration code of the temperature input is 50.
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Device function - bit assignment in the data telegram

Temperature input 5x01/02

Byte Bit | Meaning

Input byte 1 0 Empty
1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value (12 bit)
5
6
7

Input byte 2 0-7

Output bytes Without output bytes

[Table 8.12: Device function - bit assignment in the data telegram

Line fault detection

The device has a line fault detection function for detecting lead breakages. Line fault
detection can be switched off via software.

The broken-wire delay function prevents measured values from being enabled after a line
fault occurs so as to avoid constant toggling between OK/fault e.g. if there is a loose
contact.

¢ With external CJC: 0 ... 250 x 160 ms
¢ With internal CJC: 0 ... 250 x 240 ms.

In addition, for internal cold reference junction compensation, you can set the ratio of
temperature compensation measurements to actual thermocouple measurements to give
an optimum measurement time.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0 module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.
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Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

Module Data: Thermocouple Transmitter LB-5002

Device Data

Module/Type: 5002 [TC/m - Conwerter

| . (8]4 | Load

Module active v

Slat; {ED_

@ Cancel ‘ Save

Modul - TAGNa: |LB-5002

Channel 1 ]

Help | Frezet

Ll g

TAG-Ho.:| @
operating mode: Scaling in Bitz [0...65535]

Mormal 1 : i' with statuz W @

ermor mode:
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EHtended.: ) full scale: 505 -

i Tranzmitter Settings
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Figure 8.51: Temperature input 5x02: Device data window

Measuring point data area + buttons
TAG No. box

Operating mode drop-down list
Error mode drop-down list

Extended button

With statuscheck box
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Line fault detection check box
LFD-delay box
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Measuring method drop-down list
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Sensor drop-down list
Line filter option

- ek
N o O

Note box
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Start of range/End of range drop-down lists (scaling)

Pt100 scan rate box (with internal CJC only)

Start of range/End of range boxes (physical unit)

Line resistance or External reference junction box

Temperature unit option (not with mV measurement)
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
LFD-delay box

This field only appears if you have activated Line fault detection.

Specify the number of measuring cycles during which a measured value must be free of
errors before the value is signaled as good. This option can be used for suppressing loose
contacts.

10
Pt100 scan rate box (with internal CJC only)

This field is only visible if you select "Internal cold reference junction compensation” from
the Measuring method drop-down list.

Specify how frequently the cold reference junction compensation temperature should be
measured (in relation to the actual thermocouple measurement). The entry is effective for
the duration of the measuring cycle: The more frequently the cold reference junction
compensation temperature is measured, the longer a measuring cycle lasts.

Example: If you specify the ratio 1:20, the cold reference junction compensation
temperature is measured after every twentieth thermocouple measurement.
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1

Measuring method drop-down list

Preset the measuring method you wish to use. Select between internal and external
reference junction. Refer to the LB/FB Remote I/O hardware manuals for more detailed

information.

12

Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.

13

Line resistance or External reference junction box

Enter either the line resistance (internal reference junction) or the thermostat temperature
(external reference junction) in this box, depending on the Measuring method selected

(see section above).

Line resistance: For an internal reference junction, enter the resistance value of the spur so
that the measurement error can be compensated.
External reference junction: For an external reference junction, enter the thermostat

temperature (e.g. 50 °C).
14

Sensor drop-down list

Select the sensor. Depending on the sensor, the correct linearization is automatically
used.. The following table lists the sensors that can be used together with the temperature

input

Sensor Beginning of range (min.) End of range (max.)
mV -75 mV 75 mV
U -200°C 600 °C
B 0°C 1820 °C
E -270 °C 1000 °C
T -270 °C 400 °C
K -200 °C 1370 °C
S 0°C 1760 °C
R -200 °C 900 °C
L -50 °C 1760 °C
J -210 °C 1200 °C
N -210 °C 1200 °C
Pallaplat -100 °C 1300 °C
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15

Line filter option

Select the right line filter to compensate for system-related interference (50 Hz and 60 Hz).

16
Temperature in option

This option is not available if you have selected "mV" under Sensor.
Select the temperature unit you wish to enter and display the beginning and the end of the
measuring range (°C or °F).

17
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ 0
min. valug in Bits ]
maz. valug in Bits E0000

Substitute Values

Analog¥alusin % W with Status
’D_@ ™ break \@
¥ | Diatz iy

Simulation Yalues

AnalogWalue in % [V with Status
’U_® I break \@
¥ Data invalid

’Tl Cancel I

Figure 8.52: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

D G b WON =
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Explanations:
1
Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.

4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.
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Configuring 1/0 modules

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all /O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

8.12.7 Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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Configuring strain gage measurement

The I/0 modules 5x02 and 4x01 can be interconnected for strain gage readings. Use the
4x01 analog output to produce a constant current, and the measurement input of the 5x02
temperature input to process the millivolt signal from the voltage generated across the
bridge. The measured value is tranmitted to the PLC or process control system via the
fieldbus.

A constant current of 20 mA is suitable for supplying a 350 Q bridge. This produces a
bridge voltage of 7 V. If the bridge sensitivity is 2 mV/V, then the full-load voltage is 14 mV.

Configuring I/O modules for strain gage measurement

Prerequisite: You have already created a project file in the configuration software. This
project file is open and the tree structure contains a Com Unit and the I/O modules 4x01
and 5x02. Communication with the remote 1/O station is working properly.

1. Either set
the operating mode of analog output 4x01 to "Simulation" (Device data > Operating
mode drop-down list) and set 20 mA as the simulation value (click the Extended button)
or
set a fixed value of 20 mA via the fieldbus.

2. Set temperature input 5x02 to millivolt measurements "mV" (Device data > Sensor
drop-down list).

3. For temperature input 5x02, select "external reference junction" (Device data >
Measuring method drop-down list ).

4. Deactivate reference junction compensation on temperature input 5x02 by setting the
thermostat temperature of the external reference junction to 0 °C (Device data > Ext.
reference junction box).

5X02 Bus

4X01

Figure 8.53: Example: Strain gage bridge
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8.13 LB/FB 5x04 temperature input

B 545
B354

7 8 9 10 11 12 13 14 15 16
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I
Ch.1
Ch.2
Ch.3
Ch.4

1

COM

Figure 8.54: Connection diagram 5x04
e Connect slide-wire sensors in a 2-wire configuration to terminals 1 and 4, 5 and 8, 9 and
12, 13 and 16.

¢ Connect slide-wire sensors in a 3-wire configuration to terminals 1/3/4, 5/7/8, 9/11/12,
and 13/15/16.

* Connect Pt100 sensors in a 2, 3, and 4-wire configuration as shown in the illustration.

The signal converter is the interface between process signals from Pt100 sensors in a 2, 3,
or 4-wire configuration and the process control system or PLC. Slide-wire sensors up to
10000 Q can also be connected.

Versions
e LB 5004, not intrinsically safe

* LB 5104, intrinsically safe
e FB 5204, intrinsically safe

200180 2009-08
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Features
¢ Module width: 2 slots
¢ 4 channels
* Resistive sensor measuring ranges:
¢ Pt100: 18 Q ... 390 3, max. 500 Q including line resistance
e P1200:37Q...780 Q
e Pt500:92 Q... 1952 Q
e Pt1000: 185 Q2 ... 3905 O
¢ Ni100: 69 Q... 270 Q
¢ Ni500: 345 Q... 1350 Q
¢ Ni1000: 690 Q ... 2700 Q
* Slide-wire sensor: 0 Q2 ... 10000 Q
* Smallest span: 50 Q or 1/10 of the final value for 0.1% accuracy
¢ Maximum line resistance: 50 Q
e Temperature effect: 0.025% of the maximum span /10 K
* Linearity error: 0.025% of the maximum span
e Sensor current: 220 pA

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Temperatures within a range of -200 °C to 850 °C are detected with a resolution of 16 bits.
The actual measurement range is calculated based on this resolution.

For the smallest range (0 to 100%), a resolution of 2500 measurement points is obtained,
which corresponds to 0.04 %.

Measuring time and cycle time

The internal module processing times depend on the preset measuring process:

¢ 120 ms per active channel or 480 ms for all 4 channels;
* 240 ms for converting the signals of a resistive sensor channel in a 3-wire configuration.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time. It takes 4 x 6.25 ms = 25 ms until the values of all 4 channels are present in the Com
Unit because the values are transferred one after the other. This time must be added to the
AD conversion time.

A filter is available for smoothing the input signals.

It can take 15 s after downloading a configuration before the I/O module parameters are
applied.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

In the cyclic data exchange process, data is communicated in the same order as the
channels (channel 1, channel 2, etc.).

Note!
Dual-width 1/0 module

Dual-width I/0O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).
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The DP configuration code of the temperature input is 53.

Device function - bit assignment in the data telegram

Temperature inputs 5x04/5x05
Byte Bit | Meaning
Input byte 1 0 Empty
(low byte) 1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value channel 1 (12 bit)
5
6
7
Input byte 2 0-7
(high byte)
Same structure for channels 2, 3, and 4. The 4 channels are spread over 2 slots (the 1/0
modules is twice as wide); total of 8 input bytes
Output bytes Without output bytes
[Table 8.13: Device function - bit assignment in the data telegram

Line fault detection

The device has a line fault detection function that can distinguish between a lead breakage
(resistance > 1 kQ at Pt100) and short circuit (resistance < 10 Q at Pt100). Line fault
detection can be switched off via software.

The broken-wire delay function prevents measured values from being enabled after a line
fault occurs so as to avoid constant toggling between OK/fault if there is a loose contact.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.
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PROFIBUS COM UNIT

Configuring 1/0 modules

Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

Device Data
| Ok I

Load
Module/Typpe 5004 | [BTD - Converter, 4 Ch
Module active v ’h Cancel | Save
Slat: |2'I
Modul - TAG-No.; |LB-5004 Hep | iR

Channel 1 |Channe| 2| Channel 3| Channel 4 |

TAGMo.| )
— Analog- hput-
operating mode; Sealing in Bits (0...65535) Lire fault detection
INormaI ( : E with status W @ v on
error mode:

Icunent value ( : EI begin of range: | 10000~ LFD delay: I‘ID cpcles
Extended..g : ) full scale: I5UUUE_:_v{

(s

i~ Transmitter Settings

FT-100
Lo

- method of meas.:

- rarge: fram |E|.E|E| i 1 3 " - line fiker[Hz]:

- engineering unit:. ‘T

= ZENE0r

=
Bl 14
e

Femarks:

Figure 8.55: Temperature input 5x04: Device data window

Measuring point data area + buttons

TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists (scaling)
Line fault detection check box

LFD-delay box

Measuring method drop-down list

Start of range/End of range boxes (physical unit)
Line resistance box

Sensor drop-down list

Line filter option

Temperature unit option

Note box
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
LFD-delay box

This field only appears if you have activated Line fault detection.

Specify the number of measuring cycles during which a measured value must be free of
errors before the value is signaled as good. This option can be used for suppressing loose
contacts.

10
Measuring method drop-down list

Set the measuring method currently in use and select between a 2, 3, and 4-wire
configuration. If you select the 2-wire configuration, enter the line resistance in the Line
resistance box.

11
Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.
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12
Line resistance box

This box only appears if you have preset a 2-wire configuration under Measuring method
(see paragraph above).

Enter the resistance value of the spur to compensate for measurement errors. Refer to the
hardware manuals for the LB/FB Remote I/O bus systems for information on how to
measure the line resistance.

13
Sensor drop-down list

Select the sensor. Depending on the sensor, the correct linearization is automatically
used.. The following table lists the sensors that can be used together with the temperature
input

Sensor Beginning of range (min.) End of range (max.)
Resistance 0Q 10000 Q

Pt100, Pt200, Pt500, -200 °C 850 °C

Pt1000

Ni100, Ni500, Ni1000 -70°C 230 °C

14

Line filter option

Select the right line filter to compensate for system-related interference (50 Hz and 60 Hz).
15

Temperature in option

This option can only be edited if you have selected a Ptxxx or Nixxx sensor under Sensor.
Select the temperature unit in which you wish to enter the beginning and the end of the
measuring range and display the measured value (°C or °F).

16
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
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Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.56: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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8.14 LB/FB 5x05 temperature input
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Figure 8.57: Connection diagram 5x05
e Connect the thermocouples or millivolt sources to terminals 1 and 2, 5 and 6, 9 and 10
as well as 13 and 14.

¢ Aninternal reference junction (CJC) inside the I/O module measures the temperature at
the terminals.

The signal converter is the interface between process signals from thermocouples and the
process control system or PLC. Millivolt signals can also be connected to the module.

Versions

e LB 5005, not intrinsically safe
e LB 5105, intrinsically safe

e FB 5205, intrinsically safe

200180 2009-08
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Features

¢ Module width: 2 slots

* 4 channels

¢ Measurement range: -75 mV ... +75 mV without LFD

¢ Measurement range: -65 mV ... +75 mV with LFD

¢ Smallest span: 5 mV for 0.1% accuracy

e Thermocouple types: U, B, E, T, K, S, R, L, J, N, and Pallaplat.
¢ CJC internal or external (thermostat)

e Line fault: > 1 kQ

¢ Linearity error: 0.01% (0 mV ... 50 mV)

¢ Temperature coefficient: 0.02% / 10 K (0 mV ... 50 mV)

Refer to the corresponding data sheet and operating instructions for further information.

Resolution

Temperatures within a range of -200 °C to 1850 °C are detected with a resolution of 16 bits.
The actual measurement range is calculated based on this resolution.

For the smallest range of 5 mV (0 to 100 %), a resolution of 2500 measurement points is
obtained, which corresponds to 0.04 %.

All conventional thermocouple curves and Pallaplat are linearized.

Measuring time and cycle time

The internal module processing times depend on the preset measuring process:

e 200 ms for all 4 channels without line fault detection (int./ext. reference junction),
e 350 ms for all 4 channels with line fault detection (int./ext. reference junction).

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time. It takes 4 x 6.25 ms = 25 ms until the values of all 4 channels are present in the Com
Unit because the values are transferred one after the other. This time must be added to the
AD conversion time.

A filter is available for smoothing the input signals.
Data transfer
Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
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and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The 4 bits of the lowest
order are of little importance for the accuracy of the measured value, which is why they are
used for transferring status information.

If the scale does not fall within a range from 10000 to 50000, the status information is
omitted.

In the cyclic data exchange process, data is communicated in the same order as the
channels (channel 1, channel 2, etc.).

Note!
Dual-width 1/0 module

Dual-width I/0 modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote I/O station (see chapter 6.6.2).

The DP configuration code of the temperature input is 53.

Device function - bit assignment in the data telegram

Temperature inputs 5x04/5x05

Byte Bit | Meaning
Input byte 1 0 Empty
(low byte) 1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Empty
3 Empty
4 Measured value channel 1 (12 bit)
5
6
7
Input byte 2 0-7
(high byte)
Same structure for channels 2, 3, and 4. The 4 channels are spread over 2 slots (the 1/0
modules is twice as wide); total of 8 input bytes
Output bytes Without output bytes

[Table 8.14: Device function - bit assignment in the data telegram
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Line fault detection

The device has a line fault detection function for detecting lead breakages. Line fault
detection can be switched off via software.

The broken-wire delay function prevents measured values from being enabled after a line
fault occurs so as to avoid constant toggling between OK/fault e.g. if there is a loose
contact.

¢ With external CJC: 0 ... 250 x 160 ms
¢ With internal CJC: 0 ... 250 x 240 ms.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0O modules.

If this feature was preset in the device data of the Com Unit, an I/0 module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).

The error bit in the low byte has practically no effect on the measured value. Suitable
drivers in the master can evaluate the diagnostic bits.
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Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

Module Data: Thermocouple Transmitter LB-5105

- Device Data

' oK | Load
Module/Type| 5105 [TCAm - Canverter Ew. 4 Ch |
Module active v @ Cancel ‘ Save
Slot: ]9
Modul - TAGNa- |LB-G105 Help ‘ Reset

Channel 1 ]Ehannel2] Chanrel 3] Ehannel4]

TAG-No.:| @

Analog- rnput
operating mode: Secaling in Bits (0. 65535) Line fault detection-
Mormal 1 : i' with status W @ [V on
ermor mode:; LFD delay: 10 cycle@

current value ( : EV begin of rangs: | 100 bl
full scale: SDE
Extended.! : ) 2 =z
— Transmitter Settings

- methode of meas.; | extemal CIC ‘ - senzar; IK ( : ) =
- range: fram iEI.EIEI °E@o 10000 °C
-CIC: 0.00 °@ - ehgineening units: "C iE

Remarks: [ @

Figure 8.58: Temperature input 5x05: Device data window

Measuring point data area + buttons

TAG No. box

Operating mode drop-down list

Error mode drop-down list

Extended button

With statuscheck box

Start of range/End of range drop-down lists (scaling)
Line fault detection check box

LFD-delay box

Measuring method drop-down list

Start of range/End of range boxes (physical unit)
External reference junction box (for external CJC only)
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.
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5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8
Line fault detection check box

Enable Line fault detection to monitor the connection at the field end. In the event of a
fault (lead breakage or short circuit), a diagnosis is transmitted and the substitute value
strategy preset in the Error mode drop-down list is initiated.

9
LFD-delay box

This field only appears if you have activated Line fault detection.

Specify the number of measuring cycles during which a measured value must be free of
errors before the value is signaled as good. This option can be used for suppressing loose
contacts.
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10

Measuring method drop-down list

Preset the measuring method you wish to use. Select between internal and external
reference junction. Refer to the LB/FB Remote I/O hardware manuals for more detailed
information.

11
Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.

Note!

Internal reference junction already fitted

10

The reference junction on I/O modules 5x05 is installed permanently and measures the
temperature at the terminals inside the I/O module.

12
External reference junction box (for external CJC only)

This field only appears if you have selected "External reference junction" under Measuring
method.
Enter the thermostat temperature of an external reference junction (e.g. 50 °C).

200180 2009-08
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13
Sensor drop-down list

Select the sensor. Depending on the sensor, the correct linearization is automatically
used.. The following table lists the sensors that can be used together with the temperature
input

Sensor Beginning of range (min.) End of range (max.)
mV -70 mV 70 mV
U -200 °C 600 °C
B 0°C 1820 °C
E -270 °C 1000 °C
T -270 °C 400 °C
K -200 °C 1370 °C
S 0°C 1760 °C
R -200 °C 900 °C
L -50 °C 1760 °C
J -210 °C 1200 °C
N -210 °C 1200 °C
Pallaplat -100 °C 1300 °C
14

Temperature in option

This option is not available if you have selected "mV" under Sensor.
Select the temperature unit you wish to enter and display the beginning and the end of the
measuring range (°C or °F).

15
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
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Figure 8.59: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)
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Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.
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4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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8.15 LB/FB 5x06 voltage input

1 2 3 4 5
OOOO_'ii

6
=

e

COM

Figure 8.60: Connection diagram 5x06

* Connect the voltage source to terminals 5 (+) and 6 (-).

The voltage input is the interface between process signals from DC voltage transmitters
and the process control system or PLC.

Versions

e LB 5006, not intrinsically safe
e LB 5106, intrinsically safe

e FB 5206, intrinsically safe

Features

* Module width: 1 slot

* 1 channel

* Measurementrange:0V ... 10V
e Smallest span: 100 mV

e Linearity error: 0,1%

* Input resistance: 100 kQ

Refer to the corresponding data sheet and operating instructions for further information.

8.15.1 Resolution

Voltages within a range of 0 V ... 10 V are detected with a resolution of 16 bits. The actual
measurement range is calculated based on this resolution.

For the smallest range of 100 mV (0 to 100%), a resolution of 2500 measurement points is
obtained, which corresponds to a degree of accuracy of 0.04 %.
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2 Measuring time and cycle time

The internal module processing time is 100 ms.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time. A filter is available for smoothing the input signals.

3 Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The process data for each channel is transferred in whole numbers without a prefix within a
range from O ... 65535.

A 16-bit word is available for transferring data to each channel. The most important 12 bits
are used.

The DP configuration code of the temperature input is 50.

Device function - bit assignment in the data telegram

Temperature input 5x06

Byte Bit | Meaning

Input byte 1 Empty

(low byte) Empty

Empty

Empty

Measured value (12 bit)

N O O | W N = O

?
N

Input byte 2
(high byte)

Output bytes Without output bytes

[Table 8.15: Device function - bit assignment in the data telegram

Line fault detection

The "Line fault detection" function is not supported.
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Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

tModule Data: Yoltage Transmitter LB-5006

i~ Device Data

Module/Type: G006 | [Waoltage-Corverter

Module active v

Slat: E?_

Modul - TAG-Na.: |LB-5005

Channel 1 ]

TaG-No.| @

Sealing in Bitz [0...65535)
Mormal 1:E with statuz v @
ermor mode;

curent value  ( : E begin of range:jwmi_\:'
EHandBd..[ ‘/\ full scale: 500

= Tranzmitter Settings

-range; from  |0.00 \r"olto 1000 Waolt

Analog- nput

operating mode:

Lime fault detection-

-line fikerHz): &+ &0 EBO @

Remarks:

Figure 8.61: Temperature input 5x06: Device data window

Measuring point data area + buttons
TAG No. box

Operating mode drop-down list
Error mode drop-down list

With statuscheck box

Start of range/End of range drop-down lists (scaling)
Start of range/End of range boxes (physical unit)

Line filter option

1

2

3

4

5 Extended button
6

7

8

9

10 Note box
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the

section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
2
TAG No. box

Enter a unique name for the channel (maximum 32 characters).

3

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

* "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
4
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

5
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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6
With statuscheck box

If you activate With status, status information is transferred in the data telegram. If the
measurement range has been scaled differently from the default setting, status information
will not be transferred.

7
Start of range/End of range drop-down lists (scaling)

Define scaling for the measured values (16-bit value range 0 ... 65535). In Start of range,
enter the value that is to correspond to 0% (default setting: 0% = 10000). In End of range
enter the value that is to correspond to 100% (default setting: 100% = 50000).

For more details, see the section “Measured value processing” (see chapter 7.4).

In the Transmitter settings area, enter the start of range and end of range accordingly in
physical units.

8

Start of range/End of range boxes (physical unit)

Specify the start of range and end of range in the indicated physical unit.

9

Line filter option

Select the right line filter to compensate for system-related interference (50 Hz and 60 Hz).
10

Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

I3 PEPPERL+FUCHS
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Extended parameters window

Extended Parameter Set for Analog Channels

Analog Filker in %/sec @ o
min. walue in Bits 1]
miat, valug in Bits E0000

Substitute Values -

Analog Walusin % W with Status
’D_® ™ bieak \@
Dtz i

Simulation Yalugs

AnalogWalug in % W with Status:
0 I~ break \@
v Data invalid

’Tl Cancel I

Figure 8.62: Extended parameters window with additional channel settings

Analog filter box

Min./max. transmitted value box

Analog value as % box (substitute value)
With status check box (substitute value)
Analog value as % box (simulation value)
With status check box (simulation value)

O g b WON =

Explanations:

Analog filter box

The analog filter for damping the signal can be activated if the input signals fluctuate.
Enter a value in % for defining the rate of change of the input value for each second. The
measurement range is used as the reference value (characteristic: ramp, linear). Enter the
value "0" here to deactivate the filter.

2
Min./max. transmitted value boxes

Specify the smallest/largest values to be transmitted (0 ... 65535). Specify the lower limit in
the Min. transmitted value box and the upper limit in the Max. transmitted value box.
The values for start of range and end of range are within this range.

3
Analog value in % box (substitute value)

Enter a substitute value in % relating to the measurement range (-25% ... 125%). The
substitute value is transferred when an error occurs and you have selected "Substitute
value" from the Error mode drop-down list.

200180 2009-08

I3 PEPPERL+FUCHS 259



8.15.7

260

4
With status check box (substitute value)

Specify whether status information should be transmitted with the substitute value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0 module).

Lead breakage: Transfers information on line fault detection with the substitute value; not
available for all I/O modules.

Invalid data: Transfers the substitute value with an "Invalid data" identifier. It makes sense
to select the "Invalid data" status, as an error occurs when the substitute value is
transferred.

5
Analog value in % box (simulation value)

Enter a simulation value in % relating to the measurement range (-25% ... 125%). The
simulation value is transferred if you have selected "Simulation" from the Operating mode
drop-down list.

6
With status check box (simulation value)

Specify whether status information should be transmitted with the simulation value. If you
activate With status, further check boxes will become available, which you can use to
(de)activate the following status information (depending on the 1/0O module).

Lead breakage: Transfers information on line fault detection with the simulation value; not
available for all I/O modules.

Invalid data: Transfers the simulation value with an "Invalid data" identifier. If you select
Invalid data, the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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8.16.1
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LB/FB 6x01 relay output

B
ES(S

w-;)—ll'
711 0

Figure 8.63: Connection diagram 6x01

The relay output can be used to control floating contacts in the process control system or
the PLC and is suitable for the following application examples:

e Controlling lamps or acoustic sensors,

e Switching Ex-d valves or contactors.

Versions
e LB 6101, not intrinsically safe
e FB 6301, Exe

Features

* Module width: 1 slot

e 2 channels, not intrinsically safe

* One change-over contact per channel
* Switching capacity: 24 V DC/AC/1 A
* Resistive load: 30 W/30 VA

* Max. voltage 30 V DC/AC

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The response time of the relay output is 20 ms. This time depends on the cycle time of the
data traffic in the Profibus.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

The DP configuration code of the relay output is 20.

Device function - bit assignment in the data telegram

Relay output 6x01

Byte Bit | Meaning

Input bytes Without input bytes

Output byte 1 Output channel 1

Output channel 2

Empty
Empty
Empty
Empty
Empty
Empty

N| O O | W N = O

[Table 8.16: Device function - bit assignment in the data telegram

Line fault detection

The "Line fault detection" function is not supported.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0 module error appears in
the module status register and the global status register.
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8.16.5 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

-~ Device Data
o ok I Load Reset
Module/Type: [E107 ] [Felay. 2Ch ] |
Aetive v ﬁ Cancel | Save |
Slot: |3
TaGMNo:  |LB-E101 Help |
— Drigital Outputs -
TAG-No. Kanal: ‘energize on operating mode: error mode: a2 faL[JII_tI-EIDs]tection
01
Output 1 [K0): 97 MNormal | | substit lue +
_ | (2) [Nomal 7N =] ] e
Dutput 2 (K1) I 2/ INormaIv LI Isubstitu e *

Remarks: @

Figure 8.64: Digital input 6x01: Device data window

Measuring point data area + buttons
TAG No. channel box

Set output with option

Operating mode drop-down list
Error mode drop-down list

Extended button

Note box

N o a s ON =

Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements" (see chapter 7.2.2).

2
TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
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3

Set output with option

This option is not available for relay output 6x01.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

7
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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DN delay in ms
OFF delay in ms

i~ Substitute Walues
Data: &+ 0 Status

¢ N

— Simulation Values
Data: (+ g Status:

il

o
OO -

Ok I Cancel |

Figure 8.65: Digital channel window with additional channel settings

ON delay box

OFF delay box
Substitute value area
Simulation value area

B WODN =

Explanations:
1
ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).

e
. n

Figure 8.66: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
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3
Substitute value area
Define a substitute value for when there is a fault. Select a substitute value of either 0 or 1.
4

Simulation value area

Define the simulation value. The simulation value is transferred if you have selected
"Simulation" operating mode. Select a simulation value of either 0 or 1.

8.16.6 Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display.” (see chapter 7.3).
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LB/FB 6x05 relay output
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Figure 8.67: Connection diagram 6x05

The relay output can be used to control floating contacts in the process control system or
the PLC and is suitable for the following application examples:

e Controlling lamps or acoustic sensors,

e Switching Ex-d valves or contactors.

Versions
e LB 6005, not intrinsically safe
* FB 6305, Ex-e

Features

* Module width: 2 slots

* 4 channels, not intrinsically safe

* One change-over contact per channel

¢ Switching capacity: 24 VDC/230VAC/1 A
* Resistive load: 30 W /30 VA

* Max. voltage 30 V DC /253 V AC

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The response time of the relay output is 20 ms. This time depends on the cycle time of the

data traffic in the Profibus.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

Input and output data

The I/O module has input and output data (see table).

The output data sets the control outputs and marks the data as valid/invalid. As soon as the
"Data invalid" bit is enabled, the preconfigured substitute values are used (see section
below "Editing device data").

The input data allows the master to retrieve the current output status, which is particularly
useful if the input or output delay is activated (see section below "Editing device data"). The
output only reaches the required status once the preset time has elapsed so the master
can retrieve the current output status.

Note!
Dual-width 1/0 module

Dual-width I/0O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).
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The DP configuration code of the relay output is 30.

Device function - bit assignment in the data telegram

Relay output 6x05

Byte

Bit

Meaning

Input byte 1

Output status channel 1

Empty

Output status channel 2

Empty

Output status channel 3

Empty

Output status channel 4

Empty

Output byte 1

Output channel 1

Channel 1 = 0 enabled, 1 = invalid

Output channel 2

Channel 2 = 0 enabled, 1 = invalid

Output channel 3

Channel 3 = 0 enabled, 1 = invalid

Output channel 4

N O O A W N =[O N O O Al W N =O

Channel 4 = 0 enabled, 1 = invalid

[Table 8.17: Device function - bit assignment in the data telegram

Line fault detection

The "Line fault detection" function is not supported.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive

diagnosis of the overall Remote I/O station and the 1/0 modules.

If this feature was preset in the device data of the Com Unit, an I/0O module error appears in

the module status register and the global status register.
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8.17.5 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

-~ Device Dat

) ok I Load Reset
Module/Type: [E005 ] [Relay, # Ch Z30VAC ] |

Aetive v ?\ Cancel | Save |

Slot: |4 —

TAGHNo:  |LE-5005 Help |
- Digital Outputs -

X . : X _ line fault detection
TAG-No. Kanal: energize on operating made: error mode: 1LFD]
01

Output 1 (KO): I O INormaI ;I Isubstituted value;l Ektended...l
Output 2 K1) I (2\ INorma(4\ LI Isubstit(5¥lued Ex...
Output 3 (K2} | . INormaI LI substitukn/valueil Exterméd...
Output 4 [K.3); I 0 INormaI LI substituted valuell Extended...

Remarks: @

Figure 8.68: Digital input 6x05: Device data window

Measuring point data area + buttons
TAG No. channel box

Set output with option

Operating mode drop-down list
Error mode drop-down list

Extended button

Note box

N O O hs WODN =

Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements" (see chapter 7.2.2).

2
TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
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3

Set output with option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

7
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.
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Digital channel window

3
OM delay in ms ID _|::
OFF delay in ms IU 3:
-~ Subslitute Values

Data: & 0 Status  Doa 0k
-l & Data invalid

- Simulation Yalues
Dats: + 0 Statuss " DataDK
1 & Datainvalid

Ok I Cancel

Figure 8.69: Digital channel window with additional channel settings

1 ON delay box

2 OFF delay box

3 Substitute value area
4 Simulation value area
Explanations:

1

ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).
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Figure 8.70: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

¢ Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

» Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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8.18 LB/FB 6x06 relay output
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Figure 8.71: Connection diagram 6x06

The relay output can be used to control floating contacts in the process control system or
the PLC and is suitable for the following application examples:

e Controlling lamps or acoustic sensors,

e Switching Ex-d valves or contactors.

Versions
e LB 6006, not intrinsically safe
* FB 6306, Ex-e

Features

* Module width: 2 slots

* 8 channels, not intrinsically safe

* One N.O. contact per channel

* Switching capacity: 24 V DC/AC/1 A

* Resistive load: 30 W/30 VA

* Max. voltage 30 V DC

Refer to the corresponding data sheet and operating instructions for further information.

8.18.1 Measuring time and cycle time

The response time of the relay output is 20 ms. This time depends on the cycle time of the
data traffic in the Profibus.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time.
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Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

Input and output data

The I/O module has input and output data (see table).

The output data sets the control outputs and marks the data as valid/invalid. As soon as the
"Data invalid" bit is enabled, the preconfigured substitute values are used (see section
below "Editing device data").

The input data allows the master to retrieve the current output status, which is particularly
useful if the input or output delay is activated (see section below "Editing device data"). The
output only reaches the required status once the preset time has elapsed so the master
can retrieve the current output status.

Note!
Dual-width 1/0 module

Dual-width I/0O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).
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The DP configuration code of the relay output is 31.

Device function - bit assignment in the data telegram

Relay output 6x06

Byte Bit | Meaning

Input byte 1 Output status channel 5

Empty
Output status channel 6

Empty
Output status channel 7

Empty
Output status channel 8

Empty
Output status channel 1

Empty
Output status channel 2

Empty
Output status channel 3

Empty
Output status channel 4

Empty
Output channel 5

Input byte 2

Output byte 1

Channel 5 = 0 enabled, 1 = invalid
Output channel 6
Channel 6 = 0 enabled, 1 = invalid

Output channel 7

Channel 7 = 0 enabled, 1 = invalid
Output channel 8
Channel 8 = 0 enabled, 1 = invalid

Output byte 2 Output channel 1
Channel 1 = 0 enabled, 1 = invalid

Output channel 2

Channel 2 = 0 enabled, 1 = invalid
Output channel 3
Channel 3 = 0 enabled, 1 = invalid
Output channel 4

NI OO WO N =[O NO O WD =[O N[O O WO =O N[O OO | W N =] O

Channel 4 = 0 enabled, 1 = invalid

[Table 8.18: Device function - bit assignment in the data telegram

8.18.3 Line fault detection

The "Line fault detection" function is not supported.
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Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive

diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

Editing device data

Access the Device data window of the I1/O module (see chapter 7.2.1).

_| Geritedaten: Binary Output Type LB-6006
Device Data-
oK | Load Reset

Module/Type: [E00E | [Relay, 8Ch. 24VDC ]

Active v @ Cancel ] Save

Slat: B

TAGNo: |LE-BO0G Help

: Diigital Dutputs
. £ : . _ line fault detection
TAG-Mo. Kanal: energize on operating mode: error mode: (LFD]
o1
Output 1 (K0): | N ]Normal :_J isubstituted value_V_j Extended...J
Output 2 [K1): ] { - JNormaI _V_J 1substituted value_V_] Extended...
Dutput 3(K2) | ® o JNormaI ﬂ 1substituted valuelj Extended...
" - i - B
Output 4 (K3 ] @ @ ]Normalm __J ]substltmlue_J H
Output 5 (K4} | ]Normal L] JsubstitLREn/valueLJ Exterméd...
Dutput 6 (K5} | = |N0rmal L] ]substituted valueL] Extended...i
Dutput 7 (KE): | & |N0rmal _'..J Jsubstituted value__V_i Extended...]
Output & (K7 ] - JNormaI _V_J 1substituted value_v_] Extended...
Remarks: @

Figure 8.72: Digital input 6x06: Device data window

Measuring point data area + buttons
TAG No. channel box

Set output with option

Operating mode drop-down list
Error mode drop-down list

Extended button

Note box

N O g s O =

Explanations:

Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section ""Device data’ window — universal screen elements" (see chapter 7.2.2).
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2

TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).

3

Set output with option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted from the field.

* "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value”,
"Substitute value" and "Last valid value™:

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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7
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

OM delay in ms m
OFF delay in ms Iﬁ
- Substitute Yalues
Data: .0  Statuss  [ata ik i )
@ Datainvald
— Simulation Yalues
Data: Status: (" Data OK
*+ Dala |nva||di

(114 I Cancel

Figure 8.73: Digital channel window with additional channel settings

ON delay box

OFF delay box
Substitute value area
Simulation value area

B WODN =

Explanations:
1
ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).
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Figure 8.74: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

¢ Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

» Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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8.19 LB/FB 6x08 digital output

33| ¥

)
-0
o
-0
o
-0
o
-0
o
-0
o

-9y Q. 9

Figure 8.75: Connection diagram 6x08 with output disable input

The digital output connects lamps (LEDs), acoustic sensors and solenoid valves to the
process control system or the PLC. Contactors can be activated in addition.

Versions

e LB 6008, not intrinsically safe
e LB 6108, intrinsically safe

¢ FB 6208, intrinsically safe

* FB 6308, Exe

Note!

10

Versions are available with and without a bus-independent output disable input. Select the
appropriate version from the catalog. Note which backplane types are compatible with the
different versions. Refer to the LB/FB hardware manuals and the P+F SIL manual for more
detailed information.

Features

¢ Module width: 2 slots

* 8 low voltage channels, intrinsically safe

e Switching capacity: 20 V DC / 8 mA

¢ Line fault detection current: 0.3 mA, when activated

Refer to the corresponding data sheet and operating instructions for further information.

200180 2009-08

I3 PEPPERL+FUCHS 281



8.19.1

8.19.2

282

10

Measuring time and cycle time

The response time of the digital output is 10 ms. This time depends on the cycle time of the
data traffic in the Profibus.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the I/O module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

Input and output data

The I/0 module has input and output data (see table).

The output data sets the control outputs and marks the data as valid/invalid. As soon as the
"Data invalid" bit is enabled, the preconfigured substitute values are used (see section
below "Editing device data").

The input data allows the master to retrieve the current output status, which is particularly
useful if the input or output delay is activated (see section below "Editing device data"). The
output only reaches the required status once the preset time has elapsed so the master
can retrieve the current output status.

Note!
Dual-width 1/0 module

Dual-width I/O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/O module unless it is the last I/O module in a Remote I/O station (see chapter 6.6.2).
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The DP configuration code of the digital output is 31.

Device function - bit assignment in the data telegram

Digital output 6x08

Byte Bit | Meaning
Input byte 1 Output status channel 5
Line fault detection channel 5 (0 = OK, 1 = error)
Output status channel 6
Line fault detection channel 6 (0 = OK, 1 = error)
Output status channel 7
Line fault detection channel 7 (0 = OK, 1 = error)
Output status channel 8
Line fault detection channel 8 (0 = OK, 1 = error)
Input byte 2 Output status channel 1

Line fault detection channel 1 (0 = OK, 1 = error)

Output status channel 2

Line fault detection channel 2 (0 = OK, 1 = error)

Output status channel 3

Line fault detection channel 3 (0 = OK, 1 = error)

Output status channel 4

Line fault detection channel 4 (0 = OK, 1 = error)

Output byte 1

Output channel 5

Channel 5 = 0 enabled, 1 = invalid

Output channel 6

Channel 6 = 0 enabled, 1 = invalid

Output channel 7

Channel 7 = 0 enabled, 1 = invalid

Output channel 8

Channel 8 = 0 enabled, 1 = invalid

Output byte 2

Output channel 1

Channel 1 = 0 enabled, 1 = invalid

Output channel 2

Channel 2 = 0 enabled, 1 = invalid

Output channel 3

Channel 3 = 0 enabled, 1 = invalid

Output channel 4

NI OO WO N =[O NO O WD =[O N[O O WO =O N[O OO | W N =] O

Channel 4 = 0 enabled, 1 = invalid

[Table 8.19: Device function - bit assignment in the data telegram

Line fault detection

The device has a function for line fault detection that can detect lead breakages and short
circuits. Line fault detection can be switched off via software. The circuit is monitored by a

test current that is low enough not to activate a connected valve.
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Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive

diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in

the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels

(specifying the slot, channel, input/output ID, reason for fault).

Editing device data

Access the Device data window of the /0O module (see chapter 7.2.1).

_| Geritedaten: Binary Output Type LB-6008
Device Data-
ok | Load Reset
Module/Type: [E008 ] [Active Output, 8Ch ] ‘
Active v @ Cancel ] Save ‘
Slat: g
TAGNo: |LB-BO0E Help
Digital Dutputs
TAGN . £ : § _ line fault detection
Mo, Kanal: energize on operating mode: error mode: (LFD]
o1
Output 1 (K0} | [ ]Normal _:J {substituted value_:_j I’ Extended...
Output 2 [K1): ] o o |N0rmal _V_J 1substituted value_V_] v Extended...
Dutput 3(K2) | ® o JNormaI Ll 1substituted valuelj ird Extended...
Clutput 4 [K3): ] @ @ ]Norma LJ |substit IueLJ @ 4@_‘
Dutput 5 (K4) | *  |Maomal | |substiuberialue = Esteréd i
Dutput 6 (K5} | = |N0rmal ﬂ ]substituted value_ﬁj ird Extended.. J
Dutput 7 (KEL | & ]Normal __VJ Jsubstituted value__V_i ird Extended.. J
Output & [K7): ] o o lNormaI _V_J 1substituted valueL] ird Extended...
Remarks:

Figure 8.76: Digital output 6x08/6x1x: Device data window

Measuring point data area + buttons
TAG No. channel box

Set output with option

Operating mode drop-down list
Error mode drop-down list

Extended button
Note box

O N O g s WODN =

Short circuit / breakage detection check box
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Explanations:
1
Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section ""Device data’ window — universal screen elements" (see chapter 7.2.2).

2

TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).

3

Set output with option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

¢ "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the /0O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

e "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

e "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

¢ "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.
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6
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

7
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.

8
Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

I3 PEPPERL+FUCHS
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Digital channel window

3
OM delay in ms ID _|::
OFF delay in ms IU 3:
-~ Subslitute Values

Data: & 0 Status  Doa 0k
-l & Data invalid

- Simulation Yalues
Dats: + 0 Statuss " DataDK
1 & Datainvalid

Ok I Cancel

Figure 8.77: Digital channel window with additional channel settings

1 ON delay box

2 OFF delay box

3 Substitute value area
4 Simulation value area
Explanations:

1

ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).
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Figure 8.78: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

¢ Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

» Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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8.20 LB/FB 6x1x digital output
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Figure 8.79: Connection diagram 6x10 - 6x15

1. with output disable input
2. without output disable input

The digital output connects lamps (LEDs), acoustic sensors and solenoid valves to the
process control system or the PLC. Contactors can be activated in addition.

Versions

e LB 611, intrinsically safe (x =0 ... 5)

e FB 621, intrinsically safe (x=0 ... 5)

The electrical data of the various versions is different.

Note!

10

Versions are available with and without a bus-independent output disable input. Select the
appropriate version from the catalog. Note which backplane types are compatible with the
different versions. Refer to the LB/FB hardware manuals and the P+F SIL manual for more
detailed information.
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Features
¢ Module width: 2 slots
* 4 low voltage channels, intrinsically safe

Refer to the corresponding data sheet and operating instructions for further information.

Measuring time and cycle time

The response time of the digital output is 10 ms. This time depends on the cycle time of the
data traffic in the Profibus.

The signals are transmitted to the Com Unit every 6.5 ms irrespective of the measuring
time.

Data transfer

Data is transferred as specified in the Profibus specification.

It is important that the master and slave have the same configuration prior to the data
exchange (DP configuration string). The configuration parameters are stored in the GSD
file.

You can use the DTM on process control systems that support the FDT concept. The DTM
ensures that the master receives all important information about the relevant configuration
and is adapted automatically.

If the process control system does not support the FDT concept, the configuration must be
replicated in the master. If a GSD file is integrated, the correct configuration code is
automatically adopted when the 1/0 module is selected. If the GSD file cannot be
integrated, the configuration parameters must be entered manually (see table below).

Input and output data

The I/0 module has input and output data (see table).

The output data sets the control outputs and marks the data as valid/invalid. As soon as the
"Data invalid" bit is enabled, the preconfigured substitute values are used (see section
below "Editing device data").

The input data allows the master to retrieve the current output status, which is particularly
useful if the input or output delay is activated (see section below "Editing device data"). The
output only reaches the required status once the preset time has elapsed so the master
can retrieve the current output status.

Note!
Dual-width 1/0 module

Dual-width I/O modules occupy 2 slots. Therefore, always configure an empty slot after this
I/0 module unless it is the last I/O module in a Remote 1/O station (see chapter 6.6.2).
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The DP configuration code of the digital output is 30.

Device function - bit assignment in the data telegram

Relay output 6x1x

Byte Bit | Meaning
Input byte 1 0 Output status channel 1

1 Line fault detection channel 1 (0 = OK, 1 = error)
2 Output status channel 2
3 Line fault detection channel 2 (0 = OK, 1 = error)
4 Output status channel 3
5 Line fault detection channel 3 (0 = OK, 1 = error)
6 Output status channel 4
7 Line fault detection channel 4 (0 = OK, 1 = error)

Output byte 1 0 Output channel 1
1 Channel 1 = 0 enabled, 1 = invalid
2 Output channel 2
3 Channel 2 = 0 enabled, 1 = invalid
4 Output channel 3
5 Channel 3 = 0 enabled, 1 = invalid
6 Output channel 4
7 Channel 4 = 0 enabled, 1 = invalid

[Table 8.20: Device function - bit assignment in the data telegram

Line fault detection

The device has a function for line fault detection that can detect lead breakages and short
circuits. Line fault detection can be switched off via software. The circuit is monitored by a
test current that is low enough not to activate a connected valve.

Diagnostics

The Com Unit supports both the DP diagnostics functions (Profibus standard) and the
extended diagnostics functions (manufacturer-specific) to allow the comprehensive
diagnosis of the overall Remote 1/O station and the I/O modules.

If this feature was preset in the device data of the Com Unit, an I/O module error appears in
the module status register and the global status register.

In addition, a channel-related error is displayed if a fault occurs in one of the channels
(specifying the slot, channel, input/output ID, reason for fault).
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8.20.5 Editing device data

Access the Device data window of the I/O module (see chapter 7.2.1).

-~ Device Data
— Ok I Load | Reset

Module/Type: [6008 ] [Active Output, 8Ch ]

Aetive v /h Cancel | Save |

Slot: IS N

TAG-Mo: |LB-500S Help |
-~ Digital Output

TAG-No. Kanal: energize on operating made: error mode: e fault dEtECtIDn
o1

Output 1 (KO): o INormaI j Isubstituted valuej Extended...
Output 2 [K1]: o« INormaI LI Isubstituted valueLI Extended...
Output 3 (K2]: (ol O INormaI substituted value:l Extended...

Lelled

4

LE@M

| v

| i

| W
Output 4 (K3): I @ @ INorma - substit IueLI @
Dutput 5 (K4] I Q INormaI : l Isubstitu;value v.l Exte)

| i

|

|

Output & K5): (S C INormaI LI Isubstituted valueLI Extended...
Output 7 KB & INomal LI substituted valueLI v Extended...
Dutput 8 [K7): & | Momal LI substituted valueLI ird Extended...

Remarks: |

Figure 8.80: Digital output 6x08/6x1x: Device data window

Measuring point data area + buttons

TAG No. channel box

Set output with option

Operating mode drop-down list

Error mode drop-down list

Short circuit / breakage detection check box
Extended button

Note box

00 N O s WDN =

Explanations:

Measuring point data area + buttons

This area is identical for all I/O modules. A description of this area can be found in the
section "'Device data’ window — universal screen elements" (see chapter 7.2.2).

2
TAG No. channel box

Enter a unique name for the channel (maximum 32 characters).
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3

Set output with option

Choose between positive or negative logic for the digital signal.

4

Operating mode drop-down list

Select either "Normal" (normal mode) or "Simulation" (simulation mode):

e "Normal": In normal mode, the signal is transmitted from the field.

e "Simulation": A signal is simulated in simulation mode. The signal is preset in a separate
window that you can open by pressing the Extended button.

See section "Operating mode and error mode" (see chapter 7.6) for more details.
5
Error mode drop-down list

Preset how the I/O module responds in the event of a fault. Select between "Current value",
"Substitute value" and "Last valid value":

* "Current value": The signal is transferred unchanged in spite of the error (the signal may
be a simulated signal).

* "Substitute value": A substitute value is transferred. The substitute value is preset
manually in a separate window that you can open by pressing the Extended button.

e "Last valid value": The last value that was valid before the fault occurred is transferred.

See section "Operating mode and error mode" (see chapter 7.6) for more details on error
mode.

6
Short circuit / breakage detection check box

Enable line fault detection to monitor the connection at the field end. In the event of a fault
(lead breakage or short circuit), a diagnosis is transmitted and the substitute value strategy
preset in the Error mode drop-down list is initiated.

The line fault detection function is only available for NAMUR signals. On contact inputs
without a NAMUR shunt resistor, the connection at the field end cannot be monitored.

7
Extended button

Pressing this button opens a window containing more channel settings for the "Operating
mode" (simulation value) and "Error mode" (substitute value) function modes. The following
illustration displays the window in more detail.
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8

Note box

Enter a comment of your choice here with a maximum of 256 characters. The comment is
only stored in the database, storing the comment in the device is not possible. The
comment applies for the entire I/O module and also appears on the other tabs in the
window.

Digital channel window

ON delay in ms m
OFF delay in ms Iﬁ
- Substitute Yalues
Data: .0  Statuss  [ata ik i )
@ Datainvald
— Simulation Yalues
Data: Status: (" Data OK
*+ Dala |nva||di

(114 I Cancel

Figure 8.81: Digital channel window with additional channel settings

ON delay box

OFF delay box
Substitute value area
Simulation value area

B WODN =

Explanations:
1
ON delay box

Enter a value in ms to delay the transfer of a signal change from 0 to 1. Use the ON delay to
filter out brief disturbing pulses (contact bounce) (see illustration below).

2
OFF delay box

Enter a value in ms to delay the transfer of a signal change from 1 to 0. Use the OFF delay
to extend short pulses. In this way, even extremely short signals from the fieldbus cycle can
be detected (e.g. go-devil control) (see illustration below).
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Figure 8.82: ON and OFF delay

1 ON delay: The ON delay function is deactivated in the top half of the illustration and ac-

tivated in the bottom half (short signals are filtered out).
2 OFF delay: The OFF delay function is deactivated in the top half of the illustration and

activated in the bottom half (short signals are extended).
3
Substitute value area
Define a substitute value for when there is a fault.

¢ Data: Select a substitute value of either 0 or 1.

¢ Status: Define the status with which the substitute value should be transferred ("Data
OK" or "Invalid data"). It makes sense to select the "Invalid data" status, as an error
occurs when the substitute value is transferred.

4
Simulation value area

Define the simulation value and the status of the value. The simulation value is transferred
if you have selected "Simulation" operating mode.

¢ Data: Select a simulation value of either 0 or 1.

» Status: Select between the status "Data OK" and "Invalid data". If you select "Invalid
data", the substitute value strategy is initiated.

Using the measured value display

The measured value display is used to display measured values and status information.
Find out how to access the measured value display and the significance of the information
it contains in the section "Accessing the measured value display." (see chapter 7.3).
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9 Troubleshooting
9.1 Service call

Before booking a service call, please check that the following actions have been taken:

¢ the customer has consulted the Service Center by phone to locate the problem,
¢ the customer has tested the installation against the checklists below,

* P + F Service staff have performed remote diagnosis using PC ANYWHERE.

200180 2009-08
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Communications error

If there is a communications error, work through the following checklist and take any

relevant action.

Error

Action(s)

Remote I/O station cannot
be found in the
configuration software

e Make sure that no other applications assigned to the
selected port are active. This can be the case, for
example, if you use the HART/SMART software of other

manufacturers and this application was not closed before

you started the remote I/O configuration.

¢ Check that the connection cable between the PC and the

bus stations is properly connected.

* Check that all the settings have been made as described
in this manual.

* The yellow LEDs on the front of the Com Unit must flash
when data is being exchanged.

[Table 9.1: Communications error

Fault

Action(s)

Errors in communication
with the process control
system or PLC

* Check that the cables are connected properly and not
damaged.

* Check in the configuration software that the selected
address matches the required station address.

e Check that the bus termination is enabled. The
PROFIBUS must have exactly 2 bus terminations per
segment, one at the start and one at the end.

* Check whether the bus stations have been connected to
a branch in a star formation - this is not permitted.
Choose a linear arrangement without branches

* Check that the master and slave have matching

configuration strings. The slave address must be identical

for master and slave on the fieldbus.
e Check that the correct GSD file is being used.

Communications error on
the Service bus

¢ Check that the cables are connected properly and not
damaged.

* Check in the configuration software that the selected
address matches the required station address.

¢ Check that the bus termination is enabled. The Service
bus must have exactly 2 bus terminations per segment,
one at the start and one at the end.

* Check whether the bus stations have been connected to
a branch in a star formation - this is not permitted.
Choose a linear arrangement without branches.

* Check that the correct interface is set in the configuration
software.

A new station will not work
on a bus on which other
stations are already
working.

¢ Check whether the bus terminations are still located at
the start and the end of the bus after the extension.

I PEPPERL+FUCHS

297



298

Fault

Action(s)

The software cannot find a
com unit when establishing
communication.

e Check that the yellow LEDs on the com unit come on
when communication is being set up.

* Check that the bus address is in the chosen range. If
necessary, enlarge the search range.

* Check that the com unit is plugged in correctly.

The com unit readout does
not give the expected
configuration.

* The required configuration has not been saved in the
com unit. Select the "Write data to device" menu option to
save the configuration in the com unit.

Communication error on the
service bus after
communication has been
established

* Check that the Service bus is DC isolated.
¢ Use the laptop under battery power.

¢ Use a standard commercial RS232-RS485 interface
converter with automatic detection of baud rate and
transmission direction.

Data missing from station
download

* Check that all the data was previously saved in the
station.

No HART communication

* Check whether the I/0 module used supports the HART
functionality.

* Make sure that the HART field devices are operating in
the permitted range of 4 to 20 mA.

¢ Check that the correct address of the HART device has
been used.

¢ Check that the HART software has a DTM for the field
device used. If not, only HART basic functions are
available.

[Table 9.2: Communications error

Fault

Action(s)

FB extension unit in Zone 1
does not function.

¢ Check whether the wires on the base unit and extension
unit are connected correctly.

¢ On redundant systems, check whether the required
connection between the extension unit and the
redundancy unit exists.

[Table 9.3: Communications error
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Redundancy faults

If there is a redundancy fault, work through the following checklist and take any relevant
action.

Fault Action(s)

Continuous switching ¢ Check that the correct type of redundancy is selected
between redundant systems (line redundancy - application redundancy).

¢ Check that the switchover time been set to a sufficiently
long period in the Com Unit.

e If you are using an FB system in Zone 1, check whether
there is a required front connection between the Com
Units.

* Check that the process control system is configured for
this type of redundancy.

Does not switch to * Check that redundancy has been configured at the Com
redundant system when a Unit.
Com Unit is removed

e Check that there is an electrical connection between the
two Com Units. If not, connect them.

Modules are continuously * Check whether one of the Com Units has not been
changing the data configured for redundancy mode. If this is the case, both
Com Units actively try to access the I/O modules and
interfere with each other.

[Table 9.4: Redundancy faults

Faults indicated by LEDs

A number of LEDs on the com unit, the I/O modules and the power supply help to locate
faults. If the LEDs indicate a fault, work through the following checklist and take any
relevant action.

Incorrect error messages

An open-circuit in the output circuits may be indicated for certain loads, even though the 1/0
module is actually still working perfectly. For example this may happen sometimes with
solenoid valves whose input impedance lies outside the open-circuit detection range. In
this case, connect a large-value resistor in parallel with the output, which normally
improves the situation.

With booster valves, the charging capacitor is often the culprit if the short-circuit detection
activates. Connecting a small-value resistor in series usually rectifies the problem. If
necessary, disable the line fault detection function.

You cannot switch off the red LED on the com unit via the system or via the bus until all the
I/0 modules are working properly again (common alarm). To disable the common alarm,
select the Fault monitor menu option in the configuration software.
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LEDs on the Com Unit

Fault

Action(s)

Red LED on Com Unit is on.

There is a problem with an 1/0 module in one of the slots.

* Scan all slots for I/O modules displaying flashing red
LEDs. All red LEDs must be off, otherwise the Com
Unit will continue to indicate a fault.

Yellow LED on the Com
Unit is flashing without the
bus being connected.

e The Com Unit is operational and working with the 1/0
modules.

Yellow LED on the Com
Unit is flashing at long
intervals.

e The Com Unit is operational and working with the 1/0
modules. At least one I/0O module is in simulation mode
(manual operation).

Yellow LED on Com Unit is
on.

* For FB Com Units: check that the polarity of the Com Unit
wiring is correct.

» Check that a terminator is being used and is enabled.
The Modbus must have exactly 2 terminators per
segment, one at the start and one at the end.

Green LED on Com Unit is
flashing.

e The Com Unit is active. As soon as this Com Unit is
switched off in a redundant system there will be a
redundancy switchover.

 If possible, only remove the Com Unit whose green LED
is permanently on.

Main bus

Yellow LEDs on Com Units
do not flash while
communication is being
established.

* Check that the configuration cable and the adapter are
connected properly.

Service bus

Yellow LEDs on Com Units
do not flash while
communication is being
established on the service
bus.

* Check that the configuration cable and the adapter are
connected properly.

LEDs on I/0O modules and power supplies

Fault

Action(s)

Red LED on an I/O module
illuminated

* Check that the field wiring is connected correctly.
» Check that the sensor is working properly.
* Check that the field devices are working properly.

Red LED on an I/0O module
is flashing.

I/0O module cannot communicate with the Com Unit.

* Check that the I/O module is plugged into the
backplane properly.

* Make sure that none of the pins are bent in the
connector.

¢ Plug a different /0O module into this slot. If the new
module also does not work (red LED flashing), the fault
may lie with the backplane.

I3 PEPPERL+FUCHS
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LEDs on I/O modules and power supplies

Fault

Action(s)

Yellow LEDs on I/O
modules illuminated.

* For digital inputs, the yellow LEDs provide various status
indicators.

e For transmitter supply modules, the yellow LED indicates
that operation is outside the normal range.

Green LEDs on all modules
are off.

¢ Check that the supply is connected to the backplane
correctly.

* Check that the power supply is working and is plugged
into the backplane properly.

Green LED on one module
is off.

* Check that the module is plugged into the backplane
properly.
* If necessary, replace the module.

* If this does not rectify the problem, check that the
backplane is working correctly.

Green LED on power supply
is off.

* Check that the correct voltage is connected to the power
supply unit.

* Check that the power supply is plugged into the
backplane correctly and that it is making contact with the
backplane.

* Check the supply voltage. Under maximum load, the 24
V DC voltage must not drop below 20 V including any
ripple. If necessary, use an oscilloscope (fire permit may
be needed).

¢ The fuse may have blown.
FB: The power supplies do not contain replaceable fuses
and so you will have to replace the power supply with a
new one.
LB: For reasons of explosion protection, the fuses for
power supplies and I/O modules must only be changed
by suitably qualified, specialist personnel. Replace fuses
with fuses of the same value.
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9.5 Signal fault

If there is a signal fault, work through the following checklist and take any relevant action.
Disabled 1/0 modules

Disabled 1/0 modules are often used for future expansions. Before disabling the 1/0
module, switch off its line fault detection function. This stops the I/O module from triggering
an alarm every time the com unit polls the slot to see if an I/O module is installed.

302

Fault

Action(s)

No change in signal when
the parameters are
changed.

¢ Check that the change was saved in the slave station.

* Download the parameter settings to find out the current
parameter settings of the /O module.

* Applicable to PROFIBUS com unit only: Check whether
HCIR is active. If so, the new setting will only come into
force once the master has performed the HCIR
changeover.

Incorrect signal

e Check whether there is a short-circuit or open wire in the
circuit.

* Check that the field devices and sensors are working
correctly.

* Replace the I/0O module.
* Check the bus signal path to the 1/0 module.

All signals in a station are
incorrect.

e Check that the power supply is working correctly.
e Check the bus connection.

* Check bus communication.

* Use a bus monitor.

Output module switches to
substitute values.

* Check the response monitoring time for bus monitoring in
the com unit. The response monitoring time must be
longer than the duration of a bus cycle.

An output module switches
off.

Input module intermittently
fails to supply process
values.

Communication has been lost with the com unit.

* Check that the /O module is plugged into the
backplane properly.

I/0 module works correctly
in one particular slot, but not
in another.

* Check that the connector for the faulty slot is OK and
does not have any bent pins.

* If necessary, stop using the slot.

Process values
intermittently incorrect.

* Check whether external interference may be causing
errors in the process value.

¢ Check that the shielding is intact.

Signal does not change.

¢ Check whether the channel is set to manual operation
(simulation) (not com unit 8x06). In simulation mode the
signal is frozen.

* Check whether the substitute value is being used
because there is no bus communication.

* Check that a sensible value has been chosen for the
scaling. Can the process control system handle the
selected range (e.g., 10,000 to 50,000) ?

I3 PEPPERL+FUCHS
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Fault

Action(s)

Module is not supplying any
diagnostic messages.

¢ Check whether the line fault detection function is
enabled. If not, enable line fault detection.

e Check whether the diagnostic function is enabled in the
com unit.

No input data, No output.

* Check that the correct I/O module has been plugged in.

* Check that the scaling of the analog input/output meets
the system requirements.

* Check that the wiring is OK.

I/0 module reported as not
present.

* Check that the correct I/O module has been plugged in.

¢ Check that the green LED on the I/O module is on and
that the 1/0 module is plugged in properly.

Module fault

* Check that the green LED on the 1/0 module is on. If not,
then there may be no contact with the backplane or the
fuse has blown. If all the 1/0O modules in a segment have
failed, then the fault lies in the power supply or the
backplane.

* Check the diagnostic information for the 1/0 module (e.g.,
no module, incorrect module, line fault, etc.) by referring
to the process-value window of the affected I/O module.

[Table 9.5: Signal fault

Fault

Action(s)

6/8 LB modules fail
simultaneously (LB 9121,

LB 9101 backplane system).

* Check that the power supply for the segment is working
correctly.

[Table 9.6: Signal fault

Fault

Action(s)

24 FB modules fail
simultaneously.

» Check that the power supply is working perfecily.
* Check that the extension wiring is correct and intact.

[Table 9.7: Signal fault
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9.6 Faults and their effects

The table below shows what effect different faults will have.

Fault Diagnostics Effect
FB Zone 1 power supply * The master receives an * No problem in redundant
failure (redundant) error message in the system

global status register,
provided this facility has
been pre-configured.

¢ Redundancy switchover
from primary to redundant

Com Unit.
* The master also receives a
redundancy error
message.
FB Zone 1 power supply * The master receives 24 e 24 FB slots are lost.
failure (not redundant) error messages in the

global and module status
register, provided this
facility has been pre-
configured.

* The master receives 24
module-specific and
channel-specific error
messages if module
diagnostics have been
enabled.

[Table 9.8: Faults and their effects
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Fault

Diagnostics

Effect

Power supply failure
(redundant station)

* The master receives an
error message in the
global status register,
provided this facility has
been pre-configured
(LB9022 and LB9024
backplanes only).

¢ Backplanes LB 9022, LB

9024 and LB 9029: 2-out-
of-3 redundancy when
using three LB9006 power
supplies means full
functionality is maintained
feven when a power supply
ails.

Backplanes LB 9121 and
LB 9101: when using two
LB9104 power supplies, 8
modules fail immediately if
a power supply fails. The
com units continue to be
supplied from the working
power supply, however,
and communication is
maintained.

Power supply failure (non-
redundant station)

* The master receives 8
error messages in the
global and module status
register, provided this
facility has been pre-
configured.

* The master receives 8
module-specific and
channel-specific error
messages if module
diagnostics have been
enabled.

Backplanes LB 9022, LB
9024 and LB 9029: in non-
redundant use, normally
just two power supplies
are used. This means that
if one power supply fails,
the whole station may be
adversely affected
(depending on the number
of modules used).

Backplanes LB 9121 and
LB 9101: when using two
LB9104 power supplies, 8
modules fail immediately if
a power supply fails. The
com unit continues to be
supplied from the working
power supply, however,
and communication is
maintained.

[Table 9.9: Faults and their effects

Fault

Diagnostics

Effect

Bus communication failure

¢ The master detects the
failure.

¢ The outputs assume

substitute values, provided
this option has been
programmed.

Com unit failure or voltage
lost

¢ The master detects the
faulty slave.

No voltage at the outputs,
unless system has
redundant design.
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Fault

Diagnostics

Effect

I/0O module failure

* The master receives an
error message in the
global and module status
register, provided this
function has been
programmed.

* The master receives the
message "module error" if
module diagnostics have
been enabled.

* No change in signal; the
inputs assume substitute
values, provided this
option has been
programmed.

* No voltage at the output.

* Usually the green LED is
off. There are situations,
however, where the green
LED is still on despite a
fault.

Incorrect 1/0O module

* The master receives an
error message in the
global and module status
register, provided this
function has been
programmed.

* The master receives the
message "incorrect
module" if module
diagnostics have been
enabled.

* No change in signal; the
inputs assume substitute
values, provided this
option has been
programmed.

* No voltage at the output

¢ The red LED in the dual-
width module flashes.

I/O module missing or
removed.

* The master receives an
error message in the
global and module status
register, provided this
function has been
programmed.

* The master receives the
message "missing
module" if module
diagnostics have been
enabled.

* The input is frozen.
* No voltage at the output.

module-specific faults

Line fault in input module

* The master receives an
error message in the
global and module status
register, provided this
function has been
programmed.

e The master receives an
error message "data
invalid" if module
diagnostics have been
enabled

e The red LED is on.

* No change in signal; the
inputs assume substitute
values, provided this
option has been
programmed.

e Temperature inputs do not
return to working normally
until the fault has been
rectified and the broken-
wire delay has elapsed.

Input signal lies out of range
for 3x01, 3x02, 3x03, 3x04,
3x05 analog input

* The master receives an
error message in the
global and module status
register, provided this
function has been
programmed.

e The master receives an
error message "data
invalid" if module
diagnostics have been
enabled

* The yellow LED is on.

¢ The signal is kept within
preset limits
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Fault Diagnostics Effect

Line fault in output modules | ¢ The master receives an * The red LED is on.
2xxx, 4x01, 4x02, 6x08 error message in the
global and module status
register, provided this
function has been
programmed.

* The master receives an
error message "data
invalid" if module
diagnostics have been
enabled

* No voltage at the output.

Table 9.10: Faults and their effects
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